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Abbreviations
This section describes the abbreviations used in this documentation.
3DS

3D Studio

ATTR

ATTRibute

BMP

BitMaP

COL

COLor

DDS

Direct Draw Surface

DLL

Dynamic Link Library

DOF

Degree-Of-Freedom

EXE

EXEcutable file in Microsoft® Windows®

FLT

FLighT (OpenFlight® file format extension)

GIF

Graphics Interchange Format

HSV

Hue-Saturation-Value

ID

IDentification

INT

INTensity

INTA

INTensity-Alpha

IR

Infra-Red

IRISGL

Integrated Raster Imaging System Graphics Library

IVE

OpenSceneGraph deprecated binary file format

JPEG

Joint Photographic Experts Group

LOD

Level-Of-Detail

MAC

Media Access Control

MAT

MATerial

N/A

Not Available

NAD

North American Datum

NE

North-East

OpenGL

Open Graphics Library

OSG

OpenSceneGraph deprecated ASCII file format

OSGB

OpenSceneGraph binary file format

OSGT

OpenSceneGraph text file format

OSGX

OpenSceneGraph XML file format

P3D

3D model file format used by VBS2

PBM

Portable Bit Map

PGM

Portable Gray Map

PNG

Portable Network Graphics

PNM

Portable aNy Map

PPM

Portable Pixel Map

RCP

Remo Color Palette

RGB

Red-Green-Blue

RGBA

Red-Green-Blue-Alpha
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RLP

Remo Light Point Palette

RMP

Remo Material Palette

RSP

Remo Shader Palette

RTP

Remo Texture Palette

RXP

Remo Texture Mapping Palette

®

SGI

Silicon Graphics Incorporated

SHP

ESRI SHaPe file format

STL

StereoLithography

SW

South-West

TAR

Tape ARchive (archive file format)

TEX

TEXture

TGA

TarGA

TIFF

Tagged Image File Format

UTM

Universal Transverse Mercator

VBS2

Virtual BattleSpace 2

WGS

World Geodetic System

XML

eXtensible Markup Language

ZIP

Compressed archive file format
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Overview
Remo 3D™ is an effective tool for creating and modifying 3D models intended for realtime
visualization. Remo 3D's primary file format is OpenFlight® and it allows for importing
from and exporting to different file formats.

As opposed to many other 3D modeling products that are primarily intended for
rendering, Remo 3D offers the user full control of the model scene graph and allows for
modification of features like degree-of-freedom nodes, level-of-detail nodes, switch
nodes, etc. Furthermore, the process of creating models in Remo 3D allows for focusing
on the individual polygons and vertices. All in all, this makes Remo 3D exceptionally
suitable for creating and modifying 3D models intended for realtime visualization.
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Installation
This section describes the installation of Remo 3D™ v2.10 on your system.

Microsoft® Windows®
Perform the following steps to install Remo 3D™ v2.10 in Microsoft® Windows®:
Unpack the downloaded ZIP file.
Run the unpacked installation EXE file and follow the instructions.
Remo 3D™ v2.10 can be installed both with and without administrative privileges.
Administrators can install for all users or for the current user only. The application can be
uninstalled from the Program menu, by executing uninstall.exe in the Remo 3D
installation folder or from the Windows Control Panel.
You can also install and uninstall Remo 3D™ v2.10 non-interactively from the command
prompt with the following commands (/S is for silent):
 remo3d_v2.10_64_install.exe /S /INSTDIR=<installation_folder>
 "<installation_folder>\uninstall.exe" /S
This can be useful for automatic installation scripts. Here are examples of installing and
uninstalling from the command-line:
 remo3d_v2.10_64_install.exe /S /INSTDIR=C:\Program Files\Remo3D
 "C:\Program Files\Remo3D\uninstall.exe" /S

Linux
Perform the following steps to install Remo 3D™ v2.10 in Linux:
Unpack the downloaded gzipped TAR file with one of the following commands:
tar xvzf remo3d_v2.10_64_linux.tar.gz
or
gunzip remo3d_v2.10_64_linux.tar.gz; tar xvf remo3d_v2.10_64_linux.tar
The unpacked remo3d_v2.10_linux folder is the installed Remo 3D™ v2.10 folder in
which remo3d is the executable file.
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Window Areas
This section describes the different areas of the Remo 3D™ graphical user interface.

Menu Bar
The menu bar is located at the top of the Remo 3D window. It is described in the Menu
section.

Tool Icons
Along the left border of the Remo 3D window is a scrollable area containing tool icons.
These are described in the Tools chapter.

Other Icons
Below the menu bar is an area containing icons for file operations, edit operations,
selection modes and palettes.
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File Icons

New
By clicking this icon a new model is created, called untitled.flt.

Open
By clicking this icon the user can choose to open one or more OpenFlight® files. The
general functionality of the file dialog is described in the File Dialogs section.
Note that OpenFlight® files also can be opened by drag and drop, i.e. dragging the files
from a file manager and dropping them on to the Remo 3D window. Another way of
opening models is by specifying their file names on the command-line:
remo3d <filename1> <filename2> ...
or for instance like this in Microsoft® Windows®:
"C:\Program Files\Remo3D\remo3d.exe" <filename1> <filename2> ...

Save
By clicking this icon the current model is saved to disk, using the same name as before
and overwriting the old model.

Edit Icons

Cut
By clicking this icon the selected primitives are copied to the clipboard and deleted from
the model. The old contents of the clipboard are erased.

Copy
By clicking this icon the selected primitives are copied to the clipboard. The old contents
of the clipboard are erased. Note that the current pivot point is also copied and restored
when pasting.
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Paste
By clicking this icon the primitives in the clipboard are added to the current parent in the
model. The current pivot point is also changed to the pivot point saved together with the
primitives in the clipboard.

Undo
By clicking this icon the latest command is reversed. Commands that respond to
undo/redo are all tools or palette operations that modify the model, left- or right-shifting
of nodes, all types of selection operations, cutting and pasting of geometry, drag and
drop operations, moving of the pivot point and setting the parent node. Undoable and
redoable commands can be viewed in the Command List described in the Command List
section.

Redo
By clicking this icon the latest command that were undone is re-activated. Commands
that respond to undo/redo are all tools or palette operations that modify the model, leftor right-shifting of nodes, all types of selection operations, cutting and pasting of
geometry, drag and drop operations, moving of the pivot point and setting the parent
node. Undoable and redoable commands can be viewed in the Command List described in
the Command List section.

Selection Mode Icons
The mode icons are described in the Modes chapter.

Miscellaneous Icons
The miscellaneous icons are described in the following sections.

Shrink Polygons
To be able to select separate vertices sharing the same position, see thin polygons and
such, it can be convenient to temporarily shrink all polygons by clicking this icon. The
shrinking is done by moving all vertices toward the center of their polygons. The distance
moved is 20% of the distance between the vertex and the polygon center.
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Show Normals
This icon activates and deactivates visualization of vertex normals, if any.

Report Statistics
This icon activates a statistics report for the sub-trees of the selected nodes. The
statistics include numbers of vertices, polygons, objects, groups, LODs, switches, DOFs,
light point systems, light points and external references in the selected sub-trees as well
as minimum, maximum and center coordinates together with the size of the selected
geometry. It also reports the area of all polygons in the selected sub-tree. Note that the
number of polygons reported might be higher than the number of polygons selected,
since some of the selected polygons might have polygons (sub-faces) beneath them.
Report Statistics is special in that it stays active when switching between models,
allowing for convenient comparison.

Report Differences
By clicking this icon the user can choose to compare the currently selected sub-tree with
either the sub-tree contained in the current clipboard (put there by a Copy or Cut
operation) or with another OpenFlight® file. In the case of comparing with an OpenFlight®
file, the header node of the current model should be selected in order for the report to
make any sense. The user can also specify if the revision date or version of the file (not
the OpenFlight® version) to compare with should be ignored or not.
The result is presented in a message box, reporting the first difference encountered. This
could be e.g. different node types, node names, attributes or different numbers of
children.

Snap To Grid
When indicating coordinates grid snapping can be used with a tolerance of 25% of the
current grid spacing.

Show Vertices Large
This icon activates and deactivates visualization of large vertices.
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Show Vertex Numbers
This icon activates and deactivates visualization of vertex numbers, starting with 0 for
the first vertex in a polygon or light point node.

Palette Icons
Current Color (COL)
This icon shows the currently chosen color. Clicking it will open the color palette
described in the Color Palette section and let the user select the current color or edit the
color palette.

Current Texture (TEX)
This icon shows the currently chosen texture. Clicking it will open the texture palette
described in the Texture Palette section and let the user select the current texture or edit
the texture palette.

Current Texture Mapping (TXM)
This icon shows the currently chosen texture mapping. Clicking it will open the texture
mapping palette described in the Texture Mapping Palette section and let the user select
the current texture mapping or edit the texture mapping palette.

Current Material (MAT)
This icon shows the currently chosen material. Clicking it will open the material palette
described in the Material Palette section and let the user select the current material or
edit the material palette.

Current Light Point (LPT)
Clicking this icon will open the light point palette described in the Light Point Palette
section and let the user select the current light point appearance and animation or edit
the light point palette.

Current Shader (SHD)
Clicking this icon will open the shader palette described in the Shader Palette section and
let the user edit the shader palette.
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Model View
The area to the left and beneath the icons is the model view, where the model is threedimensionally visualized. The model view contains tabs so that several models can be in
memory simultaneously. With Ctrl+TAB and Ctrl+Shift+TAB the user can switch forwards
and backwards between these models. A model can be presented in one or more
viewports. These viewports, as well as the tree view, can be resized with respect to each
other by clicking and moving their borders.

Tool Area
The area to the right of the model view is the tool area. This is used by tools that need
user interface components like buttons, input and output fields.

Tree View
The area beneath the model view is the tree view, which is described in the Tree View
chapter.

Coordinates and Selections Field
The area beneath the tree view is used for displaying the current and previous
coordinates, the delta in X, Y and Z and the distance from the previous coordinate. It is
also used for displaying a list of the names of the currently selected primitives together
with the number of primitives selected. Furthermore, the name of the current parent
node is presented on a button. To change the current parent, select the new parent node
and click the parent button or press Ctrl+P.
This field also contains three convenient buttons for aligning the grid to the XY, XZ or YZ
plane.

Status Area
The area at the bottom of the Remo 3D window is the status area. This is used for
displaying informative text of the current action. If the mouse cursor is located over a
node in the tree view, the complete node name is also displayed in the status area.
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Mouse Handling
This section describes the different ways of controlling Remo 3D using the mouse. Note
that except for an ordinary mouse, the 3Dconnexion Space Navigator™ is supported for
controlling the model view as described in the Space Navigator™ Support section.

Mouse Movement
The table below describes movement of the model using the mouse.
Note that the sensitivity of panning, zooming and rotating can be set in the preferences
described in the Preferences section or by using the Sensitivity dialog available from the
View menu.
Right mouse button

Rotates view around the current center point,
horizontally and vertically.

Shift + Right mouse button

Zooms view in (move mouse downwards) and out (move
mouse upwards).

Ctrl + Right mouse button

Pans view.

Scroll wheel

Zooms view in (scroll downwards) and out (scroll
upwards).

Shift + Scroll wheel

Zooms view in and out in finer steps.

Mouse Selection
The table below describes selection of geometry using the mouse.
Note that sometimes selecting small primitives, e.g. one vertex, by one click can be
difficult. In those cases, try selecting with a small rectangular area instead.
Clicking left mouse button

Selects the nearest primitive.

Clicking and dragging left
mouse button

Selects primitives within a rectangular area, even
those behind.

Holding Shift and clicking left
mouse button

Adds the nearest primitive to the existing selection.

Holding Alt and clicking left
mouse button

Removes the nearest primitive from the existing
selection.

Holding Shift and clicking and
dragging left mouse button

Adds non-selected primitives within the rectangular
area to the existing selection.

Holding Alt and clicking and
dragging left mouse button

Removes selected primitives within the rectangular
area from the existing selection.
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Mouse Coordinate Indication
The table below describes coordinate indication using the mouse. Indicating coordinates
is required for controlling certain tools, defining the grid as three points, translating the
grid, etc.
Middle mouse button

Indicates a coordinate in the grid. Snaps to grid points
if snap is active.

Ctrl + Middle mouse button

Moves pivot point of current selection to a coordinate
in the grid. Snaps to grid points if snap is active.

Shift + Middle mouse button

Indicates a coordinate, snapping to the center point of
an existing primitive. The current primitive mode
decides which type of primitive to which to snap.

Ctrl + Shift + Middle mouse
button

Moves pivot point of current selection to a coordinate,
snapping to the center point of an existing primitive.
The current primitive mode decides which type of
primitive to which to snap.

Miscellaneous Mouse Functions
The table below describes miscellaneous use of the mouse buttons.
Ctrl + Alt + Right mouse
button

Opens a pop-up menu with various settings for the
currently focused viewport. This menu is the same as
Viewport in the View menu and is described in detail
in the Viewport Menu section. The menu can also be
reached by pressing the Menu button on the
keyboard.

Space Navigator™ Support
Remo 3D supports model view manipulation with the 3Dconnexion Space Navigator™.
This support requires that the 3Dconnexion driver is installed. The pan, zoom and rotate
configuration from the 3Dconnexion control panel will be used and the sensitivity is
controlled as described in the View Menu and Preferences sections. For more information
about this device, see www.3dconnexion.com.
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File Dialogs
This section describes the different file dialogs used throughout the Remo 3D graphical
user interface. The file dialogs will have different appearances depending on which
operating system you are on.
In both Microsoft® Windows® and Linux, the file dialog for saving OpenFlight® files will
contain a drop-down menu list of available OpenFlight® versions.

Windows File Dialogs
In Microsoft® Windows®, an ordinary file dialog matching the current Windows version is
used, except for the addition of the OpenFlight® version in the save dialog. No further
description of file dialogs in Microsoft® Windows® is needed.
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Linux File Dialogs
In Linux, a common file dialog independent of the Linux distribution or window system is
used. The functionality of this file dialog is described below.

When opening all file dialogs in Remo 3D for Linux (e.g. for opening or saving of
OpenFlight® models, textures or palettes), they will show the latest folder visited in that
particular dialog in the current Remo 3D session.
The favorites list always contains a File Systems favorite which will show the available file
systems in the file list.
Automatic completion is used when typing the filename. The file type can be chosen in
the Files Of Type drop-down menu at the bottom of the dialog.
In file dialogs intended for saving or exporting files, folders can be created by clicking the
New Folder icon in the top right corner of the file dialog. Navigation to the upper level in
the folder hierarchy can be performed by clicking the Up One Level icon to the left of the
New Folder icon.
The folder currently visited can be saved to a list of favorites by choosing Add To
Favorites from the Favorites drop-down menu at the top of the file dialog. A favorite
folder can be navigated to again by choosing it from the Favorites drop-down menu. The
favorites can also be moved and deleted by choosing Manage Favorites from the same
drop-down menu. The favorites are remembered until the next session of Remo 3D.

24

Remo 3D™ v2.10 User’s Guide

Menu
This section describes all items in the Remo 3D menu.

File Menu
The table below describes the contents of the File menu.
New

Creates a new model, called untitled.flt.

Open...

Lets the user open one or more OpenFlight® files. The general
functionality of the file dialog is described in the File Dialogs
section.
Note that OpenFlight® files also can be opened by dragging
them from a file manager and dropping them on to the Remo 3D
window. Another way of opening models is by specifying their
file names on the command-line:
remo3d <filename1> <filename2> ...

Revert...

Opens the current model from disk again.

Revert Externals

Opens all external references from disk again.

Revert Textures

Reloads all textures from disk again.

External
References…

Shows a list of all externally referenced models, uniquely by file
name, allowing for enabling and disabling. Use the Apply button
to confirm. Toggle Use Relative Paths for relative or absolute
external paths. If the Load External References setting described
in the Preferences section is disabled, all external references in
this dialog will disabled to start with.

Open Recent

Contains up to four recent 3D model files that can be opened
directly.

Save

Save the current model to disk, using the same name as before
and overwriting the old model.

Save As...

Lets the user choose a filename and location for saving the
opened model to disk. The OpenFlight® version can also be
selected. If a file with the chosen name already exists, the user
can choose to overwrite the file or not. The general functionality
of the file dialog is described in the File Dialogs section.

Import...

Lets the user import one or more files of different 3D file
formats. The general functionality of the file dialog is described
in the File Dialogs section. Each imported file results in a new
untitled model containing the geometry from the imported file.
The import file formats supported are listed in the Technical
Specifications section.
Embedded textures and shaders, as well as externally
referenced files, can be converted and written to disk.
Remo 3D uses OpenSceneGraph plugins for importing different
file formats. These plugins can be controlled with a number of
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settings specified as an option string. This string can be set
using the REMO3D_IMPORT_EXPORT_OPTIONS environment
variable.
Note that 3D model files supported for import also can be
imported by dragging them from a file manager and dropping
them on to the Remo 3D window. Another way of importing
models is by specifying their file names on the command-line:
remo3d <filename1> <filename2> ...
Export As...

Lets the user choose a filename for exporting the current model
to another 3D file format. If a file with the chosen name already
exists, the user can choose to overwrite the file or not. The
general functionality of the file dialog is described in the File
Dialogs section. The export file formats supported are listed in
the Technical Specifications section.
Remo 3D uses OpenSceneGraph plugins for exporting different
file formats. These plugins can be controlled with a number of
settings specified as an option string. This string can be set
using the REMO3D_IMPORT_EXPORT_OPTIONS environment
variable.

Close

Closes the currently selected model. If changes have been
made, the user is given the opportunity to save the model.

Close All Models

Closes all models. If changes have been made to a model, the
user is given the opportunity to save that model.

Exit

Exits the program. All models are closed. If changes have been
made to a model, the user is given the opportunity to save that
model.

Edit Menu
The table below describes the contents of the Edit menu.
Undo

Reverses the latest command. Commands that respond to
undo/redo are all tools or palette operations that modify the
model, left- or right-shifting of nodes, all types of selection
operations, cutting and pasting of geometry, drag and drop
operations, moving of the pivot point and setting the parent
node. Undoable and redoable commands can be viewed in the
Command List described in the Command List section.

Redo

Re-activates the latest command that were undone. Commands
that respond to undo/redo are all tools or palette operations that
modify the model, left- or right-shifting of nodes, all types of
selection operations, cutting and pasting of geometry, drag and
drop operations, moving of the pivot point and setting the
parent node. Undoable and redoable commands can be viewed
in the Command List described in the Command List section.

Cut

Copies selected primitives to the clipboard and deletes them
from the model. The old contents of the clipboard are erased.
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Copy

Copies selected primitives to the clipboard. The old contents of
the clipboard are erased. The current pivot point is also saved to
the clipboard.

Paste

Adds the primitives in the clipboard to the current parent in the
model. The pivot point is changed to the pivot point saved
together with the primitives in the clipboard.

Delete

Deletes selected primitives.

Set Parent

Changes the current parent to the currently selected node.

Change Parent

Moves the selected nodes to become children of the current
parent.

Shift Far Left

Shifts the selected nodes all the way to the left in the tree
structure.

Shift Left

Shifts the selected nodes one step to the left in the tree
structure.

Shift Right

Shifts the selected nodes one step to the right in the tree
structure.

Shift Far Right

Shifts the selected nodes all the way to the right in the tree
structure.

Preferences...

Opens the preferences window, described in the Preferences
section.

View Menu
The table below describes the contents of the View menu.
Next Model

Switches to the next model among the tabs.

Previous Model

Switches to the previous model among the tabs.

More Detail

Shows the next more detailed LOD level.

Most Detail

Shows the most detailed LOD level.

Less Detail

Shows the next less detailed LOD level.

Least Detail

Shows the least detailed LOD level.

Show All LODs

Shows all LODs simultaneously.

Sensitivity...

Lets the user set the sensitivity for panning, zooming and
rotating the view. This input dialog is non-modal which means
that it is possible to open the dialog and continue working with
the rest of the Remo 3D graphical user interface.

Multi-texture

In this sub-menu, the user can choose which of the eight multitexture layers that are to be visible. It’s also possible to enable
or disable all layers or only enable the base layer 0.

Show Gizmos

Toggle if gizmos should be shown or not.

Command List...

Opens the command list where all commands executed so far
can be viewed. The command list is described in the Command
List section.

Preview DOF…

Opens a DOF preview dialog described in the Preview DOF
section.

Preview
Animation...

Opens an animation preview dialog described in the
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Viewport

This sub-menu is only available when a viewport is focused. This
menu is described in Viewport Menu in the Viewport Menu
section.

Selection Menu
The table below describes the contents of the Selection menu.
All

Selects all primitives of the currently chosen type. Selected
primitives of other types are deselected.

None

Deselects all primitives.

Invert Selection

Selects all primitives of the currently chosen type except for
those already selected. Selected primitives of other types are
deselected.

Select By Name...

Selects a node with a specified name. The user can specify the
name, whether the search should be case sensitive or not and if
the selection should be added to the previous selection or
created as a new selection.
To select vertices, add a /Vx suffix to the polygon or light point
node name, where x is the zero-based vertex number. To select
edges, add a /Ex suffix, where x is the zero-based edge number.

Select By
Attributes...

Selects all primitives matching a given condition of desired
attributes. Select By Attributes is described in more detail in the
Select By Attributes section.

Select Polygons By
Number Of
Vertices...

Selects all polygons with a given number of vertices.

Select Sliver
Polygons

Selects all polygons in the model (or in the selected subtree) having an angle smaller than the current tolerance
between two edges. Those polygons are considered to be
slivers. The current tolerance is described in the Preferences
section.

Select Naked
Edges

Select edges in currently selected geometry or in the whole
model having no neighbors and thereby considered 'naked'.

Select Parents

Selects the parents of the currently selected nodes.

Select Children

Selects the child nodes of the currently selected nodes.

Select Previous

Switches to the latest previous selection. This will essentially
toggle between the two latest selections.

Mode Menu
The table below describes the contents of the Mode menu.
Vertex Mode

Sets vertices to be interactively selectable in the model view.
Vertices are corner points of polygon or light point nodes.

Edge Mode

Sets edges to be interactively selectable in the model view.
Edges are virtual structures representing pairs of consecutive
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vertices.
Polygon Mode

Sets polygons to be interactively selectable in the model view.
Polygons are surface nodes, each one containing a number of
vertices.

Object Mode

Sets objects to be interactively selectable in the model view.
Objects are hierarchy grouping nodes containing only polygon or
light point nodes.

Group Mode

Sets groups to be interactively selectable in the model view.
Groups are general hierarchy grouping nodes.

LOD Mode

Sets LODs to be interactively selectable in the model view. LODs
are level-of-detail hierarchy grouping nodes switched on or off
depending on viewing distance.

DOF Mode

Sets DOFs to be interactively selectable in the model view. DOFs
are degree-of-freedom hierarchy grouping nodes allowing for
transformation of contained geometry.

Switch Mode

Sets switches to be interactively selectable in the model view.
Switches are hierarchy grouping nodes switching contained
geometry on or off with a number of switch masks.

Light Point Mode

Sets light points to be interactively selectable in the model view.
Light points are light point nodes, each one containing a number
of vertices.

Light Point System
Mode

Sets light point system nodes to be interactively selectable in
the model view. Light point system nodes are hierarchy
grouping nodes containing only light points.

External Reference
Mode

Sets external references to be interactively selectable in the
model view. External references are nodes referencing external
OpenFlight® files.

Tools Menu
The Tools menu contains all tools described in the Tools chapter.

Palettes Menu
The table below describes the contents of the Palettes menu.
Color Palette...

Opens the color palette of the currently focused model and lets
the user select the current color or edit the color palette.

Texture Palette...

Opens the texture palette of the currently focused model and
lets the user select the current texture or edit the texture
palette.

Texture Mapping
Palette...

Opens the texture mapping palette of the currently focused
model and lets the user select the current texture mapping or
edit the texture mapping palette.

Material Palette...

Opens the material palette of the currently focused model and
lets the user select the current material or edit the material
palette.

Light Point

Opens the light point palette of the currently focused model and
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Palette…

lets the user select the current light point appearance and
animation or edit the light point palette.

Shader Palette...

Opens the shader palette of the currently focused model and
lets the user edit the shader palette.

Script Menu
The table below describes the contents of the Script menu.
Script Editor…

Opens the Script Editor described in the Script Environment
section.

Macro Editor…

Opens the Macro Editor described in the Macro Editor section.

Macros

This sub-menu contains available macros, described in the
Macros chapter.

Misc Menu
The Misc menu contains the same functionalities as described in the Miscellaneous Icons
section.

Help Menu
The table below describes the contents of the Help menu.
Contents...

Opens the help window described in the Help chapter.

About Remo 3D...

Shows short information about the current version of the
program and how to get in contact with Remograph.

License…

Opens the license dialog described in the License Handling
section.
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Select By Attributes
This dialog is used for selecting all primitives matching a given condition of desired
attributes.

The total condition will consist of a number of expressions. To construct an expression,
click on a desired attribute label in the list to the right, select an operator (Equal To, Not
Equal To, Greater Than or Less Than) and specify a desired value of the chosen attribute.
Select By Attributes will only work with one selection mode at a time, one can’t select
e.g. vertices and polygons at the same time this way. That would require using the Add
To Selection check box described later. The selection mode can be changed with the
Mode buttons in the top of this dialog. Note that this will reset the current condition. If
the primitives currently selected share the same value of a certain attribute, this will be
the default for the desired value. For light points, the user has to choose between
“ordinary” inline light points or indexed light points.
An expression can be added to the total condition by clicking the ADD button or the OR
button, representing the logical operator with which the expression will be added. The
latest expression added can be removed with the Remove Last button. With the Add To
Selection check box, the user can also specify if the selection should be added to the
previous selection or created as a new selection.
The last condition used will remain after applying it. If the dialog is closed and opened
again the condition will still be the same as before, in which case the previously used
selection mode will also be activated. The Clear button will reset the condition.
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Shortcuts
This section lists all keyboard shortcuts available in Remo 3D.
Ctrl+n

New

Ctrl+o

Open...

Ctrl+s

Save

Shift+Ctrl+s

Save As...

Ctrl+i

Import…

Ctrl+e

Export As…

Ctrl+w

Close Model

Shift+Ctrl+w

Close All Models

Ctrl+q

Exit

Ctrl+z

Undo

Ctrl+y

Redo

Ctrl+x

Cut

Ctrl+c

Copy

Ctrl+v

Paste

DELETE/BACKSPACE

Delete

Ctrl+p

Set Parent

Ctrl+r

Change Parent

Ctrl+TAB

Next Model

Ctrl+Shift+TAB

Previous Model

Ctrl+m

More Detail

Shift+Ctrl+m

Most Detail

Ctrl+l

Less Detail

Shift+Ctrl+l

Least Detail

Ctrl+t

Sensitivity…

Ctrl+g

Show Gizmos

Ctrl+a

Select All

Ctrl+d

Select None

Alt+Ctrl+0

Toggle multi-texture layer 0 (base).

Alt+Ctrl+1

Toggle multi-texture layer 1.

Alt+Ctrl+2

Toggle multi-texture layer 2.

Alt+Ctrl+3

Toggle multi-texture layer 3.

Alt+Ctrl+4

Toggle multi-texture layer 4.

Alt+Ctrl+5

Toggle multi-texture layer 5.

Alt+Ctrl+6

Toggle multi-texture layer 6.

Alt+Ctrl+7

Toggle multi-texture layer 7.

F1

Help

Shift+V

Vertex Mode

Shift+E

Edge Mode
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Shift+F

Polygon (face) Mode

Shift+O

Object mode

Shift+G

Group mode

Shift+L

LOD mode

Shift+D

DOF mode

Shift+S

Switch mode

Shift+P

Light Point Mode

Shift+T

Light Point System Mode

Shift+R

External Reference Mode

Alt+Shift+t

Move

Alt+Shift+r

Rotate

Alt+Shift+s

Scale

Alt+Shift+q

Apply Transformation Matrix

Alt+Shift+n

Create Node

Alt+Shift+z

Create Polygon

Alt+Shift+f

Create External Reference

Alt+Shift+c

Apply Color

Alt+Shift+e

Apply Material

Alt+Shift+x

Map Texture

Alt+Shift+d

Modify UV

Alt+Shift+v

Reverse Polygon

Alt+Shift+b

Split/Triangulate

Alt+Shift+w

Extrude

Alt+Shift+g

Merge Polygons

Alt+Shift+h

Shade

Alt+Shift+a

Apply Attributes

s

Shrink Polygons

n

Show Normals

p

Perspective

o

Orthographic

Shift+z

Top view

z

Bottom view

Shift+y

Front view

y

Back view

Shift+x

Right view

x

Left view

Shift+j

View toward and below grid

j

View toward and above grid

Shift+q

Store current view

q

Recall stored view

v

In viewport: Fit view to the current selection, changing the
point of rotation and zoom.
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In tree view: Scroll to the selected node. If there are more
than one node selected, pressing v again will cycle trough
them.
SPACE

Fit model in view and possibly recalculate automatic pan and
zoom sensitivity

w

Toggle between solid, scribed and wireframe modes

t

Toggle texture on/off

r

Toggle shader visualization on/off

l

Toggle lighting on/off

m

Toggle lighting mode between head light and sky light

g

Toggle grid on/off

a

Align grid to three vertices

f

Align grid to a polygon (face)

+

Increase grid size

-

Decrease grid size

Shift+'+'

Double grid size

Shift+'-'

Half grid size

e

Grid spacing

d

Grid offset

h

Hide selected geometry

i

Isolate selected geometry

H

Unhide selected geometry

U

Unhide all geometry

c

Viewport preferences

MENU

Viewport menu

1

Activate the first (top) macro in the Macros sub-menu under
the Script menu.

2

Activate the second macro in the Macros sub-menu under the
Script menu.

3

Activate the third macro in the Macros sub-menu under the
Script menu.

4

Activate the fourth macro in the Macros sub-menu under the
Script menu.

5

Activate the fifth macro in the Macros sub-menu under the
Script menu.

6

Activate the sixth macro in the Macros sub-menu under the
Script menu.

7

Activate the seventh macro in the Macros sub-menu under the
Script menu.

8

Activate the eighth macro in the Macros sub-menu under the
Script menu.

9

Activate the ninth macro in the Macros sub-menu under the
Script menu.
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Tools
Generally, the behavior of a tool depends on the current mode, the current selection and
any coordinates indicated by the user. A tool is active until another tool is activated, until
the user deactivates the tool or until a tool that doesn’t require any user interface (e.g.
Apply Color) has finishes its task. After e.g. moving a number of selected primitives the
same primitives can be moved again just by indicating a new coordinate.
A new set of primitives can also be selected and the tool can be applied to them without
having to restart the tool. A tool can be deselected so that no tool is currently active.

XFORM (Transformation tools)
Move
This tool moves the currently selected primitives so that the pivot point of the selection is
moved to the new coordinate indicated by pressing the middle mouse button. A new
position can be assigned to the pivot point prior to the movement using Ctrl + Middle
mouse button.
The user can choose to freeze the X, Y or Z axis to avoid moving in the corresponding
directions. An exact movement can also be performed by manually specifying the
coordinate in the x, y and z input boxes and clicking the Move button. This way of
moving can be relative or absolute depending on if the Relative check box is enabled or
not. If the movement was relative and the Move button is clicked again, the same
relative movement will be repeated.
Another way of moving the selected primitives is to check the Move To Point check box.
This will make each of the selected primitives move to the specified point and can be
useful for example when moving several vertices to the same position. Since the
movement in this mode will always be absolute, the Relative check box is disabled.
By setting the Snap Movement to a value above zero, the relative movement will be
snapped to an even multiple of the specified number.
The move tool can also be controlled by a gizmo. When pressing down the middle mouse
button on one of the arrows or planes between the arrows, the selected geometry can be
moved in the arrow’s direction or in the plane defined by the arrows.
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A convenient feature of the Move tool is the Plant option. This will simply place the
selected primitives exactly at the position clicked at, provided that the click hits another
existing geometry. This can be useful when e.g. planting trees on terrain, with the pivot
at the bottom of the tree geometry and not in its center point.
When planting, one often copies selected primitives to the clipboard, pastes the
primitives and then plants them, all in a repeated process. Make sure that the desired
pivot point is correct when copying the primitives, since the pivot is saved together with
the geometry in the clipboard.
By enabling the Apply Matrix check box, the movement will be applied as a
transformation matrix to the selected primitives that support this, instead of modifying
the coordinates. Nodes that don't support transformation matrices (vertices, edges,
polygons, light points, headers and DOF nodes) will not be affected and a warning will be
shown. This type of transformation will be the same as running the Apply Transformation
Matrix tool. Apply Matrix is activated by default if only external reference nodes are
selected, as a convenience to be able to transform them easily.
See the separate Soft Selection section for a description of the Soft Selection controls.

Rotate
This tool rotates the currently selected primitives around a specified axis. The axis can
quickly be chosen as X, Y or Z by using the convenient X, Y and Z buttons. An existing
edge can also be selected as rotation axis by clicking the Pick Rotation Edge button and
selecting one of the existing edges in the model using the left mouse button.
The current rotation axis is visualized as a yellow line. Note that when picking an edge to
define the direction of the rotation axis, it’s only the direction and not the position of the
rotation axis which is defined. To actually force the rotation axis to be the same as the
picked edge, it has to be translated by moving the pivot point to the picked edge’s center
using the Edge mode and Shift + Ctrl + Middle mouse button. The pivot point can also be
moved to any coordinate on the picked edge by indicating a coordinate either on the grid
or snapped to a vertex.
The actual rotation can be performed by clicking and dragging the middle mouse button
up and down in the model view. An exact angle (in degrees) can also be specified in the
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Angle input box in which case the Rotate button must be clicked to confirm the rotation.
If the Rotate button is clicked again, a new rotation with the same angle is performed.
By setting the Snap Angle to a value above zero, the relative rotation will be snapped to
an even multiple of the specified angle in degrees.
The Rotate Normals check box controls whether or not to rotate the vertex normals to
correspond to the vertex position rotation.
The rotate tool can also be controlled by a gizmo. When pressing down the middle mouse
button on one of the boxes on the rotation circles, the selected geometry can be rotated
around the axis that goes through the center of the rotation circle.

See the Move section for a description of the Apply Matrix check box.
See the separate Soft Selection section for a description of the Soft Selection controls.

Scale
This tool scales the currently selected primitives from the current pivot point. The user
can choose to freeze the X, Y or Z axis to avoid scaling in the corresponding direction.
The actual scaling can be performed by clicking and dragging the middle mouse button
up and down in the model view.
An exact scaling factor (in percent) can also be specified in the Scale input box in which
case the Scale button must be clicked to confirm the scaling. If the Scale button is clicked
again, a new scaling with the same factor is performed.
By setting the Snap Scale to a value above zero, the relative scale will be snapped to an
even multiple of the specified percentage.
The scale tool can also be controlled by a gizmo. When pressing down the middle mouse
button on one of the arrows or planes between the arrows, the selected geometry can be
scaled in the direction of the arrow or in the plane by dragging the mouse in the arrow’s
direction or within the plane. When scaling with the plane, the scaling can be uniform in
both directions or individual in each direction of the axes that make up the plane. This is
controlled by a setting described in the Preferences section.
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See the Move section for a description of the Apply Matrix check box.
See the separate Soft Selection section for a description of the Soft Selection controls.

Soft Selection
The Move, Rotate and Scale tools can all use Soft Selection when performing the
transformations. Soft Selection is used to smoothly vary the weight of each vertex or
primitive. The weight is varied according to a weight function; there are currently six
different weight functions:
Linear
Sine
Square Root
Square
Cube Root
Cube
The weight is also bound by a radius. When the distance between the vertex/primitive to
the pivot point is greater than this radius, the vertex/primitive will not be affected by the
transformation at all. From the pivot point up to the radius, the weight will be calculated
according to the weight function.
To activate Soft Selection in the Move, Rotate and Scale tools, check the Activate check
box. When Soft Selection is active, the weight of each selected vertex/primitive can be
shown by checking the Show Visualization check box. The colors used to visualize the
weight of the vertex/primitive range from blue to red, where blue is zero weight and red
is full weight.
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The weights of the Soft Selection are recalculated when a new selection is made. They
are also recalculated when the pivot point is independently moved or any of the Soft
Selection parameters are changed.

Apply Transformation Matrix
With this tool transformation matrices can be applied, inspected and edited.
Transformation matrices can be applied to group nodes, object nodes, LOD nodes,
external references, light point system nodes and switch nodes. New transformations can
be added by selecting the transformation type and clicking the Add Before or the Add
After button.
Transformation matrices can also be applied to polygon and light point nodes, but the
transformation matrices are only used to transform replications; without a replication the
transformation matrices have no effect. If a group has a transformation matrix and a
replication, the transformation matrix is used to transform the replications.
The transformation matrices are applied to the geometry from the top and downwards in
the list. The list of transformations can be edited by moving them upwards or downwards
in the list with the Move Up and Move Down buttons or removing them with the Remove
button. The details of a transformation can be edited when it’s selected. All changes to
the transformation matrices must be confirmed by clicking the Apply button.
Note that the details of Rotate And/Or Scale To Point transformations and Put
transformations can’t be edited in the current version of Remo 3D.

Eliminate Transformation Matrices
This tool eliminates all transformation matrices recursively beneath and including the
selected node. Vertex coordinates are transformed accordingly so that the geometry
appears the same. Note that external references and instances will not always respond
well to this, since it’s impossible to transform their vertices correctly.
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CREATE (Creation tools)
Create Node
This tool allows for creation of object, group, LOD, DOF, light point system or switch
nodes. The new node is placed beneath the current parent node.

Create Polygon
With this tool the user can create a new polygon. The coordinates of the new vertices are
indicated using the middle mouse button. They can be snapped to previous coordinates
by using the vertex mode and Shift + Middle mouse button. They can also be snapped to
the centers of other primitives, like polygons or edges in the same manner.
When the coordinates for all vertices have been indicated, the polygon is created by
clicking the Done button or by pressing the Enter key. The last vertex created can be
removed by clicking the Remove Last button.
When clicking the Done button or pressing the Enter key, the vertices might be rotated
automatically to a reverse order, to make the polygon face the viewer in the current
viewport. This can be changed later by using the Reverse Polygon tool. The polygon is
placed beneath the current parent node.

Create Disk
With this tool the user can create a disk polygon. The disk polygon is attached to the
current parent node. A center coordinate is indicated with the middle mouse button, as
well as a position on the disk border. A third point, called span, must be in the disk plane
and is needed to complete the disk. If Align To Grid is enabled, the span point isn’t
needed. Instead the disk will be created in the plane defined by the current grid.
The number of segments can be changed before or after indicating the three coordinates.
Any of the three coordinates can be changed by clicking their radio buttons and indicating
new coordinates. A disk is completed by clicking the Done button or pressing the Enter
key.

Create Sphere
With this tool the user can create a sphere. The sphere is made up of a number of
polygons put beneath an object node. The object node is attached to the current parent
node. A center coordinate is indicated with the middle mouse button, as well as a
position on the sphere border.
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The number of rows and segments can be changed before or after indicating the two
coordinates. Any of the two coordinates can be changed by clicking their radio buttons
and indicating new coordinates. A sphere is completed by clicking the Done button or
pressing the Enter key.

Create External Reference
This tool creates one or more external references. Simply select one or more OpenFlight®
files in the file dialog. The general functionality of the file dialog is described in the File
Dialogs section. The reference nodes are placed beneath the current parent node.
Note that if the Load External References setting described in the Preferences section is
disabled, the model won’t be loaded until it’s enabled in the External References dialog
available from the File menu.
When loading a model with external references, the REMO3D_FILE_PATH environment
variable is used if the external referenced files aren't found directly.

Create Light Point
This tool creates a string of light points. The coordinates of the new vertices are indicated
using the middle mouse button. They can be snapped to previous coordinates by using
the vertex mode and Shift + Middle mouse button. They can also be snapped to the
centers of other primitives, like polygons or edges in the same manner.
By enabling the Indexed check box, indexed light points will be created instead of
ordinary “inline” light points. The indexed light point that will be created will refer the
light point palette with the currently active appearance and animation indices which can
be picked in the Light Point Palette described in the Light Point Palette section.
When the coordinates for all vertices have been indicated, the light point string is
completed by clicking the Done button or pressing the Enter key. The last vertex created
can be removed by clicking the Remove Last button. The light point node is placed
beneath the current parent node.

SURFACE (Surface appearance tools)
Apply Color
This tool applies the current color to all polygons in the selected geometry. If vertices or
edges are selected, the color is applied to the vertices.
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Read Color From Node
This tool reads the color from the polygons in the selected geometry and applies it as the
current color. If vertices or edges are selected, the color is read from the vertices. This
tool only works if all selected primitives have the same color.

Apply Texture
This tool applies the current texture to all polygons in the selected geometry.
Note that the texture will not be mapped; it’s only the polygon texture index that is
modified. For mapping a texture to the geometry, use one of the Map Texture or Apply
Texture Mapping tools.

Read Texture From Node
This tool reads the texture from the polygons in the selected geometry and applies it as
the current texture. This tool only works if all selected polygons have the same texture.
Note that the texture mapping will not be read from the node, it's only the polygon
texture index that is retrieved.

Apply Texture Mapping
This tool applies the current texture mapping to all polygons in the selected geometry.
This will modify the texture mapping index of the polygons and it will also modify the UV
coordinates of the vertices according to the new mapping.
Note that the texture index will not be changed, only the texture mapping from the
texture mapping palette will be modified.

Read Texture Mapping From Node
This tool reads the texture mapping index (pointing at the texture mapping palette) from
the polygons in the selected geometry and applies it as the current texture mapping. This
tool only works if all selected polygons have the same texture mapping index.

Apply Material
This tool applies the current material to all polygons in the selected geometry.
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Read Material From Node
This tool reads the material from the polygons in the selected geometry and applies it as
the current material. This tool only works if all selected polygons have the same material.

Apply Shader
This tool applies the current shader to all polygons in the selected geometry.

Read Shader From Node
This tool reads the shader from the polygons in the selected geometry and applies it as
the current shader. This tool only works if all selected polygons have the same shader.

Remove Texture
This tool removes the texture and detail texture, as well as the texture coordinates and
texture mappings from all polygons in the selected geometry.

Remove Texture Mapping
This tool removes all texture mapping indices from all polygons in the selected geometry.
Note that it’s only the texture mapping indices that will be set to -1, the UV coordinates
of the vertices won’t be modified. This means that the appearance will be similar to what
it was before, but the texture mapping will now be controlled only by the UV coordinates,
which will imply a different appearance for e.g. four-point mappings. If the texture and
mapping should be removed completely, use the Remove Texture tool.

Remove Material
This tool removes the material from all polygons in the selected geometry.

Remove Shader
This tool removes the shader from all polygons in the selected geometry.
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TEXMAP (Texture mapping tools)
Map Texture
With this tool, a texture can be mapped on to a number of selected polygons or all
polygons beneath the selected sub-trees. The currently chosen texture is applied to the
polygons and texture coordinates are applied to their vertices in different ways
depending on if planar, cylindrical or spherical mapping is chosen. If the user chooses to
add this mapping to the texture mapping palette, an index for the new mapping created
will also be applied to the polygons.
The Map Texture tool supports multi-texturing. To apply a base texture, layer 0 should be
used. The other seven layers are used for multi-texturing. When done with one layer the
button Texture New Layer should be clicked. If the Texture New Layer button isn’t clicked
and a new layer is chosen, the previous layer will be restored to its previous texture.
The texture mapping is controlled by indicating up to four geometry coordinates with the
middle mouse button. With the First, Second, Third and Fourth radio buttons, the user
can switch between these geometry coordinates. As a default, they are automatically
activated one by one, starting with the first. The geometry coordinates have different
impact on the texture mapping depending on the mapping type and if adding to palette is
chosen or not. This is described in more detail in the following sections. For planar
mappings (3-point and 4-point), each geometry coordinate corresponds to a texture
coordinate (u, v) which can be manually modified by the user, either by entering the
values in the text boxes or by clicking and dragging the corresponding points in the
texture image below. By clicking the Full View button, a window with a full size view of
the texture image is opened, also allowing for modifying the (u, v) coordinates in the
same way.
These (u, v) coordinates are horizontal (u) and vertical (v) positions in the texture image
and range from 0 to 1. A u-value of 0 means the left-most position while a u-value of 1
means the right-most position. Likewise, a v-value of 0 means the bottom position and a
v-value of 1 means the top position. If new geometry is selected, the corresponding
texture coordinates will be reset to their default values, unless the Freeze check box is
enabled. Both the geometry coordinates and the corresponding texture coordinates will
be reset if a new texture is chosen.
If planar (3-point or 4-point) mapping is chosen, the first, second and third geometry
coordinates are lower left, lower right and upper right points of the virtual plane (at least
the default corresponding texture coordinates imply these corner points). The texture
coordinates applied to the vertices will be interpolated between the texture coordinates
to which these coordinates correspond. In the case of 4-point mapping, a fourth
geometry point is added, representing the upper left point of the mapping. This fourth
geometry point will actually be projected in to the plane described by the first, second
and third points. Its corresponding texture coordinate will contribute to the mapping and
the result could be a non-linear mapping that is useful for non-orthogonal texture
images. Note that a 4-point texture mapping needs to be added to the texture mapping
palette in order to work in the expected way. When adding to palette, the Open GL
TexGen functionality will be used, resulting in a continuous non-linear mapping.
Therefore, adding to palette will be the default when choosing 4-point mapping. It’s still
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possible to use 4-point mapping without adding it to the texture mapping palette and in
some cases that might be sufficient.
Cylindrical and spherical mappings behave differently depending on whether the Add To
Palette check box is enabled or not, as described in the following sections. This is due to
the need for supporting the OpenFlight® texture mapping format when adding to palette
is chosen. If we’re not adding the texture mapping palette, a more advanced texture
mapping is allowed.

Mapping texture and adding to palette
For cylindrical mapping when adding to palette, the first geometry coordinate is the
bottom center of the virtual cylinder. The second geometry coordinate is the top center
of the virtual cylinder. Repetitions is the number of times the texture width is wrapped
around the cylinder.
For spherical mapping when adding to palette, the one and only geometry coordinate is
the virtual sphere origin. Repetitions is the number of times the texture is wrapped
around the sphere, both horizontally and vertically.

Mapping texture without adding to palette
For cylindrical mapping when not adding to palette, the first geometry coordinate is the
virtual cylinder origin. The second geometry coordinate should be placed at the virtual
cylinder surface and the line between the first and the second coordinate defines the
zero-line for the horizontal angle. The third geometry coordinate should be placed
directly above the second geometry coordinate and thereby defines the height of the
texture mapping. The three geometry coordinates together define the position and
orientation of the virtual cylinder. Horizontal Repetitions is the number of times the
texture width is wrapped around the cylinder.
For spherical mapping when not adding to palette, the first geometry coordinate is the
virtual sphere origin. The second geometry coordinate should be placed at the virtual
sphere surface and the line between the first and the second coordinate defines the zeroline for the horizontal angle. The third geometry coordinate should be placed directly
above the second geometry coordinate and the line between the second and the third
geometry coordinates defines the zero-line for the vertical angle. The three geometry
coordinates together define the position and orientation of the virtual sphere. Horizontal
Repetitions is the number of times the texture width is wrapped around the sphere.
Vertical Repetitions is the number of times the texture height is wrapped around the
sphere.

Move Texture Map
This tool moves the texture on the currently selected primitives. The texture can be
moved using the pivot point of the selection relative to a new coordinate indicated by
pressing the middle mouse button. A new position can be assigned to the pivot point
prior to the movement using Ctrl + Middle mouse button.
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The user can choose to freeze the X, Y or Z axis to avoid moving the texture in the
corresponding directions. An exact movement can also be performed by manually
specifying the coordinate in the x, y and z input boxes and clicking the Move button. If
the Move button is clicked again, the same relative movement will be repeated.
The move texture map tool can also be controlled by a gizmo. When pressing down the
middle mouse button on one of the arrows or planes between the arrows, the texture on
the selected geometry can be moved in the arrow’s direction or in the plane defined by
the arrows.
To control for which multi-texture layer the texture map is to be transformed, the
Texture Layer combo-box can be used.
Note that all texture mapping indices on the polygons in the selected geometry will be
reset, since changing the mappings of the texture mapping palette is not the intention of
this tool.

Rotate Texture Map
This tool rotates the texture on currently selected primitives around a specified axis. The
axis can quickly be chosen as X, Y or Z by using the convenient X, Y and Z buttons. An
existing edge can also be selected as rotation axis by clicking the Pick Rotation Edge
button and selecting one of the existing edges in the model using the left mouse button.
The current rotation axis is visualized as a yellow line. Note that when picking an edge to
define the direction of the rotation axis, it’s only the direction and not the position of the
rotation axis which is defined. To actually force the rotation axis to be the same as the
picked edge, it has to be translated by moving the pivot point to the picked edge’s center
using the Edge mode and Shift + Ctrl + Middle mouse button. The pivot point can also be
moved to any coordinate on the picked edge by indicating a coordinate either on the grid
or snapped to a vertex.
The actual texture rotation can be performed by clicking and dragging the middle mouse
button up and down in the model view. An exact angle (in degrees) can also be specified
in the Angle input box in which case the Rotate button must be clicked to confirm the
rotation. If the Rotate button is clicked again, a new rotation with the same angle is
performed.
The rotate texture map tool can also be controlled by a gizmo. When pressing down the
middle mouse button on one of the boxes on the rotation circles, the texture on the
selected geometry can be rotated around the axis that goes through the center of the
rotation circle.
To control for which multi-texture layer the texture map is to be transformed, the
Texture Layer combo-box can be used.
Note that all texture mapping indices on the polygons in the selected geometry will be
reset, since changing the mappings of the texture mapping palette is not the intention of
this tool.
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Scale Texture Map
This tool scales the texture on the currently selected primitives from the current pivot
point. The user can choose to freeze the X, Y or Z axis to avoid scaling in the
corresponding direction. The actual scaling can be performed by clicking and dragging
the middle mouse button up and down in the model view.
An exact scaling factor (in percent) can also be specified in the Scale input box in which
case the Scale button must be clicked to confirm the scaling. If the Scale button is clicked
again, a new scaling with the same factor is performed.
The scale texture map tool can also be controlled by a gizmo. When pressing down the
middle mouse button on one of the arrows or planes between the arrows, the texture on
the selected geometry can be scaled in the direction of the arrow or in the plane by
dragging the mouse in the arrow’s direction or within the plane. When scaling with the
plane, the scaling can be uniform in both directions or individual in each direction of the
axes that make up the plane. This is controlled by a setting described in the Preferences
section.
To control for which multi-texture layer the texture map is to be transformed, the
Texture Layer combo-box can be used.
Note that all texture mapping indices on the polygons in the selected geometry will be
reset, since changing the mappings of the texture mapping palette is not the intention of
this tool.

47

Remo 3D™ v2.10 User’s Guide

Modify UV

This tool offers an alternative way of modifying an existing texture mapping. Choose the
multi-texture layer and press the Modify UV button to present the texture mapping of the
currently selected geometry, projected into the current texture space. This is only
possible when the selected geometry has exactly one texture mapped.
In the Modify UV window, left-clicking and dragging vertices will result in modifying their
texture coordinates correspondingly. Each release of the mouse button and each click on
the mirror icons (see below) will produce an undoable command. Undo/redo of Modify UV
commands can be performed with Ctrl+Z and Ctrl+Y respectively. Note that any palette
texture mapping will be inactivated for the modified polygons.
Vertices can be selected with a box selection as well, by clicking and dragging the left
mouse button. Selected vertices are marked in orange and surrounded by a orange/black
rectangle with handles in the corners and edge centers (more about these handles
below). Vertices can be added and removed from the selection by holding Shift and Alt
respectively.
The entire texture perimeter, i.e. the [0, 1] texture coordinate interval in both directions,
is marked with an green/black rectangle.
The view can be moved by clicking and dragging Ctrl + right mouse button, and zoomed
by clicking and dragging Shift + right mouse button or using the mouse wheel, all in the
same manner as in the viewport.
To be able to separately modify neighboring vertices whose texture coordinates coincide,
there is a Shrink button available. This can also be activated with the 's' key.
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There are buttons for Fit Selected and Fit Texture, that will zoom and pan the current
view to the selected geometry and the entire texture (the green/black rectangle)
respectively. These can also be activated with the 'v' and space keys respectively.
To be able to view the result in the model view (move the Modify UV window to see the
model view behind), there is a Fit Viewport button that will pan, rotate and zoom the
model view to the selected geometry. If certain vertices are selected and marked orange
in the Modify UV view, the model view will be focused on only these corresponding
vertices and they will also be orange in the model view.
When multiple vertices have been selected so that they are marked by the orange/black
rectangle, they can be scaled or rotated in the UV space by left-clicking and dragging the
corner and edge handles. Scale and rotate mode can be switched with the icons in the
top left corner of the Modify UV window, scale mode is default.
The selected vertices can also be mirrored horizontally or vertically in the UV space by
clicking one of the two mirror icons to the right of the scale/rotate mode icons.
The Freeze U and Freeze V check boxes in the top right corner will cause the U and V
directions to freeze when moving or scaling the vertices in the UV space.
The snap check box is enabled by default and will make selected vertices with identical
texture coordinates snap to other vertices when moved.
The Modify UV dialog can be closed with the Close button, the cross button in the upper
right corner or by pressing Escape.

MODIFY (Modification tools)

Mirror
This tool mirrors the selected geometry with respect to the plane described by the grid in
the focused viewport. Note that matrix transformed geometry will be mirrored as if it
wasn’t transformed.

Reverse Polygon
This tool reverses a number of selected polygons or all polygons beneath the selected
sub-trees. The side from which the vertices of a polygon are ordered counter-clockwise is
defined as the upside of the polygon. With this in mind, this tool can be used to define
the upsides and downsides of polygons.
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Slice
This tool allows the user to slice the selected geometry along the grid plane or along
planes orthogonal to the grid lines. Note that slicing will be performed as if the grid would
be infinite. Normals and texture coordinates are interpolated for new vertices created by
the slice operation. After the slice operation, all faces that were actually sliced are
automatically selected.

Split/Triangulate
With this tool, polygons and edges can be split in different ways. When selecting an edge
and activating this tool, the edge is split in two halves. If a polygon is selected, the tool
will triangulate the polygon into a number of triangles. This works for concave as well as
convex polygons. If two vertices in the same polygon are selected, the polygon will be
split along a new edge between the vertices. Normals and texture coordinates are
interpolated for new vertices created by the split operation.

Extrude
With this tool, selected geometry can be extruded, i.e. raised to a certain level in a
certain direction (or along a certain extrusion axis). For example, it can be used to create
a box out of a quad polygon. An extruded polygon is moved along the extrusion axis to
the desired level and new polygons (walls) are created along its borders. The extruding
operation is defined by a number of parameters described below. The actual extrusion
(with an implicated undoable extrusion command) is performed when a position is
indicated or the Apply Parameters button is clicked. If a position is indicated any changed
parameters will also be applied.
The extrusion axis can be defined by indicating a position in the model view. This way of
defining the axis is chosen by selecting the ‘Free’ radio button. The axis is then defined
as the vector from each selected polygon to the indicated position. The 'Shared Axis' can
be used here and then the axis for extrusion will be an axis from the pivot point to the
indicated point.
The extrusion axis can also be defined by the polygon normal (chosen by selecting the
‘Polygon Normal’ radio button), in which case the extrusion level can be specified by
typing a distance (positive or negative) in the ‘Height’ field or indicating a position in the
model view by pressing the middle mouse button. Note that the indicated position is not
necessarily the actual position to which the extrusion is made, since the polygon normal
is used as extrusion axis. Instead, the indicated position is projected onto the polygon
normal.
The extrusion axis can also be defined only by indicating a position in the model view.
This way of defining the axis is chosen by selecting the ‘Free’ radio button. The axis is
then defined as the vector from each selected polygon to the indicated position. The
‘Shared Axis’ can be used here as well.
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For both types of extrusions, ‘Keep Floor’ controls whether floor polygons are to be
created in the original polygon positions or not. The floor polygons are essentially
reversed copied of the original polygons selected for extrusion.
The extrude tool can also be controlled by a gizmo. When pressing down the middle
mouse button on one of the arrows or planes between the arrows, the selected geometry
can be extruded in the arrow's direction or in the plane defined by the arrows.

Revolve
With this tool, selected geometry can be revolved about a specified axis. The axis can
quickly be chosen as X, Y or Z by using the convenient X, Y and Z buttons. An existing
edge can also be selected to define the direction of the revolve axis by clicking the Pick
Revolve Edge button and selecting one of the existing edges in the model using the left
mouse button.
The current revolve axis is visualized as a yellow line. Note that when picking an edge to
define the direction of the revolve axis, it’s only the direction and not the position of the
revolve axis which is defined. To actually force the revolve axis to be the same as the
picked edge, it has to be translated by moving the pivot point to the picked edge’s center
using the Edge mode and Shift + Ctrl + Middle mouse button. The pivot point can also be
moved to any coordinate on the picked edge by indicating a coordinate either on the grid
or snapped to a vertex.
The revolving process is performed by specifying a total revolve angle (in degrees) and a
number of steps in the Angle and Steps input boxes and clicking the Revolve button. If
the Revolve button is clicked again, a new revolving process with the same angle will be
performed.

Subdivide
This tool allows the user to increase complexity of the selected geometry and create
smoother looking objects. Each polygon will be subdivided into several new polygons.
The subdivision uses the Catmull-Clark algorithm. The new subdivided geometry will be
shown in orange together with the original geometry. The resulting polygons from the
subdivision will always be quads.
To control the subdivision, the number of iterations can be specified.
If the Subdivide Borders check box is enabled, the borders of the geometry will also be
subdivided; otherwise they will be unmodified.
To create the new subdivided geometry, press the Done button.
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Simplify
This tool allows the user to reduce complexity of the selected geometry. The reduction of
the geometry is performed by an edge collapse method. To be able to simplify the
geometry, all polygons in the selection need to be triangles (the Split/Triangulate tool
can be used to split non-triangular polygons into triangles). The original geometry will be
shown while the simplification is performed to make it easier to see the differences.
In the selected geometry faces that are siblings will be grouped and simplified together,
e.g. two different object nodes will be simplified independently of each other.
There are two parts of the selected geometry that can be simplified, the boundary of the
selection and the interior. The level of reduction for the interior is controlled by the
Simplify Level slider and for the boundary the Boundary Simplify Level slider is used.
Both sliders range from 0 to 100 percent reduction, where 0 means no reduction at all
and 100 percent means maximum reduction. To control the order in which the edges are
collapsed, the Edge Weight Ratio slider can be used for the interior and the Boundary
Edge Weight Ratio can be used for the boundary.
The Edge Weight Ratio slider goes from Edge Length to Normal Deviation, where Edge
Length will remove the shortest edges first and Normal Deviation will remove the edges
that will cause the least deviation of the normals on the affected polygons. It is possible
to place the slider somewhere between Edge Length and Normal Deviation, this will
cause the edge weight to be a mix between the Edge Length and the Normal Deviation.
One way of looking at the different methods of calculating edge weights is that Edge
Length will remove detail while Normal Deviation will try to preserve detail.
The Boundary Edge Weight Ratio Slider ranges from Edge Length to Edge Angles, where
Edge Length will remove the shortest edges first and Edge Angles will remove the edges
with the smallest angle deviation toward the adjacent edges. It is possible to place the
slider somewhere between Edge Length and Edge Angles, this will cause the edge weight
to be a mix between the Edge Length and the Edge Angles.
It is possible to control the new vertex position when an interior edge is collapsed, this is
done by checking the radio buttons in the Vertex Weight box. Equal implies that all
vertices have equal weight and the new vertex position will be in the middle of the edge
that is collapsed. Normal Deviation will consider the change of the adjacent polygons
when calculating the weight of the vertices, so the new vertex position can be shifted
toward one of the ends of the edge. When an interior edge that has one of its vertices on
the boundary is collapsed, the new vertex position will be the same as the previous
vertex on the boundary. When a boundary edge is collapsed, the new vertex position is
the same as the vertex with the largest weight in the collapsed edge.
There are three different ways of coloring the simplified geometry, this is controlled by
checking the radio buttons in the Coloring box.
Uniform will set the same color on all edges.
Vertex Weight will color the vertices according to the vertex weight. Interior vertices
will be colored from red to yellow, where the red vertices have the smallest weights.
Boundary vertices will be colored from blue to green, where the blue vertices have
the smallest weights.
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Edge Weight will color the edges according to the edge weight. Interior edges will be
colored from red to yellow, where the red edges have the smallest weights. Boundary
edges will be colored from blue to green, where the blue edges have the smallest
weights.
In the Number Of Faces output box the current number of polygons will be shown.
To create the new simplified geometry, press the Done button.

Merge
This tool merges geometry in three different ways:
If polygons or other regular nodes are selected, each collection of connected coplanar polygons with matching attributes in the selected sub-tree is exchanged for
one polygon made up of the outer edges of the collection. Note that this means the
polygons have to be in the same plane and share the same edges, measured with the
tolerance described in the Preferences section. Also note that polygons with different
attributes, such as different textures, materials or colors, will not be merged.
If vertices are selected, they will be merged to a triangulated mesh beneath a new
object node. The selected original vertices won't be affected.
If edges are selected, all connected rings of edges will be merged to convex or
concave polygons. This is useful for closing holes, especially together with Select
Naked Edges feature from the Selection menu. The selected original edges won't be
affected.
You will only be able to select either vertices, edges or other nodes or polygons at a time.
The merged polygons are automatically selected.

Quantify
This tool quantifies all vertex positions in the selected geometry with a specified
quantification value. Quantification simply means to change the x, y and z of a vertex to
the nearest value divisible by the specified quantification value. The quantification is
performed when the Quantify button is clicked. This can for example be useful for
snapping free-hand indicated coordinates to a specified accuracy. It can also be used for
fixing erroneous coordinate inaccuracies in a model.
Note that some of the Remo 3D tools can introduce inaccuracies in vertex positions. This
problem will be addressed in future versions of Remo 3D, but until then the Quantify tool
can be used to fix these inaccuracies.
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Shade
With this tool, normals are calculated for the vertices in the selected geometry. If flat
shading is selected, the normals will be set to their polygon normals, creating a flat
appearance when lighting is applied to the geometry. If smooth shading is selected, the
normals will be interpolated, creating a smooth appearance.
Note that the polygons must be set to use the Vertex Color Lit or Polygon Color Lit light
modes in order to make the lighting work with the calculated normals. This can be done
with the Attribute tool or directly in this tool with the convenient Update Light Mode
check box and the Light Mode pull-down menu.
When using smooth shading, an input box for entering a crease angle will be activated.
The crease angle is used to specify a threshold angle for when the angle between
polygon normals is too large to be smoothed. E.g. if you specify a crease angle of 90
degrees all angles between polygon normals that are less then 90 degrees will be
smoothed.
Also note that when smooth shading is selected, different results are produced when
selecting adjacent geometries and shading them at the same time, than when selecting
and shading them one at a time. This is because the interpolation will take both
geometries into consideration.
The actual creation of normals is performed when clicking the Shade button.

ATTR (Attribute tools)
Apply Attributes
With this tool, attributes for the selected primitives can be viewed and modified. Note
that attributes for primitives of different types can’t be modified at once. Attributes not
having the same value in all the selected primitives are indicated as gray.
The new attributes are confirmed by clicking the Apply button. The modified attributes,
including those that were not the same from the beginning, are assigned to all selected
primitives. The unmodified attributes are completely left alone, even those that differ
among the primitives. This allows the user to modify a certain attribute for a number of
primitives while leaving the other attributes unchanged.
If the current model is in indexed color mode (RGB Mode is unchecked in the header
node attributes), color for polygons and vertices can be changed by editing the color
index (0 - 1023) and intensity (0 - 127) or by clicking the color box next to the index and
intensity attributes. If the color box is clicked, the corresponding palette will emerge and
let the user select the desired color. The same applies for polygon textures.
If the model is in RGB mode, the color of polygons and vertices can be changed by either
editing the red, green and blue values (0 - 255) or by clicking the color box next to the
RGB values. In that case, a color chooser dialog will appear and let the user choose a
new RGB color.
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When unchecking the RGB mode header node attribute and clicking the Apply button,
each polygon and vertex color will be translated to a color index and intensity which will
give the nearest corresponding RGB color.
Note that not all attributes are considered when visualizing the geometry in Remo 3D.
However, all attributes will be saved in the OpenFlight® file.
The attribute tool is activated either by clicking its icon or by double-clicking any
primitive in the model view or in the tree view. The following is a description of the
attributes of each primitive type:

Header Attributes
The tables below describe the header attributes.
The General tab contains the following attributes:
Name

The header node name.

Coordinate Units

The unit used for this model’s coordinates
(meters, kilometers, feet, inches or
nautical miles).

Save Vertex Normals

Enabled if vertex normals should be saved
in the OpenFlight® file (not used in Remo
3D, always saved).

New Textured Polygon White

Enabled if created polygons with textures
are to be rendered white.

RGB Mode

Enabled if polygon and vertex colors are
defined as RGB instead of indexed.

Format Version

The OpenFlight® format version. This will
always be 16.2 for files created in Remo
3D v2.10.

Database Version

A version number for the current model.
This number will increase each time the file
is saved.

Revision Date

The date and time for the last time this file
was saved.

Next IDs – Polygon

The ID of the next polygon to be created.

Next IDs – Object

The ID of the next object to be created.

Next IDs – Group

The ID of the next group to be created.

Next IDs – LOD

The ID of the next LOD to be created.

Next IDs – DOF

The ID of the next DOF to be created.

Next IDs – Switch

The ID of the next switch to be created.

Next IDs – Light Point

The ID of the next light point to be
created.

Next IDs – Light Source

The ID of the next light source to be
created (not used by Remo 3D).

The Projection tab contains the following attributes:
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Projection Type

The type of projection used in this model
(Flat Earth, Trapezoidal, Round Earth,
Lambert, UTM, Geodetic or Geocentric).

Earth Ellipsoid Model

The ellipsoid used in this model (WGS
1984, WGS 1972, Bessel, Clarke 1866 or
NAD 1927).

SW Corner Latitude

The south-west corner latitude of the area
covered by this model (decimal degrees).

SW Corner Longitude

The south-west corner longitude of the
area covered by this model (decimal
degrees).

NE Corner Latitude

The north-east corner latitude of the area
covered by this model (decimal degrees).

NE Corner Longitude

The north-east corner longitude of the area
covered by this model (decimal degrees).

Origin Latitude

The latitude of this model’s origin (decimal
degrees).

Origin Longitude

The longitude of this model’s origin
(decimal degrees).

SW Database Coordinate X

The south-west corner coordinate x value.

SW Database Coordinate Y

The south-west corner coordinate y value.

Database Offset X

The x value of the offset used for placing
the model in a receiving system.

Database Offset Y

The y value of the offset used for placing
the model in a receiving system.

Group Attributes
The table below describes the group attributes.
Note that the visibility of a group node’s children can be modified manually by ordinary
hiding and showing of the child nodes. However, applying attributes for a group with a
Forward or Backward sequence animation type will reset the visibility of the group’s
children so that only the first or last child is visible.
Name

The group node name.

Replications

The number of times to replicate this
group. A value of 0 is equal to no
replications and the group will be
visualized as normal. The replications are
transformed by a transformation matrix on
the group.

Sequence

The type of sequence animation used for
this group’s children (None, Forward or
Backward).

Loop Count

The number of sequence animation loops,
0 means looping forever.

Loop Duration

The duration of each loop (seconds), 0
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means as fast as possible.
Last Frame Duration

The duration of the last loop (seconds), 0
means the same duration as previous
loops.

Swing

Enabled if sequence animation should
swing back in the opposite direction after
playing the last loop (which is not
repeated).

Object Attributes
The table below describes the object attributes.
Name

The object node name.

Transparency

The transparency value of the geometry
beneath this object node (0.0 - 1.0).

Flat Shaded

Enabled if the geometry beneath this
object node is to be flat shaded (not
visualized in Remo 3D).

Shadow

Enabled if the geometry beneath this
object node defines the shadow object of
the group above.

Illuminated

Enabled if the geometry below this object
node can be illuminated (not used in Remo
3D, defined by polygons).

Display In Daylight

Enabled if the geometry below this object
node will be displayed in daylight.

Display At Dusk

Enabled if the geometry below this object
node will be displayed at dusk.

Display At Night

Enabled if the geometry below this object
node will be displayed at night.

Polygon Attributes
The tables below describe the polygon attributes.
The General tab contains the following attributes:
Name

The polygon node name.

IR Color Code

A color code for infra-red visualization in
the receiving system.

IR Material Code

A material code for infra-red classification
in the receiving system.

Feature ID

A feature identification code.

Surface Material Code

A classification code defining the material
of this polygon.

Replications

The number of times to replicate this
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polygon. A value of 0 is equal to no
replications and the polygon will be
visualized as normal. The replications are
transformed by a transformation matrix on
the polygon.
Terrain

Enabled if this polygon is defined as
terrain.

Footprint

Enabled if this polygon is defined as the
footprint of the model (e.g. used for
connecting the model to the terrain).

The Drawing tab contains the following attributes:
Draw Mode

Defines how this polygon is drawn (Solid
One Side, Solid Both Sides, Wireframe
closed or Wireframe unclosed).

Light Mode

Defines how this polygon is lit (Polygon
Color (Flat), Vertex Color (Gouraud),
Polygon Color Lit or Vertex Color Lit).

Billboard/Alpha

Defines the billboard and alpha behavior of
this polygon (Fixed/No Alpha, Fixed/Alpha,
Axis/Alpha or Point/Alpha).

Line Style

The line style index of this polygon (not
used in Remo 3D).

Transparency

The transparency of this polygon (0.0 –
1.0).

Textured Polygon White

Enabled if this polygon is to be rendered as
white if it’s textured.

Hidden

Enabled if this polygon is to be hidden.

The Color tab contains the following attributes:
Primary Color – Index

The color palette index of the primary color
(0 – 1023, -1 if none). Disabled if RGB
color mode is used.

Primary Color – Intensity

The intensity of the primary color (0 –
127). Disabled if RGB color mode is used.

Primary Color – Red

The red value of the primary color (0 –
255). Disabled if indexed color mode is
used.

Primary Color – Green

The green value of the primary color (0 –
255). Disabled if indexed color mode is
used.

Primary Color – Blue

The blue value of the primary color (0 –
255). Disabled if indexed color mode is
used.

Secondary Color – Index

The color palette index of the secondary
color (0 – 1023, -1 if none). Disabled if
RGB color mode is used. Secondary color
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isn’t visualized in Remo 3D.
Secondary Color – Intensity

The intensity of the secondary color (0 –
127). Disabled if RGB color mode is used.
Secondary color isn’t visualized in Remo
3D.

Secondary Color – Red

The red value of the secondary color (0 –
255). Disabled if indexed color mode is
used. Secondary color isn’t visualized in
Remo 3D.

Secondary Color – Green

The green value of the secondary color (0
– 255). Disabled if indexed color mode is
used. Secondary color isn’t visualized in
Remo 3D.

Secondary Color – Blue

The blue value of the secondary color (0 –
255). Disabled if indexed color mode is
used. Secondary color isn’t visualized in
Remo 3D.

The Surface tab contains the following attributes:
Texture – Layer

The multi-texture layer for which the
attributes below are modified (Layer 0 –
Layer 7). Layer 0 is the base texture layer.

Texture – Index

The texture palette index of this layer’s
texture (-1 if not used).

Texture – Multi-texture Effect

A multi-texture effect index (not visualized
in Remo 3D).

Texture – Multi-texture Data

A multi-texture data number (not
visualized in Remo 3D).

Texture – Texture Mapping Index

The texture mapping index of this layer’s
texture (-1 if not used). Note that a
texture can be mapped to a polygon either
by the texture coordinates of the polygon’s
vertices, or by this index into the texture
mapping palette.

Detail Texture –Index

The texture palette index of this polygon’s
detail texture (-1 if not used).
Note that detail textures are normally only
supported on SGI® hardware. They are not
visualized in Remo 3D.

Material – Index

The material palette index of this polygon’s
material (-1 if not used).

Shader – Index

The shader palette index of this polygon’s
shader (-1 if not used).
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Light Point Attributes
This section describes the attributes of “ordinary” inline light points. Indexed light point
attributes are described in the Indexed Light Point Attributes section.
Note that the color of each light point vertex is defined by the vertex color. The light
point attributes only define the back color of a bidirectional light point.
Also note that the visualization of a light point in Remo 3D is only based upon the light
point vertex color, the minimum and maximum pixel sizes, the directional type, the lobe
horizontal and vertical angles and the lobe roll angle. Other attributes are applied to the
light point in the OpenFlight® file but won’t affect the visualization in Remo 3D.
The tables below describe the inline light point attributes.
The General tab contains the following attributes:
Name

The light point node name.

Display Mode

Defines how this light point is displayed
(Raster, Calligraphic or Either).

Feature ID

A feature identification code.

Surface Material Code

A classification code defining the material
of this light point.

Front Intensity

Intensity scalar for front color.

Back Intensity

Intensity scalar for back color.

Replications

The number of times to replicate this light
point. A value of 0 is equal to no
replications and the light point will be
visualized as normal. The replications are
transformed by a transformation matrix on
the light point.

Back Color

Enabled if back color is used for
bidirectional light points.

Back Color – Index

The color palette index of the back color (0
– 1023, -1 if none). This color is always
indexed, even if the model is in RGB mode.

Back Color – Intensity

The intensity of the back color (0 – 127).
This color is always indexed, even if the
model is in RGB mode.

Display In Daylight

Enabled if this light point will be displayed
in daylight.

Display At Dusk

Enabled if this light point will be displayed
at dusk.

Display At Night

Enabled if this light point will be displayed
at night.

The Direction tab contains the following attributes:
Directional Type

Defines the directions of this light point’s

60

Remo 3D™ v2.10 User’s Guide

emitting light (Omnidirectional,
Unidirectional or Bidirectional).
Horizontal Lobe Angle

The horizontal angle of the light lobe
(degrees).

Vertical Lobe Angle

The vertical angle of the light lobe
(degrees).

Lobe Roll Angle

The roll angle of the light lobe (degrees).

Falloff Exponent

Exponential value controlling the falloff
between center and edge of the light lobe.
Linear falloff = 1.0.

Ambient Intensity

The ambient intensity of the light point
when viewed off-axis.

The Anim (animation) tab contains the following attributes:
Period

The animation period (seconds).

Phase Delay

The animation phase delay (seconds).

Enabled Period

The part of the animation period where the
light point is switched on (seconds).

Rotation Axis – i

The i (x) value of the rotation axis.

Rotation Axis – j

The j (y) value of the rotation axis.

Rotation Axis – k

The k (z) value of the rotation axis.

Flashing

Enabled if the light point is flashing.

Rotating

Enabled if the light point is rotating.

Counter Clockwise

Enabled if the light point rotation is defined
counter-clockwise.

The Callig (calligraphic) tab contains the following attributes:
Significance

Priority used by raster/calligraphic hybrid
systems for deciding which light points that
should be switched to raster mode at high
visualization loads (0.0 – 1.0).

Drawing Order

Calligraphic draw order index.

Minimum Defocus

Lower calligraphic defocus limit (0.0 –
1.0).

Maximum Defocus

Upper calligraphic defocus limit (0.0 –
1.0).

Quality

Calligraphic quality (Low, Medium or High).

Proximity Occulting

Enabled if the intensity of adjacent light
points are to be decreased when viewed
from a distance.

The Misc (miscellaneous) tab contains the following attributes:
Range Mode

Method for calculating the distance
between the viewer and the light point
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(Depth Buffer or Slant Range).
Randomize Intensity

The random intensity level (Off, Low,
Medium or High).

Fog Scale

The level of light point visibility through
fog. Values above 0.0 imply punching
through the fog.

Fog Intensity

Intensity factor controlling the light point
alpha.

Size Difference Threshold

Light point visibility threshold in pixels.

Transparent Pixel Size

Size in pixels where light points start
becoming transparent.

Transparent Falloff Exponent

Exponential value controlling the
transparent falloff. Linear falloff = 1.0.

Transparent Scale

Scale factor controlling the transparent
falloff.

Transparent Clamp

Minimum transparent falloff.

Minimum Pixel Size

Minimum diameter in pixels.

Maximum Pixel Size

Maximum diameter in pixels.

Actual Size

Diameter in database units (e.g. meters).

Perspective Mode

Enabled if perspective fading is to be used.

Reflective Only

Enabled if light point is reflective instead of
emissive.

Fading

Enabled if perspective fading calculations
are to be used.

Fog Punch

Enabled if light point is to punch through
fog.

Indexed Light Point Attributes
The table below describes the indexed light point attributes.
Name

The indexed light point node name.

Appearance Index

The light point palette index for the
appearance of the indexed light point.

Animation Index

The light point palette index for the
animation of the indexed light point.

Calligraphic Draw Order

Calligraphic draw order index.

Replications

The number of times to replicate this
indexed light point. A value of 0 is equal to
no replications and the indexed light point
will be visualized as normal. The
replications are transformed by a
transformation matrix on the indexed light
point.
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Light Point System Attributes
The table below describes the light point system attributes.
Name

The light point system node name.

Intensity

The intensity of the light points beneath
this light point system node. This will not
affect the visualization in Remo 3D but
might be used in the target runtime
system.

Animation State

The animation state of the light points
beneath this light point system node (On,
Off or Random). This will not affect the
visualization in Remo 3D but might be
used in the target runtime system.

Enabled

Enables or disables the light points
beneath this light point system node. This
will not affect the visualization in Remo 3D
but might be used in the target runtime
system.

Vertex Attributes
The tables below describe the vertex attributes.
The Coordinates tab contains the following attributes:
Name

The vertex name, automatically created by
its parent polygon or light point name plus
the vertex number. This attribute is readonly.

Coordinate – x

The x value of the vertex coordinate.

Coordinate – y

The y value of the vertex coordinate.

Coordinate – z

The z value of the vertex coordinate.

Texture Coordinate

Enabled if the vertex has a texture
coordinate.

Texture Coordinate – u

The horizontal u value of the vertex
texture coordinate.

Texture Coordinate – v

The vertical v value of the vertex texture
coordinate.

Normal

Enabled if the vertex has a normal.

Normal – i

The i (x) value of the vertex normal vector.

Normal – j

The j (y) value of the vertex normal
vector.

Normal – k

The k (z) value of the vertex normal
vector.

Hard Edge

Enabled if the parent polygon normal is to
be used for shading (not used by Remo
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3D).
Frozen Normal

Enabled if the vertex normal is fixed (not
used by Remo 3D).

The Color tab contains the following attributes:
Color – Index

The color palette index of the vertex color
(0 – 1023, -1 if none). Disabled if RGB
color mode is used.

Color – Intensity

The intensity of the vertex color (0 – 127).
Disabled if RGB color mode is used.

Color – Red

The red value of the vertex color (0 –
255). Disabled if indexed color mode is
used.

Color – Green

The green value of the vertex color (0 –
255). Disabled if indexed color mode is
used.

Color – Blue

The blue value of the vertex color (0 –
255). Disabled if indexed color mode is
used.

LOD Attributes
The table below describes the LOD attributes.
Name

The LOD node name.

Switch Range – Switch In (far range)

The far range at which the LOD is switched
in, in database units (e.g. meters).

Switch Range – Switch Out (near range)

The near range at which the LOD is
switched out, in database units (e.g.
meters).

Switch Range – Transition

The interval in which the LOD is faded, in
database units (e.g. meters).

Use Previous Slant Range

If this attribute is enabled, the target
runtime system can assume the same
slant range (distance from viewer to LOD
center) as this node’s left sibling.

Additive LODs Below

This indicates that the LOD nodes beneath
this LOD node are additive, i.e. that they
add details rather than replace details.

LOD Center – x

The x value of the LOD center coordinate.

LOD Center – y

The y value of the LOD center coordinate.

LOD Center – z

The z value of the LOD center coordinate.

Freeze LOD Center

Enabled if the LOD center is to be frozen
and not recalculated in the receiving
system.
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Note that the LOD center can be retrieved from the current pivot point by clicking the Get
From Pivot button.

DOF Attributes
The tables below describe the DOF attributes.
The General tab contains the following attributes:
Name

The DOF node name.

Origin X

The x value of the origin of the DOF local
coordinate system.

Origin Y

The y value of the origin of the DOF local
coordinate system.

Origin Z

The z value of the origin of the DOF local
coordinate system.

Point On X Axis X

The x value of the point on the x-axis of
the DOF local coordinate system.

Point On X Axis Y

The y value of the point on the x-axis of
the DOF local coordinate system.

Point On X Axis Z

The z value of the point on the x-axis of
the DOF local coordinate system.

Point In XY Plane X

The x value of the point in the xy-plane of
the DOF local coordinate system.

Point In XY Plane Y

The y value of the point in the xy-plane of
the DOF local coordinate system.

Point In XY Plane Z

The z value of the point in the xy-plane of
the DOF local coordinate system.

Show Coordinate System

Toggle to control if a visual representation
of the DOF local coordinate system should
be shown.

Use Current Translation

Toggle to control if the DOF local
coordinate system shown should be
translated according to the current
translation.

Use Current Rotation

Toggle to control if the DOF local
coordinate system shown should be
rotated according to the current rotation.

The Origin, Point On X Axis and Point In XY Plane can be retrieved from the current pivot
point by clicking the Get From Pivot button.
The Pick... buttons can be used to pick the points with the middle mouse button in the
viewports. When the Origin Pick... button is checked and a point is picked it automatically
switches to pick the Point On X Axis and then switches to pick the Point in XY Plane.
The Translate tab contains the following attributes:
Minimum X

The x value of the minimum translation.
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Minimum Y

The y value of the minimum translation.

Minimum Z

The z value of the minimum translation.

Current X

The x value of the current translation.

Current Y

The y value of the current translation.

Current Z

The z value of the current translation.

Maximum X

The x value of the maximum translation.

Maximum Y

The y value of the maximum translation.

Maximum Z

The z value of the maximum translation.

Increment X

The x value of the translation increment.

Increment Y

The y value of the translation increment.

Increment Z

The z value of the translation increment.

Limit X

Enabled if translation in the x direction is
limited.

Limit Y

Enabled if translation in the y direction is
limited.

Limit Z

Enabled if translation in the z direction is
limited.

The Rotate tab contains the following attributes:
Minimum X Rotation (Pitch)

The minimum rotation around the x axis in
degrees.

Minimum Y Rotation (Roll)

The minimum rotation around the y axis in
degrees.

Minimum Z Rotation (Yaw)

The minimum rotation around the z axis in
degrees.

Current X Rotation (Pitch)

The current rotation around the x axis in
degrees.

Current Y Rotation (Roll)

The current rotation around the y axis in
degrees.

Current Z Rotation (Yaw)

The current rotation around the z axis in
degrees.

Maximum X Rotation (Pitch)

The maximum rotation around the x axis in
degrees.

Maximum Y Rotation (Roll)

The maximum rotation around the y axis in
degrees.

Maximum Z Rotation (Yaw)

The maximum rotation around the z axis in
degrees.

Increment X Rotation (Pitch)

The rotation increment around the x axis in
degrees.

Increment Y Rotation (Roll)

The rotation increment around the y axis in
degrees.

Increment Z Rotation (Yaw)

The rotation increment around the z axis in
degrees.

Limit X Rotation (Pitch)

Enabled if rotation around the x axis is
limited.
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Limit Y Rotation (Roll)

Enabled if rotation around the y axis
limited.

Limit Z Rotation (Yaw)

Enabled if rotation around the z axis
limited.

The Scale tab contains the following attributes:
Minimum X Scale

The x value of the minimum scale.

Minimum Y Scale

The y value of the minimum scale.

Minimum Z Scale

The z value of the minimum scale.

Current X Scale

The x value of the current scale.

Current Y Scale

The y value of the current scale.

Current Z Scale

The z value of the current scale.

Maximum X Scale

The x value of the maximum scale.

Maximum Y Scale

The y value of the maximum scale.

Maximum Z Scale

The z value of the maximum scale.

Increment X Scale

The x value of the scale increment.

Increment Y Scale

The y value of the scale increment.

Increment Z Scale

The z value of the scale increment.

Limit X Scale

Enabled if scaling in the x direction is
limited.

Limit Y Scale

Enabled if scaling in the y direction is
limited.

Limit Z Scale

Enabled if scaling in the z direction is
limited.

Switch Attributes
The table below describes the switch attributes.
Name

The switch node name.
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The rest of the switch attributes user interface controls the switch masks of the switch
node. Masks can be created and removed by using the Add Before,
Add After and Delete buttons. The area below these buttons lists
the currently available masks. A switch mask is represented by its
index number followed by a radio button indicating if this is the
currently active mask, directly followed by a number of check
boxes, one for each child of the switch node. If a check box is
enabled, its corresponding child will be visible when its switch mask
is active.
The picture to the right shows an example of the attributes of a
switch node having two children and three switch masks. In the
first mask (0) only the first child is visible, in the second mask (1)
the second child is visible and in the third mask (2) both children
are visible. The currently active mask is the second mask (1).
When editing a switch mask, the check boxes can be manually
enabled or disabled. To enable or disable all check boxes in one
mask, the All On and All Off buttons can be used. The Invert button
can be used to invert the status of the check boxes for the current
mask. If other masks than the currently active mask are edited,
don’t forget to reset the currently active mask again by clicking its
radio button before applying the switch attributes.

Note that the visibility of a switch node’s children can be modified
manually by ordinary hiding and showing of the child nodes.
However, applying attributes for a switch node will reset the visibility of the switch node’s
children according to the currently selected switch mask.

External Reference Attributes
The table below describes the external reference attributes.
Filename

The OpenFlight® filename of the external
reference.

Use External Color Palette

Enabled if indexed polygon and vertex
colors in the externally referenced
geometry will be fetched from the color
palette in the external file. Otherwise they
will be fetched from the current model’s
color palette.

Use External Material Palette

Enabled if materials in the externally
referenced geometry will be fetched from
the material palette in the external file.
Otherwise they will be fetched from the
current model’s material palette.

Use External Texture Palette

Enabled if textures and texture
mappings in the externally referenced
geometry will be fetched from the texture
and texture mapping palettes in the
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external file. Otherwise they will be fetched
from the current model’s texture and
texture mapping palettes.
Use External Line Style Palette

Enabled if line styles in the externally
referenced geometry will be fetched from
the line style palette in the external file.
Otherwise they will be fetched from the
current model’s line style palette (not used
in Remo 3D).

Use External Sound Palette

Enabled if sounds in the externally
referenced geometry will be fetched from
the sound palette in the external file.
Otherwise they will be fetched from the
current model’s sound palette (not used in
Remo 3D).

Use External Light Source Palette

Enabled if light sources in the externally
referenced geometry will be fetched from
the light source palette in the external file.
Otherwise they will be fetched from the
current model’s light source palette (not
used in Remo 3D).

Use External Light Point Palette

Enabled if indexed light points in the
externally referenced geometry will be
fetched from the light point palette in the
external file. Otherwise they will be fetched
from the current model’s light point
palette.

The external reference filename also can be specified by clicking the Browse (…) button
to next to the Filename field. Note that if the Load External References setting described
in the Preferences section is disabled, the model won’t be loaded until it’s enabled in the
External References dialog available from the File menu.

Apply Comment
The comment tool lets the user add, change or remove a comment on any node. If all
nodes selected don’t have the same comments, this is indicated by erasing the comment
field and making it gray. New or modified comments are confirmed by clicking the Apply
button. If a comment is modified and even if the comments of the selected nodes were
not the same, it is assigned to all selected nodes. If the comment is left unmodified, no
assignment is made, not even for the differing nodes.
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Modes
A mode represents the type of primitive that can currently be selected or snapped to.
The following modes are available:

Vertex
Vertices are corner points of polygon or light point nodes.

Edge
Edges are virtual structures representing pairs of consecutive vertices.

Polygon
Polygons are surface nodes, each one containing a number of vertices.

Object
Objects are hierarchy grouping nodes containing only polygon or light point nodes.

Group
Groups are general hierarchy grouping nodes.

LOD
LODs are level-of-detail hierarchy grouping nodes switched on or off depending on
viewing distance.

DOF
DOFs are degree-of-freedom hierarchy grouping nodes allowing for transformation of
contained geometry.
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Switch
Switches are hierarchy grouping nodes switching contained geometry on or off with a
number of switch masks.

Light Point
Light points are light point nodes, each one containing a number of vertices.

Light Point System
Light point systems are hierarchy grouping nodes containing only light points.

External Reference
External references are nodes referencing external OpenFlight® files.
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Tree View
This section describes the tree view which shows the hierarchy of the model.

Navigate in the tree view by using the scroll bars located to the right and at the bottom
(note that the scroll bars are only shown if they are needed). The view can also be
moved by clicking and dragging Ctrl + right mouse button in the same manner as in the
viewport. A node is visualized by a box labeled by the node’s name. Different node types
have different colors as described in the Node Colors section. Polygon nodes have a small
box in their top right corner that shows the color of the polygon. Nodes having
transformation matrices are labeled with an ‘M’ in their bottom right corner. Replicated
nodes are labeled with an ‘R’ in their bottom right corner. Instances are visualized with a
small arrow pointing downwards at the referred nodes. Vertices are shown as separate
boxes, even though they are not actually nodes.
The nodes can be selected by clicking on them with the left mouse button. Shift-clicking
on a node will add that node to the current selection. Alt-clicking on an already selected
node will deselect that node. Selecting nodes within a rectangular area in the tree view is
also possible by clicking the left mouse button outside the nodes and dragging a box
around the nodes that are to be selected. Holding Shift while creating selection box will
add non-selected nodes within the rectangular area to the selection. Holding Alt while
making the selection box will remove selected nodes within the rectangular area from the
current selection. If the cursor is dragged outside the tree view when using the box
selection, the scroll bar will be scrolled toward the cursor if possible. The further from the
tree view the cursor is moved, the faster the scroll will be.
Pressing ‘v’ in the tree view will cycle through the selected nodes. Pressing ‘V’ will cycle
backwards. This can be useful when e.g. selecting some geometry in the model view,
changing focus by clicking the right mouse button (not the left mouse button since that
would imply a new selection) in the tree view and pressing ‘v’ to find out where the
selected node exists in the hierarchy.
Drag and drop of nodes is supported by clicking on the selected nodes with the left
mouse button and dragging them to their new parent. As with the box selection, if the
cursor is dragged outside the tree view, the scroll bars will be scrolled toward the cursor.
To the left are buttons for expanding and contracting sub-trees beneath the currently
selected node(s). This expansion/contraction will be performed incrementally, i.e.
multiple clicks on the expand button will expand the selected sub-tree to gradually lower
levels. Expanding and contracting can also be performed by clicking the middle mouse
button on a node. This expansion/contraction will only expand or contract the clicked
node and will not affect the nodes in the sub-tree beneath. By holding down Shift and
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clicking with the middle mouse button on a selected node, all selected nodes will be
contracted or expanded depending on the state of the clicked node.
There is also a slider that can be used to zoom the tree view in and out. The zoom slider
has a snapping center position, allowing the user to easily find the default zoom level.
The view can also be zoomed by clicking and dragging Shift + right mouse button in the
same manner as in the viewport.
The left button area also contains buttons for shifting the selected nodes to the left or to
the right, one step at a time (Shift Left/Right) or all the way to the left or to the right
(Shift Far Left/Right). This can be performed on a number of selected nodes of different
types and will produce undoable commands.
The right button area contains buttons for selecting the parents or children of the
currently selected primitives. There is also a button for selecting the previously selected
nodes. This button will toggle between the two latest selections.
Nodes that are hidden in the last viewport focused are colored light gray in the tree view.
Invisible LOD nodes are also colored with the same light gray color. Node types not fully
supported in Remo 3D will be visualized with a medium gray color. They can still be cut,
copied, pasted, deleted, dragged and dropped, but their attributes can’t be modified.
The attribute tool can be started for a selected node by double-clicking it. When the
cursor is located over a node in the tree view the full name of that node will be displayed
in the status area.

Node Colors
The database header node has a dark gray color.
Group nodes have a blue-purple color.
Object nodes have a light blue color.
LOD nodes have a light green color.
DOF nodes have a red-purple color.
Switch nodes have a pink color.
External reference nodes have an orange color.
Light point nodes have a yellow color.
Light point system nodes have a cyan/turquoise color.
Polygon nodes have a blue-green color.
Vertices have a red-orange color.
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Palettes
This section describes all palettes that can be used in Remo 3D.

Color Palette
This window presents the color palette with its 1024 color indices. The color for each
index can be edited by selecting the color, choosing Edit Color from the Edit menu and
picking a new color.

The color picking is done manually by indicating the hue, saturation and value (lightness)
with the mouse or typing the RGB or HSV values. The RGB values can be given as floats,
bytes or hexadecimal.
The color to be picked (e.g. the model’s current color or a polygon color - depending on
from where the color palette was activated) is defined by choosing a color index and
setting a color intensity. By clicking the OK button, the color is set and the palette
window is closed. By clicking the Close button or choosing Close from the File menu, no
color is applied and the palette window is closed.
If the current model uses indexed color mode, the result from a picked color is a color
index and an intensity. If RGB color mode is used (controlled by a header node
attribute), the result is a color defined by red, green and blue values. Picking the current
color from the palette by clicking the current color button in the main user interface or
picking a new color for a polygon or a vertex is supported both in the indexed and RGB
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color modes. Picking a light point back color always results in an indexed color, even if
the model is in RGB mode.
A color palette can be opened from disk by choosing Open Palette from the File menu
and saved to disk by choosing Save Palette As from the File menu. Color palette files
have an RCP (Remo 3D Color Palette) extension.
The general functionality of the file dialogs used in the color palette is described in the
File Dialogs section.

Texture Palette
This window presents the texture palette with textures represented as images regularly
distributed within the window.

The images are presented with a maximum size of 128x128. If an image has to be scaled
down, the image can be opened in a window showing it in its original size by choosing
Full Size from the View menu. A list of all textures with their indices, file paths and sizes
can be viewed by choosing Texture List from the View menu.
The texture to be picked (e.g. the current texture or a polygon texture - depending on
from where the texture palette was activated) is defined by choosing an image
representing a certain texture index. By clicking the OK button, the texture is set and the
palette window is closed. By clicking the Close button or choosing Close from the File
menu, no texture is applied and the palette window is closed.
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An existing texture can be removed by selecting the texture and choosing Remove from
the Edit menu. A new texture can be loaded into the palette by choosing Load Texture
from the File menu and choosing the filename of the texture that is to be loaded.
Supported image formats are SGI® (RGB, RGBA, INT, INTA), BMP, DDS, GIF, JPEG, PNG,
PNM (PNM, PPM, PGM, PBM), TGA and TIFF. To replace a texture, select the texture,
choose Replace Texture from the File menu and choose which file with which the texture
shall be replaced. From the Edit menu all textures that are not used in the current model
can be removed by choosing Remove Unused.
When selecting Attributes from the Edit menu, a dialog with texture attributes is
presented to the user. Through this dialog, texture attributes can be created, edited and
saved. Texture attributes are saved to a file with the same name as the texture plus an
‘.attr’ extension. The different texture attributes are described in more detail in the
Texture Attributes section below.
A texture’s index can be changed by selecting the texture, choosing Change Index from
the Edit menu and specifying a new index. To remove the path of a texture and only
keep the filename, select the texture and choose Remove Path from the Edit menu. All
texture paths can be changed by choosing Change All Paths from the Edit menu and
specifying a new folder. All texture paths can also be removed by choosing Remove All
Paths from the Edit menu. By enabling the Use Relative Paths menu item, all paths
currently in the texture palette will be converted to relative and all loaded textures after
that will use a relative path. By disabling the Use Relative Paths menu item, all paths will
be converted to absolute. All relative paths will be relative to the directory of the model.
Since the vertical orientation of DDS and PNM image files can be different, this can be
controlled with Flip DDS/PNM Images from the Edit menu. Enabling or disabling flipping
will reload all DDS and PNM textures, but it will not change any textures or models on
disk. The default is that flipping is enabled.
A texture palette can be opened from disk by selecting Open Palette from the File menu
and saved to disk by selecting Save Palette As from the File menu. Texture palette files
have an RTP (Remo 3D Texture Palette) extension.
To reload all textures from disk, Refresh from the View menu can be used.
When loading a model with textures, the REMO3D_FILE_PATH environment variable is
used if the texture files aren't found directly.
The general functionality of the file dialogs used in the texture palette is described in the
File Dialogs section.
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Texture Attributes
The tables below describe the texture attributes.
The General tab contains the following attributes:
Filename (read-only)

The filename of the corresponding texture image file.

Internal Format

The internal format used on the graphics card for this
texture, one of the following:
Default
I_12A_4 (12 bits intensity, 4 bits alpha)
IA_8 (8 bits intensity, 8 bits alpha)
RGB_5 (5 bits red, 6 bits green, 5 bits blue)
RGBA_4 (4 bits red, 4 bits green, 4 bits blue, 4 bits alpha)
IA_12 (12 bits intensity, 12 bits alpha)
RGBA_8 (8 bits red, 8 bits green, 8 bits blue 8 bits alpha)
RGBA_12 (12 bits red, 12 bits green, 12 bits blue, 12 bits alpha)
I_16 (16 bits intensity)
RGB_12 (12 bits red, 12 bits green, 12 bits blue)

External Format (read-only)

The external format used in the texture image file, one
of the following:
Default
PACK_8 (8 bits per component)
PACK_16 (16 bits per component)

Comments

A user-defined string of comments, can include linefeeds.

The Geometry tab contains the following attributes:
Earth Model

The earth model associated with the coordinates of this
model (WGS84, WGS72, Bessel, Clark 1866 or NAD27).

Projection

The projection associated with the coordinates of this
model (Flat Earth, Lambert Conic, UTM or Undefined).

Image Origin

The image origin (Lower Left or Upper Left).

Texture Size – u (read-only)

The texture image width in pixels.

Texture Size – v (read-only)

The texture image height in pixels.

Real World Size – u

The real-world width in database units (e.g. meters).

Real World Size – v

The real-world height in database units (e.g. meters).

Pivot – x

X-component (in width direction) of pivot point for
rotating textures.

Pivot – y

Y-component (in height direction) of pivot point for
rotating textures.

Up Vector – x

X-component (in width direction) of an orientation
vector, only for backwards compatibility.

Up Vector – y

Y-component (in height direction) of an orientation
vector, only for backwards compatibility.
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The Filters tab contains the following attributes:
Minification Filter

The filter used for decreasing the resolution of the
texture when viewed from afar, one of the following:
POINT (nearest pixel)
BILINEAR (weighted average of four nearest pixels)
MIPMAP (obsolete)
MIPMAP_POINT (nearest pixel in closest mipmap level)
MIPMAP_LINEAR (nearest pixel in average between two closest
mipmap levels)
MIPMAP_BILINEAR (weighted average of four nearest pixels in
closest mipmap level)
MIPMAP_TRILINEAR (weighted average of two weighted averages
of four nearest pixels in two closest mipmap levels)
None (uses system default, usually BILINEAR)
BICUBIC (spline-weighted average of 16 nearest pixels)
BILINEAR_GEQUAL (can be used for real-time shadows)
BILINEAR_LEQUAL (can be used for real-time shadows)
BICUBIC_GEQUAL (can be used for real-time shadows)
BICUBIC_LEQUAL (can be used for real-time shadows)

Magnification Filter

The filter used for increasing the resolution of the
texture when viewed at a close range (POINT,
BILINEAR, None, BICUBIC, SHARPEN, ADD_DETAIL,
MODULATE_DETAIL, BILINEAR_GEQUAL,
BILINEAR_LEQUAL, BICUBIC_GEQUAL,
BICUBIC_LEQUAL).
POINT (nearest pixel)
BILINEAR (weighted average of four nearest pixels)
None (uses system default, usually BILINEAR)
BICUBIC (spline-weighted average of 8 nearest pixels)
SHARPEN (extrapolates from weighted averages of four nearest
pixels in the two highest mipmap levels)
ADD_DETAIL (adds the detail texture specified in the polygon
attributes, normally only supported in SGI® and not visualized in
Remo 3D)
MODULATE_DETAIL (modulates the detail texture specified in the
polygon attributes, normally only supported in SGI® and not
visualized in Remo 3D)
BILINEAR_GEQUAL (can be used for real-time shadows)
BILINEAR_LEQUAL (can be used for real-time shadows)
BICUBIC_GEQUAL (can be used for real-time shadows)
BICUBIC_LEQUAL (can be used for real-time shadows)

Magnification Filter Alpha

The alpha-specific filter used for increasing the
resolution of the texture when viewed at a close range,
see possible values for magnification filter above.

Magnification Filter Color

The color-specific filter used for increasing the
resolution of the texture when viewed at a close range,
see possible values for magnification filter above.

Environment Type

The method for blending texture color with the color of
the underlying polygon or other textures, one of the
following:
MODULATE (multiplicative integration between texture and
polygon color)
BLEND (average between primary and secondary polygon color,
weighted by texture value)
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DECAL (replaces with texture color; polygon color blended
according to texture alpha)
REPLACE/COLOR (replaces with texture color)
ADD (adds texture color to polygon color)

Wrap Method u

The method for wrapping this texture in the u (width)
direction, one of the following:
Repeat (image copied to fill textured polygons)
Clamp (edge pixels repeated to fill textured polygons)
None
Mirror (like repeat but every other image is mirrored)

Wrap Method v

The method for wrapping this texture in the v (height)
direction, one of the following:
Repeat (image copied to fill textured polygons)
Clamp (edge pixels repeated to fill textured polygons)
None
Mirror (like repeat but every other image is mirrored)

Wrap Method u, v

The method for wrapping this texture if any of the
direction-specific methods above are set to None; one
of the following:
Repeat (image copied to fill textured polygons)
Clamp (edge pixels repeated to fill textured polygons)
Mirror (like repeat but every other image is mirrored)

The Detail tab contains the following attributes:
Use Detail

True if the relationship between detail and main texture
is to be specified. Note that this has no effect on the
visualization in Remo 3D. It’s purely an IRISGL feature
used on SGI® hardware.

j

The relative detail texture width, assumed to be 4.

k

The relative detail texture height, assumed to be 4.

m

The main texture width, valid values are 4, 8, 16, 32
and 64 (higher values imply wrapping).

n

The main texture height, valid values are 4, 8, 16, 32
and 64 (higher values imply wrapping).

Scramble

Not used, only for backwards compatibility.

The MIP tab contains the following attributes:
Use MIP Kernel

True if a specific 8x8 convolution kernel is to be used
for calculating mipmaps (image copies of decreasing
power-of-two sizes to reduce aliasing artifacts). Note
that this has no effect on the visualization in Remo 3D.
It’s purely an IRISGL feature used on SGI® hardware.
Mipmaps will be automatically pre-calculated even
without this kernel.
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Kernel Value (1-8)

These eight values form a vertical matrix and a
horizontal matrix according to below. The convolution
kernel is generated by multiplying these matrices.
1
3
5
7

2
4
6
8

X

12345678

The Control tab contains the following attributes:
Use Control Point

True if the texture level-of-detail scale and
minification/magnification is to be specifically
controlled. Note that this has no effect on the
visualization in Remo 3D. It’s purely an IRISGL feature
used on SGI® hardware.

LOD 0

The first texture level-of-detail value corresponding to
the first texture scale value.

LOD 1

The second texture level-of-detail value corresponding
to the second texture scale value.

LOD 2

The third texture level-of-detail value corresponding to
the third texture scale value.

LOD 3

The fourth texture level-of-detail value corresponding
to the fourth texture scale value.

LOD 4

Not used.

LOD 5

Not used.

LOD 6

Not used.

LOD 7

Not used.

Scale 0

The first texture scale value corresponding to the first
texture level-of-detail value.

Scale 1

The second texture scale value corresponding to the
second texture level-of-detail value.

Scale 2

The third texture scale value corresponding to the third
texture level-of-detail value.

Scale 3

The fourth texture scale value corresponding to the
fourth texture level-of-detail value.

Scale 4

Not used.

Scale 5

Not used.

Scale 6

Not used.

Scale 7

Not used.

Clamp

The maximum texture scale value.

The Tile tab contains the following attributes:
Use Tile

True if a sub-section of the texture is to be visualized
and the rest completely transparent. Note that this has
no effect on the visualization in Remo 3D.

Lower Left - u

U-component (in width direction) of the lower-left
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corner of the visible part of the texture.
Lower Left – v

V-component (in height direction) of the lower-left
corner of the visible part of the texture.

Upper Right - u

U-component (in width direction) of the upper-right
corner of the visible part of the texture.

Upper Right – v

V-component (in height direction) of the upper-right
corner of the visible part of the texture.

Texture Mapping Palette
This window presents the texture mapping palette with texture mappings represented as
type-specific (3-point, 4-point, cylindrical or spherical) images regularly distributed within
the window. These images are represented with the currently chosen texture but the
mappings will work with any texture.

The texture mapping to be picked (e.g. the current texture mapping or a polygon texture
mapping - depending on from where the texture mapping palette was activated) is
defined by choosing an image representing a certain texture mapping index. Clicking in
the area outside the texture mapping images will mean selecting no texture mapping,
resulting in a -1 index. By clicking the OK button, the texture mapping is set and the
palette window is closed. By clicking the Close button or choosing Close from the File
menu, no texture mapping is applied and the palette window is closed.
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Map
Texture mappings are created through the Map Texture Tool described in the
Texture section. An existing texture mapping can be removed by selecting the texture
mapping and choosing Remove from the Edit menu, or using the Delete button. All
texture mappings that are not used in the current model can be removed by choosing
Remove Unused from the Edit menu.
When selecting one of the texture mappings, its attributes are shown to the right.
Depending on the type of texture mapping selected, different attributes can be edited.
For mappings of all types, an optional name can be edited. For planar mappings (3-point
and 4-point), the texture coordinates (u, v) corresponding to the three or four geometry
coordinates can be edited, either by moving the three or four points in the texture image
as visualized in the dialog, by moving the same points in a full-size view of the texture
image after clicking the Full View button, or by editing the exact (u, v) values for each of
the three or four points. For cylindrical and spherical mappings, the number of repetitions
can be edited. Future versions of Remo 3D will allow editing the geometry points as well.
Note that the actual modification (and corresponding undoable command) of the texture
mapping attributes will be performed when leaving a text field, e.g. focusing another part
of the user interface or leaving the field by pressing Tab or Return.
A texture mapping’s index can be changed by selecting the texture mapping, choosing
Change Index from the Edit menu and specifying a new index.
A texture mapping palette can be opened from disk by selecting Open Palette from the
File menu and saved to disk by selecting Save Palette As from the File menu. Texture
mapping palette files have an RXP (Remo 3D teXture mapping Palette) extension.
The general functionality of the file dialogs used in the texture mapping palette is
described in the File Dialogs section.
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Material Palette
This window presents the material palette with materials represented as images of
material spheres regularly distributed within the window.

The material to be picked (e.g. the current material or a polygon material - depending on
from where the material palette was activated) is defined by choosing a sphere
representing a certain material index. By clicking the OK button, the material is set and
the palette window is closed. By clicking the Close button or choosing Close from the File
menu, no material is applied and the palette window is closed.
A new material can be created by choosing New from the Edit menu. A default material
will then be created and added at the end of the palette. Each material can be edited by
selecting the material and clicking one of the ambient, diffuse, specular or emissive color
boxes and choosing a new color. A color is chosen by indicating the hue, saturation and
value (lightness) with the mouse or typing the RGB or HSV values. The RGB values can
be given as floats, bytes or hexadecimal. The material’s shininess and alpha parameters
can also be changed. When changing these colors and parameters immediate feedback
will be given in the visualization of the selected material in the palette.
A material’s index can be changed by selecting the material, choosing Change Index from
the Edit menu and specifying a new index. An existing material can be removed by
selecting the material and choosing Remove from the Edit menu. To remove all unused
materials, choose Remove Unused from the Edit menu.
A material palette can be opened from disk by selecting Open Palette from the File menu
and saved to disk by selecting Save Palette As from the File menu. Material palette files
have an RMP (Remo 3D Material Palette) extension.
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The general functionality of the file dialogs used in the material palette is described in the
File Dialogs section.

Light Point Palette
This window presents the light point palette with one list for appearances and one list for
animations.

The appearance and animation to be picked are defined by choosing the corresponding
rows in the appearance and animation list. The user can switch between the lists with the
Appearance and Animation radio buttons to the left. By clicking the OK button, the
current light point appearance and animation indices are set and the palette window is
closed. By clicking the Close button or choosing Close from the File menu, no appearance
or animation is applied and the palette window is closed.
A new appearance or animation can be created by switching to the appearance or
animation list with the radio buttons and choosing New from the Edit menu. A default
appearance or animation will then be created and added at the end of the list. Each
appearance and animation can be edited by selecting the appearance or animation in the
list and modifying the attributes appearing to the right. Note that the actual modification
(and corresponding undoable command) will be performed when leaving a text field, e.g.
focusing another part of the user interface or leaving the field by pressing Tab or Return.
The attributes are described in the following two sub-sections:
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Light Point Appearance Attributes
The tables below describe the light point appearance attributes.
The General tab contains the following attributes:
Name

The light point appearance name.

Display Mode

Defines how this light point is displayed (Raster,
Calligraphic or Either).

Feature ID

A feature identification code.

Surface Material Code

A classification code defining the material of this light
point.

Front Intensity

Intensity scalar for front color.

Back Intensity

Intensity scalar for back color.

Back Color

Enabled if back color is used for bidirectional light
points.

Back Color – Index

The color palette index of the back color (0 – 1023, -1
if none). This color is always indexed, even if the model
is in RGB mode.

Back Color – Intensity

The intensity of the back color (0 – 127). This color is
always indexed, even if the model is in RGB mode.

Display In Daylight

Enabled if this light point will be displayed in daylight.

Display At Dusk

Enabled if this light point will be displayed at dusk.

Display At Night

Enabled if this light point will be displayed at night.

Conform To Terrain

Enabled if the light point is to be adapted in height to
always be on top of the terrain. This is not visualized in
Remo 3D.

The Direction tab contains the following attributes:
Directional Type

Defines the directions of this light point’s emitting light
(Omnidirectional, Unidirectional or Bidirectional).

Horizontal Lobe Angle

The horizontal angle of the light lobe (degrees).

Vertical Lobe Angle

The vertical angle of the light lobe (degrees).

Lobe Roll Angle

The roll angle of the light lobe (degrees).

Falloff Exponent

Exponential value controlling the falloff between center
and edge of the light lobe. Linear falloff = 1.0.

Ambient Intensity

The ambient intensity of the light point when viewed
off-axis.

The Callig (calligraphic) tab contains the following attributes:
Significance

Priority used by raster/calligraphic hybrid systems for
deciding which light points that should be switched to
raster mode at high visualization loads (0.0 – 1.0).

Minimum Defocus

Lower calligraphic defocus limit (0.0 – 1.0).

Maximum Defocus

Upper calligraphic defocus limit (0.0 – 1.0).
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Quality

Calligraphic quality (Low, Medium or High).

Proximity Occulting

Enabled if the intensity of adjacent light points are to
be decreased when viewed from a distance.

The Misc (miscellaneous) tab contains the following attributes:
Range Mode

Method for calculating the distance between the viewer
and the light point (Depth Buffer or Slant Range).

Randomize Intensity

The random intensity level (Off, Low, Medium or High).

Fog Scale

The level of light point visibility through fog. Values
above 0.0 imply punching through the fog.

Fog Intensity

Intensity factor controlling the light point alpha.

Size Difference Threshold

Light point visibility threshold in pixels.

Transparent Pixel Size

Size in pixels where light points start becoming
transparent.

Transparent Falloff Exponent

Exponential value controlling the transparent falloff.
Linear falloff = 1.0.

Transparent Scale

Scale factor controlling the transparent falloff.

Transparent Clamp

Minimum transparent falloff.

Minimum Pixel Size

Minimum diameter in pixels.

Maximum Pixel Size

Maximum diameter in pixels.

Actual Size

Diameter in database units (e.g. meters).

Perspective Mode

Enabled if perspective fading is to be used.

Reflective Only

Enabled if light point is reflective instead of emissive.

Fading

Enabled if perspective fading calculations are to be
used.

Fog Punch

Enabled if light point is to punch through fog.

The Misc2 (miscellaneous continued) tab contains the following attributes:
Visibility Range

The range within which the light point is visible, in
database units (e.g. meters).

Fade Range Ratio

The ratio of the visibility range within which the light
point fades away (0.0 – 1.0).

Fade In Duration

The fade-in time interval for the light point, in seconds.

Fade Out Duration

The fade-out time interval for the light point, in
seconds.

LOD Range Ratio

Certain receiving systems support changing the light
point visualization to a textured polygon at close range,
as a higher level-of-detail representation. This is the
ratio (0.0 – 1.0) of the visibility range within which this
higher level-of-detail is active.

LOD Scale

Certain receiving systems support changing the light
point visualization to a textured polygon at close range,
as a higher level-of-detail representation. This is the
size of the textured polygon relative to the light point
size.
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Texture - Index

Certain receiving systems support changing the light
point visualization to a textured polygon at close range,
as a higher level-of-detail representation. This is the
texture palette index of higher level-of-detail texture (1 if not used).

Light Point Animation Attributes
The table below describes the light point animation attributes.
The General tab contains the following attributes:
Name

The light point animation name.

Animation Type

The type of animation (Flashing Sequence, Rotating,
Strobe or Morse Code).

Period

The animation period (seconds).

Phase Delay

The animation phase delay (seconds).

Enabled Period

The part of the animation period where the light point
is switched on (seconds).

Rotation Axis – i

The i (x) value of the rotation axis.

Rotation Axis – j

The j (y) value of the rotation axis.

Rotation Axis – k

The k (z) value of the rotation axis.

Flashing

Enabled if the light point is flashing.

Rotating

Enabled if the light point is rotating.

Counter Clockwise

Enabled if the light point rotation is defined counterclockwise.

The Morse Code tab contains the following attributes:
Morse Code Timing

The type of Morse code timing (Standard or
Farnsworth).

Word Rate

The Morse code word rate in seconds.

Character Rate

The Morse code character rate in seconds.

Morse Code

The Morse code text.

The Sequence tab contains the following attributes:
Sequence Number

The number of the sequence state for which the
attributes below are modified.

State

The state of the current sequence (On, Off or Color
Change). This means that this sequence will turn on,
turn off or change the color of the light point.

Duration

The duration in seconds of this sequence.

Color Change Index

The color palette index of the sequence color (0 –
1023, -1 if none). This color is always indexed, even if
the model is in RGB mode.
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Color Change Intensity

The intensity of the primary color (0 – 127). This color
is always indexed, even if the model is in RGB mode.

Sequence states can be added and removed with the Add and Remove buttons in the
Sequence tab of the Light Point Animation attributes. New sequence states are added to
the end of the list. When clicking the Remove button, the current sequence state, as
specified by the Sequence Number drop-down menu, will be removed. The following
sequence states will be re-numbered to achieve a continuous list of sequence state
indices.
A light point appearance or animation index can be changed by selecting the appearance
or animation list row, choosing Change Index from the Edit menu and specifying a new
index. An existing appearance or animation can be removed by selecting the appearance
or animation and choosing Remove from the Edit menu. To remove all unused
appearances or animations, choose Remove Unused from the Edit menu.
A light point palette can be opened from disk by selecting Open Palette from the File
menu and saved to disk by selecting Save Palette As from the File menu. Light point
palette files have an RLP (Remo 3D Light point Palette) extension.
The general functionality of the file dialogs used in the light point palette is described in
the File Dialogs section.
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Shader Palette
This window presents the shader palette with all shaders defined for this model.

In the Shaders output, the index and the name of the shaders are presented. By clicking
on the shaders, details about them are shown. There are two types of shaders; OpenGL
Shading Language and Cg.
For the OpenGL Shading Language shaders, two types of shader program files can be
added; vertex program files and fragment program files. Vertex and fragment program
files can be added and removed with their respective Add and Remove buttons.
For the Cg shaders, one vertex program and one fragment program file can be specified.
A vertex and a fragment profile number and vertex and fragment program entry points
can also be specified.
Note that the actual modification (and corresponding undoable command) of the
information in the Cg shader text fields will be performed when leaving a text field, e.g.
focusing another part of the user interface or leaving the field by pressing Tab or Return.
Shader palettes can be saved and opened from the File menu. Shader palette files have
an RSP (Remo 3D Shader Palette) extension. New shaders can be created with Ctrl+n or
from the Edit menu by choosing New. To remove shaders from the shader palette, use
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Remove from the Edit menu or use the Delete button on the keyboard. Unused shaders
can also be removed by selecting Remove Unused from the Edit menu. To change the
index for a shader, Change Index from the Edit menu can be used. A shader’s name can
be changed by selecting Change Name from the Edit menu.
If shaders need to be reloaded from disk, Refresh from the Edit menu can be used.
When loading a model with shaders, the REMO3D_FILE_PATH environment variable is
used if the shader files aren't found directly.
The general functionality of the file dialogs used in the shader palette is described in the
File Dialogs section.
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Command List
This section describes the command list which lists the executed undoable and redoable
commands with the latest command at the top of the list.

If a command has been undone, this is visualized by putting its command name within
parentheses and changing the font to italic. These parentheses are removed if the same
command is redone.
Script commands are commands that are only present when a script is being recorded.
This makes it possible to undo commands that are recorded to a script but that are not
usually undoable.
When executing a macro, a Macro Command will be added to the command list. The
name of the macro will be displayed after the Macro Command.
The command list window is non-modal which means that it is possible to open the
command list and continue working with the rest of the Remo 3D graphical user
interface.
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Preview DOF
This section describes the DOF preview dialog which lets you preview the different
transformations of a selected DOF node.

The DOF preview dialog only works on one DOF node at a time. The different
transformation types for a DOF node can also be previewed only one at a time. The
current transformation type is chosen by one of the radio buttons in the upper part of the
dialog. A transformation type radio button is only active if the corresponding
transformation’s minimum value is smaller than or equal to its maximum value, its
current value is between the minimum and the maximum value and its increment value
is not zero.
To preview the chosen transformation the slider below the transformation type radio
buttons can be moved. Its left-most position corresponds to the minimum value of the
chosen transformation and the right-most position represents the maximum value. When
a transformation type is chosen, the slider will be located at its current value. When
moving the slider and releasing the mouse button it will return to the current value.
While previewing the current selection visualization will be hidden.
The DOF preview dialog is non-modal which means that it is possible to open the DOF
preview dialog and continue working with the rest of the Remo 3D graphical user
interface.
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Preview Animation
This section describes the animation preview dialog which lets you preview the sequence
animation of a selected group node.

The animation preview dialog will only open if exactly one group node with an animation
sequence is selected. Click the Start button to start the animation and the Stop button to
cancel the current animation. Forward and backward sequences will animate correctly.
The Loop Count, Loop Duration, Last Frame Duration and Swing attributes of the selected
group node controls the animation. An animation with Loop Count above 0 will loop until
finished and then stop. If the Loop Count is 0 it will repeat until Stop is clicked. While
animating the current selection visualization will be hidden.
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Settings
This section describes the different ways that the user can customize the appearance and
behavior of Remo 3D.

Preferences
This dialog lets the user select a number of preferences for the Remo 3D application.
These preferences can be saved to disk and will automatically be loaded the next time
Remo 3D is started.
In the Viewports tab, the number of viewports and
their arrangement can be selected. Viewports are
separate views of the same model. The user can
choose from one, two, three or four viewports.

In the Control tab, the sensitivities with which
panning, zooming and rotation of the model view are
performed can be selected. When pan or zoom
sensitivity is set to Auto, an attempt to set a suitable
sensitivity depending on the size of the model is
made. This automatic sensitivity calculation can be
repeated later by pressing space in order to zoom to
the model. Note that the sensitivity can also be
controlled with the Sensitivity dialog available from
the View menu.
In this tab, the selection tolerance in pixels can also
be set. When selecting by clicking in the model view,
this tolerance is added to the indicated window pixel
in order to make it easier to aim at the primitives
that are to be selected.
Finally, the control tab lets the user specify whether
changing the viewpoint to top, bottom, front, back,
right or left should automatically zoom to the
model’s extent or not.
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In the Gizmos tab, the user can specify if gizmos
should be shown for tools supporting them. The size
of the gizmos can also be specified, defined as the
number of pixels the gizmos will occupy on screen.
A check box for enabling uniform scaling when using
the scale gizmo is also available. When this is
checked the scale will be the same in both directions
when scaling with the planes between the axes.

In the Misc tab, the user can specify the tolerance
with which certain geometry operations are
performed. In the current version of Remo 3D, this
tolerance is used when slicing geometry, performing
cylindrical or spherical texture mapping and when
merging polygons. The tolerance is specified in
model units, e.g. meters.
The maximum number of undo commands to keep
can be specified in the Max Commands input. This
setting can have an impact on the memory usage of
Remo 3D. Setting it to a high value will make Remo
3D use more memory.
The Screen Capture Size inputs are used to specify
the size of the screenshots captured with Capture
Screen from the Viewport Menu. The image will be
cropped if the specified aspect ratio differs from the
viewport aspect ratio. If any or both of the specified
width and height are 0, the screen capture will have
the exact size of the viewport.
The Parameter Precision sets the number of decimals to use for floating-point numbers
when written in text, e.g. in Select By Attributes or when recording a script.
The user can also specify whether to convert values representing N/A (not available) to
zero or not. Certain values in an OpenFlight® file are sometimes specified as -1e+008
(-100 000 000), which is meant to represent a N/A value. To avoid actually interpreting
these values as -1e+008 and instead convert them to 0 (zero) when opening an
OpenFlight® file, this check box can be set. The following values are affected by the N/A
setting:
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The from-point in a translating matrix transformation
The origin, point on X axis and point in XY plane of a DOF node
The Automatic Texture Reload check box controls if textures should be automatically
reloaded when changed on disk.
The Automatic External Reference Reload check box controls if external references should
be automatically reloaded when changed on disk.
The Automatic Shader Reload check box controls if shaders should be automatically
reloaded when changed on disk.
The Always Save To Latest Version check box is used to enable or disable saving to the
latest OpenFlight® version. If it is checked, the Save command will save to the latest
supported OpenFlight® version, otherwise it will save to the version the file was opened
with or the last version it was saved to.
By enabling or disabling the Activate Splash Screen check box, the user can control
whether the Remo 3D splash screen will be shown or not when starting Remo 3D.
The Load External References check box controls whether externally referenced models
are to be loaded from the start or not. If disabled, they won’t be loaded directly when
loading the parent model, when creating them with the Create External Reference tool or
when specifying their model file name in the Attributes tool. Separate externally
referenced models (per file name) can be enabled in the External References dialog
available from the File menu.
The preferences can be reset to the default preferences by clicking the Defaults button.
To apply the given preferences, click the Apply button. The preferences can be saved to
disk by clicking the Save button, which will also apply the preferences. Saved preferences
will automatically be loaded the next time Remo 3D is started.

Viewport Menu
This menu is reached by choosing Viewport from the View menu, by clicking Ctrl + Alt +
right mouse button in a viewport or by pressing the Menu keyboard button in a viewport.
It contains a number of settings for the currently focused viewport.
The table below describes the contents of the viewport menu.
Viewpoint
Perspective

Draws model in perspective view. This will be indicated with the
letter P in the top right corner of the viewport.

Orthographic

Draws model in orthographic view, i.e. with a straight
projection. This will be indicated with the letter O in the top
right corner of the viewport.

Top (Along -Z)

Moves viewpoint to the Z axis, viewing in a negative Z direction
and zooming out to the model’s extent. Most models are
created so that this will show the top of the model.

Bottom (Along Z)

Moves viewpoint to the Z axis, viewing in a positive Z direction
and zooming out to the model’s extent. Most models are

96

Remo 3D™ v2.10 User’s Guide

created so that this will show the bottom of the model.
Front (Along -Y)

Moves viewpoint to the Y axis, viewing in a negative Y direction
and zooming out to the model’s extent. Most models are
created so that this will show the front of the model.

Back (Along Y)

Moves viewpoint to the Y axis, viewing in a positive Y direction
and zooming out to the model’s extent. Most models are
created so that this will show the back of the model.

Right (Along -X)

Moves viewpoint to the X axis, viewing in a negative X direction
and zooming out to the model’s extent. Most models are
created so that this will show the right side of the model.

Left (Along X)

Moves viewpoint to the X axis, viewing in a positive X direction
and zooming out to the model’s extent. Most models are
created so that this will show the left side of the model.

Above Grid

Moves viewpoint toward and above the current grid.

Below Grid

Moves viewpoint toward and below the current grid.

Store View

Stores the current view for later use.

Recall View

Recalls the stored view.

Fit To Selection

Fits the view to the current selection, changing the zoom and
point of rotation.

Fit In View

Moves the viewpoint backwards so that the complete model is
visible.

Appearance
Scribed

Draws model with wireframe polygons on top of solid polygons.

Solid

Draws model with solid polygons.

Wireframe

Draws model with wireframe polygons.

Draw Wireframe
Backface

Draws the back-face of the wireframe overlay.

Texture On

Toggles texture visualization on/off.

Shader On

Toggles shader visualization on/off.

Lighting
Lighting On

Toggles the lighting on/off.

Head Light

Switches lighting mode to head light, i.e. the light will emanate
from the viewpoint.

Sky Light

Switches lighting mode to sky light, i.e. the light will emanate
from above.

Grid
Show Grid

Enables or disables the grid. When the grid is enabled this will
be indicated with a small grid symbol in the top left corner of
the viewport.

Align To XY

Aligns the grid to the XY-plane with the origin in (0,0,0). Note
that this can be accomplished by clicking the XY button in the
coordinates and selection field as well.

Align To XZ

Aligns the grid to the XZ-plane with the origin in (0,0,0). Note
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that this can be accomplished by clicking the XZ button in the
coordinates and selection field as well.
Align To YZ

Aligns the grid to the YZ-plane with the origin in (0,0,0). Note
that this can be accomplished by clicking the YZ button in the
coordinates and selection field as well.

Align To Vertices

Aligns the grid to three vertices (e.g. three vertices of a
polygon; cancel by choosing again). None of the three indicated
coordinates are propagated to the active tool.

Align To Polygon
(Face)

Aligns the grid to a selected polygon.

Translate Origin

Translates the grid origin to an indicated coordinate (cancel by
choosing again). The indicated coordinate is not propagated to
the active tool.

Z-buffer

Draws the grid using normal Z buffer with respect to other
geometry.

Always On Top

Draws the grid on top of other geometry.

Never On Top

Draws the grid behind other geometry.

Increase Grid Size

Increases the grid size by one grid line.

Decrease Grid Size

Decreases the grid size by one grid line.

Double Grid Size

Increases the grid size to twice the current number of grid
lines.

Half Grid Size

Decreases the grid size to half the current number of grid lines.

Grid Spacing...

Lets the user select the distance between each grid line. This
input dialog is non-modal which means that it is possible to
open the dialog and continue working with the rest of the Remo
3D graphical user interface.

Grid Offset...

Lets the user select an offset with which the grid should be
translated in its orthogonal direction. This input dialog is nonmodal which means that it is possible to open the dialog and
continue working with the rest of the Remo 3D graphical user
interface.

Hiding
Hide Selected

Hides the selected geometry.

Isolate Selected

Hides all geometry but the selected.

Unhide Selected

Unhides the selected geometry.

Unhide All

Unhides all geometry.

Capture Screen...

Captures a screenshot of the current viewport. The size of the
screenshot is determined by the size specified in the
Preferences dialog.

Viewport
Preferences...

Opens the viewport preferences window described in the
Viewport Preferences section.
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Viewport Preferences
This dialog lets the user select a number of preferences for the current viewport. These
preferences can be saved to disk and will automatically be loaded the next time a
viewport is created.
In the Background tab, top and bottom colors can be
chosen to form a color gradient or a solid background
color. The colors can be specified as red, green and
blue or hue, saturation and value (lightness). Preset
background colors can be chosen by clicking the Sky,
Gray, Black or White button.

The Frustum tab lets the user specify the viewing
frustum including the near clip and far clip distances
as well as the field-of-view angle. The default is to
automatically calculate the near clip and far clip
distances from the extent of the visible geometry.
Small feature culling can also be enabled and disabled
by checking and unchecking the Small Feature Culling
check box. The pixel size threshold for the small
feature culling can also be specified. When enabled,
small feature culling will not display objects that
occupy fewer pixels on screen than the specified
threshold.
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In the Light tab, ambient, diffuse and specular colors
can be specified for the lighting of the scene. The
colors can be specified as red, green and blue or hue,
saturation and value (lightness).

The Visual Cues tab contains settings for the grid, the
visualization of large vertices, normals and the
orientation axes. The grid can be customized by
specifying the colors of the grid lines and axes, as well
as the spacing between the grid lines and which line
number that is to be drawn with a thick line style.
Large vertex visualization can be customized by
specifying inner and outer colors as well as the size of
the vertex markings.
The visualization of normals can be customized with
color and scale. It’s also possible to only show
normals for the current selection and toggle if normals
should be visible for replications, instances and
external references.
The orientation X, Y and Z axes can be visualized in
one of the model view’s four corners. It can also be
turned off.

The viewport preferences can be reset to the default preferences by clicking the Defaults
button. To apply the given preferences, click the Apply button. The viewport preferences
can also be saved to disk by clicking the Save button, which will also apply the viewport
preferences. Saved viewport preferences will automatically be used for all viewports
created, e.g. when the next time Remo 3D is started, when a new model is opened or
when the number of viewports is changed.
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License Handling
There are three types of licenses in Remo 3D; node-locked, USB dongle, and floating.
Node-locked and USB dongle licenses can be time-limited for evaluation of the product.

Node-locked and USB dongle licenses
The node-locked and USB dongle licenses in Remo 3D are based on a hardware
fingerprint and a license key. The hardware fingerprint is generated either from the MAC
address of the Ethernet card in the computer which is running Remo 3D or from the
serial number of a USB memory stick working as a dongle, depending on which type of
license you purchase. To obtain a valid license key, the hardware fingerprint must be
included in the purchase form on www.remograph.com or sent to sales@remograph.com.

To unlock a demo version of Remo 3D, the license key should be entered in the License
dialog which can be found under the Help menu. This dialog is also where the hardware
fingerprint can be obtained. When the License File radio button is activated, depending
on which type of license you intend to purchase, click the Pick Network Adapter or Pick
USB Dongle button. Select a network adapter (choose a network adapter that will be
active when running Remo 3D) or a connected USB memory stick for which the hardware
fingerprint should be generated. If a USB memory stick is selected, this device will be
your USB dongle and will have to be connected to the computer running Remo 3D.
Note that in Microsoft® Windows® 10/8/7, the USB memory stick also has to be mounted
in order to generate a hardware fingerprint and verify the license when running Remo
3D. However, when inserting a USB memory stick it is usually mounted automatically.
The license key will by default be stored in the same folder as the Remo 3D executable
file. This can be changed by entering a filename in which the license should be stored. To
use an alternative location of the license file, i.e. not alongside the Remo 3D executable
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file and named license.dat, use the environment variable REMO3D_LICENSE_FILE to
specify the license file to use.

Floating licenses
When using a floating license, a license server is needed. A license server program is
included in the Remo 3D download and is called remoLicenseServer. The server program
is available in Linux and Microsoft® Windows® 10/8/7.
The remoLicenseServer program has the following syntax:
remoLicenseServer -g | -u | [-i] -l <number of licenses> -n <license key> [-f
<license file>] [-p <port number>] [-o <log file>] [-v]
-g Prints all possible hardware fingerprints to the console.
-u Stop and uninstall Windows Service (only available in Microsoft Windows).
-i Install and start Windows Service (only available in Microsoft Windows).
-l Specifies the number of licenses the server should use.
-n Specified the license key.
-f Specifies the path and name of the license file written and used internally.
-p Specifies the port number.
-o Specifies a log file (default is stdout).
-v Verbose mode.
The server is unlocked with a license key generated from a hardware fingerprint and the
number of licenses. A hardware fingerprint can be obtained by specifying -g to
remoLicenseServer, then a list of hardware fingerprints will be output to the console. The
license key is locked to a certain number of licenses, so when starting
remoLicenseServer, make sure the correct number of licenses is specified.
In Microsoft® Windows®, the license server can be run as a service. Install Remo 3D
normally on the server computer and run remoLicenseServer.exe from a command
prompt, specifying the –i switch. The service will then be installed and started
automatically with the options that you specify with the other parameters. To stop and
uninstall the service, specify only the –u switch to remoLicenseServer.exe. It is
recommended to send the server log messages to a specific log file with the –o switch,
since this is the only way of seeing what the service does. It is also recommended to use
the –v switch for verbose output. A license file for internal use will be written to the same
folder as where the remoLicenseServer executable resides. If another destination for this
file is preferred, e.g. due to privilege issues, this can be specified with the –f switch.
When running Remo 3D, the server needs to be specified in the license dialog, check the
License Server radio button, enter the server name in the License Server field and the
server port in the License Server Port.

The license server and port will by default be stored in the same folder as the Remo 3D
executable file. This can be changed by entering a filename in which the license server
and port should be stored. To use an alternative location of the license server file, i.e. not
alongside the Remo 3D executable file and named licenseserver.dat, use the
environment variable REMO3D_LICENSE_SERVER_FILE to specify the license server file
to use.
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The license server and port can also be specified with environment variables by setting
REMO3D_LICENSE_SERVER to the server name and REMO3D_LICENSE_SERVER_PORT to
the server port.

Time limited license
A time limited license can be used for evaluation of Remo 3D. You need to generate a
node-locked or dongle hardware fingerprint to be used for the time limited license, as
described in the Node-locked and USB dongle licenses section above. Enter this hardware
fingerprint when requesting a demo license from our website at www.remograph.com
and you will instantly receive a license key.
When you have received the time limited license key, press the License File radio button
in the license dialog and enter the key in the License Key field. Remo 3D will then be
unlocked for 30 days from the day when the license key was generated. When starting
Remo 3D, a message box will appear that states how long time is left for the time limited
license. If the time is up, the message box will state for how long the time limited license
has been exceeded.
The license key will by default be stored in the same folder as the Remo 3D executable
file. This can be changed by entering a filename in which the license should be stored. To
use an alternative location of the license file, i.e. not alongside the Remo 3D executable
file and named license.dat, use the environment variable REMO3D_LICENSE_FILE to
specify the license file to use.
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Installed Content
Remo 3D is installed with a comprehensive built-in help system, a tutorial complete with
necessary models and textures, sample model files, scripts and macros.

Built-in Help System
The help system is described in the Help chapter.

Tutorial
With the tutorial you will learn how to use a majority of the tools in Remo 3D. The
models and textures necessary for performing the tutorial steps, as well as the tutorial
document, are available in the tutorial folder.

Samples
The samples folder contains the following sample material:

Sample Models
The samples/EdgedSign, samples/Simthetiq and samples/Cantaloupe folders contain
some nice OpenFlight® models from EdgedSign, Simthetiq Inc. and cantaloupe|3d.

Scripts
The samples/scripts folder contains a number of sample command-line scripts
described in the Script Samples section.

Macros
The samples/macros folder contains sample macros described in the Macro Samples
section.
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Help
The Remo 3D help will open up in a separate window. If not closed manually, it will
remain open until Remo 3D is closed.
The help system is based on the Eclipse platform running in a Java™ environment.
Therefore, it requires that Java™ is installed on the computer, with a path set to the java
executable. If not, the help window will not open. However, the same information is
available in the user’s guide that is installed with Remo 3D.

You can navigate through the contents in the left pane of the help window, use the
Search functionality at the top of the window or the Index available in the bottom left
part of the window. You can also print pages and set personal bookmarks that will be
saved until the next session.
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Scripts
All tasks available manually in Remo 3D are possible to automate through a script. The
script language is based on Lua (www.lua.org) with an addition of several Remo 3Dspecific functions.

Script Environment
A script can be written in your favorite text editor or in the Script Editor available from
the Script menu. Either way, this is where you execute the script and where you can see
the results.

A script can also be executed directly from the command-line by giving it as a parameter
to the remo3d executable file, like this:
remo3d <script filename> <arguments>
or for instance like this in Microsoft® Windows®:
"C:\Program Files\Remo3D\remo3d.exe" <script filename> <arguments>
In Microsoft® Windows®, a separate console window will open when executing a script
from the command-line. To be able to see any printed information in this console, the
execution ends with a pause where the user has to press a key to continue. When
executing multiple scripts from e.g. a batch file this is not ideal, so to avoid having to
press a key between each script, an environment variable called
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REMO3D_SCRIPT_CONFIRMATION can be set to OFF (or off) by doing the following (any
other value or no environment variable at all will result in confirmations):
Start -> Settings -> Control Panel -> System -> Advanced ->
Environment Variables -> New
Enter REMO3D_SCRIPT_CONFIRMATION as variable name and OFF as variable
value.
To direct the text output from a script to a log file rather than the console, use the
REMO3D_LOG environment variable to point at a log file, e.g. set it to C:\Temp\log.txt.
The log file doesn’t have to exist before the script is executed. When REMO3D_LOG is
defined, no console window will open while running a command-line script in Microsoft®
Windows®.
When executing a script from the command-line, the arg table will be filled with the
given command-line arguments, just like with normal Lua command-line usage. The
remo3d executable path goes into index -1 of the arg table, the script filename goes into
index 0, the first script argument goes into index 1, and so on. The following command
line would e.g. generate the following arg table:
remo3d script.lua a b
arg[-1] = "remo3d"
arg[0] = "script.lua"
arg[1] = "a"
arg[2] = "b"
A script executed from the Script Editor will operate in the current Remo 3D
environment, i.e. the currently open models will be available to the script and any
immediate commands from the script will be operating on the current model. A script
executed from the command-line will have to open or create a model explicitly.

Script Samples
The Remo 3D installation contains a number of script samples. See the Script
Environment section for information about how to execute a command-line script. The
samples/scripts folder contains the following command-line scripts:
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convert.lua
Remo 3D command-line script for converting between all model file formats supported by Remo
3D.
Usage:
convert.lua <input filename> <output filename>
<input filename> is the source model, has to be OpenFlight or format supported for import in
Remo 3D.
<output filename> is the target model, has to be OpenFlight or format supported for import in
Remo 3D.
flt2txt.lua
Remo 3D command-line script for printing nodes as an indented scene graph in a new text file.
Usage:
flt2txt.lua <model filename> <text filename>
<model filename> is the input OpenFlight model file.
<text filename> is the output text file.
fltConvert.lua
Remo 3D command-line script for converting between OpenFlight versions.
Usage:
fltConvert.lua <input filename> <output filename> <version>
<input filename> is the source OpenFlight file.
<output filename> is the target OpenFlight file.
<version> is the new OpenFlight version as an integer, e.g. 1600 or 1570.
listExternals.lua
Remo 3D command-line script for printing the file names of all external references in a given
model file.
Usage:
listExternals.lua <model filename>
<model filename> is the input OpenFlight model file.
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listTextures.lua
Remo 3D command-line script for printing the file names of all textures in a given model file.
Usage:
listTextures.lua <model filename>
<model filename> is the input OpenFlight model file.
setTextureFilters.lua
Remo 3D command-line script for setting minification and magnification filters on a given texture
image.
Usage:
setTextureFilters.lua <texture filename> <minFilter> <magFilter> [magFilterAlpha]
[magFilterColor]
<texture filename> is the texture image file, has to be supported by Remo 3D.
<minFilter> is the minification filter given as one of the strings in the corresponding Minfication
Filter combo-box in the Texture Attributes dialog in Remo 3D, e.g. MIPMAP_TRILINEAR.
<magFilter> is the magnification filter given as one of the strings in the corresponding
Magnification Filter combo-box in the Texture Attributes dialog in Remo 3D, e.g. BILINEAR.
[magFilterAlpha] and [magFilterColor] are optional, see above for instructions. Note that if
magFilterColor is given, then magFilterAlpha must be given as well.

The samples/macros folder contains a number of sample macros described in the Macro
Samples section.

Script Reference
The following sections describe all Remo 3D-specific functions that you can use in
combination with the functions from all standard Lua libraries. For more information
about the functionality behind the functions, see the corresponding descriptions of menu
options or tools.
All actions available to the user interactively in Remo 3D can be performed in a script
with corresponding functions. These actions include tools or palette operations that
modify the model, left- or right-shifting of nodes, all types of selection operations, cutting
and pasting of geometry, moving of the pivot point and setting the parent node. The
retrieval (get/report) functions available will report properties, characteristics or
attributes that are visible to the user in the Remo 3D user interface. In additions to these
functions, there are functions for traversing the tree structure (remo.traverse) and
converting the current selection to another mode (remo.convertSelection).
These are some general facts to be aware of when writing scripts for Remo 3D:
The “remo.” prefix is used with every script function.
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While indices generally begin with 1 in Lua, the Remo 3D-specific indices are zerobased.
File paths given as strings in a script, e.g. to functions such as remo.openModel, can
use both forward slashes (/) and back slashes (\) as separators, regardless of the
current operating system. Note that back slashes have to be represented as
duplicates (\\) in hard-coded strings.
It is prohibited to create or import multiple models with the same name, since you
wouldn’t be able to switch to them in a deterministic way.
Be sure to use the print function in Lua to achieve text output from your script, the
io.write function will not produce any text in the Script Editor output dialog or the
console. Note that the print function always ends with a new-line, to avoid this the
REMO3D_NO_LINE_FEED environment variable can be used.
The version of the Lua library shipped with Remo 3D is 5.2.3.

General Script Functions
This section describes all general and miscellaneous script functions.

remo.getVersion()
Reports the current Remo 3D version.
returns: The Remo 3D version as a number, e.g. 2.0 or 2.3.
remo.changePivot(x, y, z)
Changes the position of the pivot point to a given point.
x, y, z: The coordinate at which the new pivot should be located.
remo.getPivot()
Reports the current pivot point.
returns: The current pivot point as three values (x,y,z).
remo.getNumChildren()
Reports the number of children for a selected node. One and only one selected node is allowed.
Vertices will not be counted, so the children of polygons and light points will only be other polygons
(sub-faces) or light points.
returns: The number of children for the selected node as an integer.
remo.getNumVertices()
Reports the number of vertices for a selected polygon or light point node. One and only one
selected polygon or light point node is allowed.
returns: The number of vertices for the selected polygon or light point node.
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remo.executeMacro(scriptFile, paramName1, paramValue1, ...)
Executes a macro with parameters.
scriptFile: The script file to execute.
paramNameX: The name of the parameter number X.
paramValueX: The value for the parameter number X.
remo.traverse(preCallback, postCallback)
Traverses the selected nodes recursively (depth-first), executing given callback functions for each
node. Vertices are also traversed. The selection is cleared after the traversal. See below for details.
(*)
preCallback: The pre-callback function (as a function first-class value). The node being traversed is
selected and this callback is executed before traversing the sub-tree beneath the node. Can be
specified as nil, but at least one of the pre- or post-callback functions must be defined. See below
for details. (*)
postCallback: The post-callback function (as a function first-class value). The node being traversed
is selected and this callback is executed after traversing the sub-tree beneath the node. Can be
specified as nil, but at least one of the pre- or post-callback functions must be defined. See below
for details. (*)
remo.setTolerance(tolerance)
Sets the tolerance used by different tools and script functions. This tolerance is described in the
Preferences section.
tolerance: The desired tolerance.
remo.getTolerance()
Returns the tolerance used by different tools and script functions. This tolerance is described in the
Preferences section.
returns: The current tolerance.

(*) The pre- and post-callback functions used in the remo.traverse function are given
the selection mode of the current node as a string, one of the following:
"VERTEX"
"POLYGON"
"OBJECT"
"GROUP"
"LOD"
"DOF"
"EXTERNAL"
"SWITCH"
"LIGHTPOINT"
"LIGHTPOINTSYSTEM"
"HEADER"
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The pre-callback function must return a boolean specifying whether the traversal should
continue downwards or not. Note that the post-callback function is executed on a node
whose pre-callback returned false, even if the traversal below wasn’t performed. Also
note that if the current model is changed in the callback functions (e.g. another model is
temporarily opened), it has to be changed back with remo.setCurrentModel before
leaving the function.
Below is an example that prints the type and name of each node, indented according to
the tree structure. Vertex names are avoided by returning false from the pre-callback
after printing the names of polygon nodes and light point nodes.
indent = 0
function preCallback(selectionMode)
print(string.rep(" ", indent) .. selectionMode .. ": " .. remo.getAttributes("Name"))
indent = indent + 1
return (selectionMode ~= "POLYGON" and selectionMode ~= "LIGHTPOINT")
end
function postCallback(selectionMode)
indent = indent – 1
end
remo.selectAll("HEADER")
remo.traverse(preCallback, postCallback)

File Script Functions
This section describes script functions related to model files.

remo.newModel(filename)
Creates a new (unsaved) OpenFlight model and makes it the current model.
filename: The filename of the new (unsaved) OpenFlight model.
returns: true if the new operation was successful.
remo.openModel(filename)
Opens an OpenFlight model and makes it the current model.
filename: The filename of the OpenFlight model that should be opened.
returns: true if the open operation was successful.
remo.revertModel()
Reverts the current OpenFlight model.
returns: true if the revert operation was successful.
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remo.saveModel(version)
Saves the current model to an OpenFlight file with the current model's filename.
version (optional, default latest supported): The version of the saved file as an integer, e.g. 1570
or 1620.
returns: true if the save operation was successful.
remo.saveModelAs(filename, version)
Saves the current model to an OpenFlight file with a given filename.
filename: The filename to which the OpenFlight model should be saved.
version (optional, default latest supported): The version of the saved file as an integer, e.g. 1570
or 1620.
returns: true if the save operation was successful.
remo.isModelUnsaved()
Reports whether the current model is unsaved or not.
returns: true if the current model is unsaved.
remo.importModel(sourceFilename, targetFilename, textureOutputPath,
shaderOutputPath, shaderOutputBaseName, externalOutputPath)
Imports geometry to a new (unsaved) model and makes it the current model.
sourceFilename: The filename from which to import.
targetFilename: The filename of the new model with the imported geometry.
textureOutputPath (optional, default empty): The output path where embedded textures will be
written. If not given or empty, no embedded textures will be written to disk.
shaderOutputPath (optional, default empty): The output path where embedded shaders will be
written. If not given or empty, no embedded shaders will be written to disk.
shaderOutputBaseName (optional, default empty): The base name of embedded shaders written to
disk. If not given or empty, no embedded shaders will be written to disk.
externalOutputPath (optional, default empty): The output path where externally referenced files
will be written. If not given or empty, no externally referenced files will be written to disk.
returns: true if the import operation was successful.
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remo.exportModel(filename)
Exports the current model to a file. The file extension determines the output file format.
filename: The filename to which to export.
returns: true if the export operation was successful.
remo.closeModel()
Closes the current model.
remo.setCurrentModel(filename)
Sets the current model to the model with the given filename. If no such model exists, this does
nothing.
filename: The filename of the model that is to be made current.
returns: true if the current model switch succeeded.
remo.getCurrentModelFilename()
Reports the filename of the current model.
returns: The current model filename as a string.
remo.saveAllModels()
Saves all open models.
remo.closeAllModels()
Closes all open models.
remo.makeExternalPathsRelative()
Update all external reference paths to be relative to the current model file path.
remo.makeExternalPathsAbsolute()
Update all external reference paths to be absolute, by appending the model file path to the relative
paths.
V

Clipboard/Edit Script Functions
This section describes script functions related to the clipboard and general editing.

remo.cut()
Cuts the currently selected nodes to the clipboard.
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remo.copy()
Copies the currently selected nodes to the clipboard.
remo.paste()
Pastes the contents of the clipboard under the current parent.
remo.delete()
Deletes the currently selected nodes.
remo.setParent()
Sets the parent to the currently selected node.
remo.changeParent()
Moves the currently selected nodes to the current parent.
remo.getParent()
Reports the name of the current parent node.
returns: The name of the current parent node as a string.
remo.shiftLeft()
Shift selected nodes one step to the left.
remo.shiftRight()
Shift selected nodes one step to the right.
remo.shiftFarLeft()
Shift selected nodes all the way to the left.
remo.shiftFarRight()
Shift selected nodes all the way to the right.

Selection Script Functions
This section describes script functions related to selecting geometry and nodes in
different ways.
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remo.selectAll(selectionMode)
Selects all primitives of a given mode.
selectionMode: The selection mode as a string, one of the following:
"VERTEX"
"EDGE"
"POLYGON"
"OBJECT"
"GROUP"
"LOD"
"DOF"
"EXTERNAL"
"SWITCH"
"LIGHTPOINT"
"LIGHTPOINTSYSTEM"
"HEADER"
returns: true if any primitive was selected.
remo.selectByName([table | name1, name2, ...], caseSensitive, addToSelection)
Selects all primitives with at least one specific name (give a table OR separate names as
parameters)
table: A table of names, given as [name1, name2, ...]
nameX: One of the names to search for; could be one (name1 only) or an arbitrary number of
names.
caseSensitive (optional, default false): true if the match should be case sensitive.
addToSelection (optional, default false): true if the selected nodes should be added to the current
selection.
returns: true if any primitive was selected.
remo.selectNone()
Clears all selections.
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remo.invertSelection(selectionMode)
Inverts the selection of a given mode.
selectionMode: The selection mode as a string, one of the following:
"VERTEX"
"EDGE"
"POLYGON"
"OBJECT"
"GROUP"
"LOD"
"DOF"
"EXTERNAL"
"SWITCH"
"LIGHTPOINT"
"LIGHTPOINTSYSTEM"
"HEADER"
remo.selectByAttributes(selectionMode, conditionString, addToSelection,
indexedLightPoint)
Selects all primitives matching a given condition of desired attributes (see below for details). (*)
selectionMode: The selection mode as a string, one of the following:
"VERTEX"
"POLYGON"
"OBJECT"
"GROUP"
"LOD"
"DOF"
"EXTERNAL"
"SWITCH"
"LIGHTPOINT"
"LIGHTPOINTSYSTEM"
conditionString: The string representing the expression for selecting nodes, more information
below. (*)
addToSelection (optional, default false): true if selection should be added to the existing selection.
indexedLightPoint (optional, default false): true if light points should be of indexed type, false if
inline.
returns: true if any primitive was selected.
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remo.getNumSelectedPrimitives(selectionMode)
Reports the number of selected primitives of a given mode.
selectionMode: The selection mode as a string, one of the following:
"VERTEX"
"EDGE"
"POLYGON"
"OBJECT"
"GROUP"
"LOD"
"DOF"
"EXTERNAL"
"SWITCH"
"LIGHTPOINT"
"LIGHTPOINTSYSTEM"
"HEADER"
returns: The number of selected primitives of the given mode.
remo.getTotalNumSelectedPrimitives()
Reports the number of selected primitives of all modes.
returns: The total number of selected primitives.
remo.getSelectionNames()
Reports the names of all selected primitives.
returns: A table containing the names of the selected primitives.
remo.convertSelection(selectionMode)
Converts the selection to a given mode. E.g., if a number of objects and groups are selected and
selectionMode is "POLYGON", this will select all polygons beneath the objects and groups.
selectionMode: The selection mode as a string, one of the following:
"VERTEX"
"EDGE"
"POLYGON"
"OBJECT"
"GROUP"
"LOD"
"DOF"
"EXTERNAL"
"SWITCH"
"LIGHTPOINT"
"LIGHTPOINTSYSTEM"
remo.selectSliverPolygons()
Selects all polygons in the model (or in the selected sub-tree) having an angle smaller than the
current tolerance between two edges. Those polygons are considered to be slivers. The current
tolerance is described in the Preferences section.
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remo.selectByNumberOfVertices(number, selectFromCurrent)
Selects all polygons in the model (or in the selected sub-tree) having a given number of vertices.
number: The desired number of vertices.
selectFromCurrent (optional, default true): true if selection is to be performed within the already
selected geometry.
remo.selectParents()
Selects the parents of the currently selected nodes.
remo.selectChildren()
Selects the child nodes of the currently selected nodes.
remo.selectPrevious()
Selects the previously selected nodes. This will essentially toggle between the two latest selections.
remo.selectVerticesByLocation(x, y)
Selects vertices with a specified two-dimensional x,y position, using the current tolerance specified
in the preferences.
x, y: The 2D coordinate with which to search for vertices.
remo.selectNakedEdges()
Select edges in currently selected geometry or in the whole model having no neighbors and
thereby considered 'naked'.

(*) The condition string given to the remo.selectByAttributes function needs some
special attention:
A condition is made up of a number of expressions connected with AND or OR (case
insensitive) relations.
An expression is made up of three parts; an attribute name given as it appears in the
corresponding label in the attribute tool (case insensitive), a relation and a value
(case insensitive for strings).
A relation is either = (equal to), < (less than), > (greater than) or != (not equal to).
The following are examples of different condition strings:
"Coordinate x < 19 AND normal enabled = 1"
"billboard/alpha = Fixed / Alpha and draw mode = Solid one side"
There are special rules for the attribute names, described at the asterisk (*) in the
Attribute Script Functions section.
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Transformation Script Functions
This section describes script functions for transformation tools.

remo.move(x, y, z, absolute, moveToPoint, softSelectionActive, radius,
weightFunction, weightMode, freezeX, freezeY, freezeZ, applyMatrix)
Moves the currently selected geometry.
x, y, z: The coordinates for the movement.
absolute (optional, default false): true if the movement should be made absolute, false if relative.
moveToPoint (optional, default false): true if all selected nodes should be moved to the same
point.
(if moveToPoint is set to true the coordinates will always be treated as absolute)
softSelectionActive (optional, default false): true if soft selection should be active.
radius (optional, default 10.0): The soft selection radius.
weightFunction (optional, default "LINEAR"): The soft selection weight function as a string, one of
the following:
"LINEAR"
"SQUARE"
"SQUAREROOT"
"CUBE"
"CUBEROOT"
weightMode (optional, default "WEIGHT_PER_VERTEX"): The soft selection weight mode as a
string, one of the following:
"WEIGHT_PER_VERTEX"
"WEIGHT_PER_PRIMITIVE"
freezeX, freezeY, freezeZ (optional, default false): Set to true to freeze movement along certain
axes.
applyMatrix (optional, default false): Set to true to apply as transformation matrix.
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remo.rotate(angle, axisX, axisY, axisZ, normal, softSelectionActive, radius,
weightFunction, weightMode, applyMatrix)
Rotates the currently selected geometry.
angle: The angle to rotate in degrees.
axisX, axisY, axisZ: The axis to rotate around.
normal: true if the normals should be rotated.
softSelectionActive (optional, default false): true if soft selection should be active.
radius (optional, default 10.0): The soft selection radius.
weightFunction (optional, default "LINEAR"): The soft selection weight function as a string, one of
the following:
"LINEAR"
"SQUARE"
"SQUAREROOT"
"CUBE"
"CUBEROOT"
weightMode (optional, default "WEIGHT_PER_VERTEX"): The soft selection weight mode as a
string, one of the following:
"WEIGHT_PER_VERTEX"
"WEIGHT_PER_PRIMITIVE"
applyMatrix (optional, default false): Set to true to apply as transformation matrix.
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remo.scale(scaleX, scaleY, scaleZ, softSelectionActive, radius, weightFunction,
weightMode, applyMatrix)
Scales the currently selected geometry.
scaleX: The scale along the x-axis.
scaleY: The scale along the y-axis.
scaleZ: The scale along the z-axis.
softSelectionActive (optional, default false): true if soft selection should be active.
radius (optional, default 10.0): The soft selection radius.
weightFunction (optional, default "LINEAR"): The soft selection weight function as a string, one of
the following:
"LINEAR"
"SQUARE"
"SQUAREROOT"
"CUBE"
"CUBEROOT"
weightMode (optional, default "WEIGHT_PER_VERTEX"): The soft selection weight mode as a
string, one of the following:
"WEIGHT_PER_VERTEX"
"WEIGHT_PER_PRIMITIVE"
applyMatrix (optional, default false): Set to true to apply as transformation matrix.
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remo.addTransformationMatrix(type, ...
(rest of parameters depending on type as follows:)
TRANSLATE:
..., fromX, fromY, fromZ, deltaX, deltaY, deltaZ, index)
SCALE:
..., centerX, centerY, centerZ, scaleX, scaleY, scaleZ, index)
ROTATE_ABOUT_EDGE:
..., point1X, point1Y, point1Z, point2X, point2Y, point2Z, angle, index)
ROTATE_ABOUT_POINT:
..., centerX, centerY, centerZ, axisX, axisY, axisZ, angle, index)
GENERAL_MATRIX:
..., m00, m01, m02, m03,
m10, m11, m12, m13,
m20, m21, m22, m23,
m30, m31, m32, m33, index)
Applies a transformation matrix of a given type to the selected node. This will only work with a
single (one and only one) node selected. Transformation matrices can be applied to group nodes,
object nodes, LOD nodes, external references, light point system nodes and switch nodes.
Transformation matrices can also be applied to polygon and light point nodes, but the
transformation matrices are only used to transform replications; without a replication the
transformation matrices have no effect. If a group has a transformation matrix and a replication,
the transformation matrix is used to transform the replications.
type: The type of transformation as a string, one of the following:
"TRANSLATE"
"SCALE"
"ROTATE_ABOUT_EDGE"
"ROTATE_ABOUT_POINT"
"GENERAL_MATRIX"
fromX, fromY, fromZ: The reference 'from' position of a translation. Not used in the calculation.
deltaX, deltaY, deltaZ: The translation distance.
centerX, centerY, centerZ: The center of a scale or a rotate-about-point transformation.
scaleX, scaleY, scaleZ: The scale factors in X, Y and Z.
point1X, point1Y, point1Z: The 'from' point of the edge about which to rotate.
point2X, point2Y, point2Z: The 'to' point of the edge about which to rotate.
angle: The angle in degrees with which the rotation is performed.
axisX, axisY, axisZ: The axis around which the rotation is to be performed.
mXY: The value at column X and row Y of the general transformation matrix.
index (optional, default last): The zero-based index at which the new transformation matrix is to
be added.
returns: true if a transformation matrix was added.
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remo.getNumTransformationMatrices()
Reports the number of transformation matrices applied to the selected node. This will only work
with a single (one and only one) node selected.
returns: The number of transformation matrices for the selected node.
remo.getTransformationMatrixType(index)
Reports the type of transformation matrix at a given index for the selected node.
index: The zero-based index at which the requested transformation matrix is located.
returns: The type of transformation as a string, one of the following:
"TRANSLATE"
"SCALE"
"ROTATE_ABOUT_EDGE"
"ROTATE_ABOUT_POINT"
"ROTATE_SCALE_TO_POINT"
"PUT_TRANSFORM"
"GENERAL_MATRIX"
(or an empty string if no transformation matrix is at the given index)
remo.eliminateTransformationMatrices()
Eliminates all transformation matrices recursively in the currently selected sub-tree and modifies
all coordinates accordingly instead.
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remo.getTransformationMatrix(index)
Reports the attributes of the transformation matrix at a given index for the selected node.
index: The zero-based index at which the requested transformation matrix is located.
returns: Multiple values:
Always the type of transformation as a string, one of the following:
"TRANSLATE"
"SCALE"
"ROTATE_ABOUT_EDGE"
"ROTATE_ABOUT_POINT"
"ROTATE_SCALE_TO_POINT"
"PUT_TRANSFORM"
"GENERAL_MATRIX"
(or an empty string if no transformation matrix is at the given index)
Different values depending on type:
TRANSLATE:
fromX, fromY, fromZ: The reference 'from' position of the translation. Not used in the calculation.
deltaX, deltaY, deltaZ: The translation distance.
SCALE:
centerX, centerY, centerZ: The center of the scale transformation.
scaleX, scaleY, scaleZ: The scale factors in X, Y and Z.
ROTATE_ABOUT_EDGE:
point1X, point1Y, point1Z: The 'from' point of the edge about which to rotate.
point2X, point2Y, point2Z: The 'to' point of the edge about which to rotate.
angle: The angle in degrees with which the rotation is performed.
ROTATE_ABOUT_POINT:
centerX, centerY, centerZ: The center of the rotation.
axisX, axisY, axisZ: The axis around which the rotation is to be performed.
angle: The angle in degrees with which the rotation is performed.
ROTATE_SCALE_TO_POINT:
centerX, centerY, centerZ: The center of the rotate-scale-to-point transformation.
refX, refY, refZ: The reference point of the rotate-scale-to-point transformation.
toX, toY, toZ: The 'to' point of the rotate-scale-to-point transformation.
overallScaleFactor: The overall scale factor of the rotate-scale-to-point transformation.
axisScaleFactor: The scale factor in axis direction of the rotate-scale-to-point transformation.
angle: The angle in degrees with which the rotation is performed.
PUT_TRANSFORM:
fromOriginX, fromOriginY, fromOriginZ: The 'from' point origin coordinate.
fromAlignX, fromAlignY, fromAlignZ: The 'from' point align coordinate.
fromTrackX, fromTrackY, fromTrackZ: The 'from' point track coordinate.
toOriginX, toOriginY, toOriginZ: The 'to' point origin coordinate.
toAlignX, toAlignY, toAlignZ: The 'to' point align coordinate.
toTrackX, toTrackY, toTrackZ: The 'to' point track coordinate.
GENERAL_MATRIX:
m00, m01, m02, m03, m10, m11, m12, m13, m20, m21, m22, m23, m30, m31, m32, m33:
The general transformation matrix values.
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remo.clearTransformationMatrices()
Clears all transformation matrices from the selected node.
returns: true if any transformation matrices were cleared.
remo.removeTransformationMatrix(index)
index: The zero-based index at which the requested transformation matrix is located.
returns: true if a transformation matrix was removed.
remo.moveTransformationMatrix(index, newIndex)
index: The zero-based index at which the requested transformation matrix is located.
newIndex: The new zero-based index for the transformation matrix.
remo.getAccumulatedTransformationMatrix()
Reports the accumulated transformation matrix for the selected node.
returns: The accumulated transformation matrix as separate values:
m00, m01, m02, m03, m10, m11, m12, m13, m20, m21, m22, m23, m30, m31, m32, m33

Creation Script Functions
This section describes script functions for creation tools.

remo.create(selectionMode)
Creates a primitive of given type.
selectionMode: The selection mode as a string, one of the following:
"OBJECT"
"GROUP"
"LOD"
"DOF"
"SWITCH"
"LIGHTPOINTSYSTEM"
returns: The name of the new node, empty string if no node was created.
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remo.createPolygon([table | x1, y1, z1, x2, y2, z2, ... , xn, yn, zn])
Creates a polygon (give a table OR separate coordinates as parameters)
table: A table of coordinates, given as [x1, y1, z1, x2, y2, z2, ...]
x1, y1, z1: Coordinate for the first point in the polygon.
x2, y2, z2: Coordinate for the second point in the polygon.
xn, yn, zn: Coordinate for the last point in the polygon.
returns: The name of the new polygon, empty string if no polygon was created.
remo.createDisk(centerX, centerY, centerZ, borderX, borderY, borderZ, normalX,
normalY, normalZ, numSegments)
Creates a disk polygon.
centerX, centerY, centerZ: The center coordinate for the disk.
borderX, borderY, borderZ: The border coordinate for the disk.
normalX, normalY, normalZ: The normal for the disk.
numSegments: The number of segments in the disk.
returns: The name of the created disk polygon, empty string if no disk was created.
remo.createSphere(centerX, centerY, centerZ, borderX, borderY, borderZ, numRows,
numSegments)
Creates a sphere.
centerX, centerY, centerZ: The center coordinate.
borderX, borderY, borderZ: The border coordinate.
numRows: The number of rows in the sphere.
numSegments: The number of segments in the sphere.
returns: The name of the created sphere object node, empty string if no sphere was created.
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remo.createLightPoint(indexed, x1, y1, z1, x2, y2, z2, ... , xn, yn, zn)
Creates a light point node with one or more light point vertices.
indexed: true if an indexed light point is wanted, false if ordinary (inline).
x1, y1, z1: The coordinate for the first light point.
x2, y2, z2: The coordinate for the second light point.
xn, yn, zn: The coordinate for the last light point.
returns: The name of the new light point node, empty string if no light point node was created.
remo.createExternals(filename1, filename2, ...)
Creates one or more external references.
filenameX: The filename for the external number X to be created.
returns: true if any external reference nodes were created.

Surface Script Functions
This section describes script functions for surface appearance tools.

remo.applyColor()
Applies the current color to the currently selected nodes.
returns: true if any color was applied.
remo.readColor()
Reads the color from the currently selected node(s). The retrieved color will be the current color.
returns: true if a color was retrieved.
remo.applyTexture()
Applies the current texture to the currently selected nodes.
returns: true if any texture was applied.
remo.readTexture()
Reads the texture from the currently selected node(s). The retrieved texture will be the current
texture.
returns: true if a texture was retrieved.
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remo.applyTextureMapping()
Applies the current texture mapping to the currently selected nodes.
returns: true if any texture mapping was applied.
remo.readTextureMapping()
Reads the texture mapping from the currently selected node(s). The retrieved texture mapping will
be the current texture mapping.
returns: true if a texture mapping was retrieved.
remo.applyMaterial()
Applies the current material to the currently selected nodes.
returns: true if any material was applied.
remo.readMaterial()
Reads the material from the currently selected node(s). The retrieved material will be the current
material.
returns: true if a material was retrieved.
remo.applyShader()
Applies the current shader to the currently selected nodes.
returns: true if any shader was applied.
remo.readShader()
Reads the shader from the currently selected node(s). The retrieved shader will be the current
shader.
returns: true if a shader was retrieved.
remo.removeTexture()
Removes all texture and texture mapping indices from the currently selected nodes.
returns: true if any texture or texture mapping was removed.
remo.removeTextureMapping()
Removes all texture mapping indices from the currently selected nodes.
returns: true if any texture mapping was removed.
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remo.removeMaterial()
Removes all material indices from the currently selected nodes.
returns: true if any material was removed.
remo.removeShader()
Removes all shader indices from the currently selected nodes.
returns: true if any shader was removed.

Texture Mapping Script Functions
This section describes script functions for texture mapping.

remo.mapTexture(type, layer, addToPalette, ...
(rest of parameters depending on type as follows:)
THREEPOINT:
..., x1,y1,z1, x2,y2,z2, x3,y3,z3, u1,v1, u2,v2, u3,v3)
FOURPOINT:
..., x1,y1,z1, x2,y2,z2, x3,y3,z3, x4,y4,z4, u1,v1, u2,v2, u3,v3, u4,v4)
CYLINDRICAL, no palette:
..., x1,y1,z1, x2,y2,z2, x3,y3,z3, horizRepetitions)
CYLINDRICAL, with palette:
..., x1,y1,z1, x2,y2,z2, horizRepetitions)
SPHERICAL, no palette:
..., x1,y1,z1, x2,y2,z2, x3,y3,z3, horizRepetitions, vertRepetitions)
SPHERICAL, with palette:
..., x1,y1,z1, repetitions)
Maps the current texture on to the currently selected nodes.
type: The texture mapping type as a string, one of the following:
"THREEPOINT"
"FOURPOINT"
"CYLINDRICAL"
"SPHERICAL"
layer: The texture layer (0 - 7).
addToPalette: true if the created texture mapping should be added to the texture mapping palette.
x1,y1,z1: The first (origin) coordinate of a 3-point or 4-point mapping,
or the center of a non-palette cylindrical mapping (addToPalette = false),
or the lower center of a palette cylindrical mapping (addToPalette = true),
or the center of a spherical mapping.
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x2,y2,z2: The second (alignment) coordinate of a 3-point or 4-point mapping,
or the perpendicular surface coordinate of a non-palette cylindrical or spherical mapping
(addToPalette = false),
or the upper center of a palette cylindrical mapping (addToPalette = true).
x3,y3,z3: The third (shear) coordinate of a 3-point or 4-point mapping,
or the vertical perpendicular coordinate of a non-palette cylindrical or spherical mapping
(addToPalette = false).
x4,y4,z4: The fourth (perspective) coordinate of a 4-point mapping.
u1,v1: The texture coordinate corresponding to the first (origin) coordinate of a 3-point or 4-point
mapping.
u2,v2: The texture coordinate corresponding to the second (alignment) coordinate of a 3-point or
4-point mapping.
u3,v3: The texture coordinate corresponding to the third (shear) coordinate of a 3-point or 4-point
mapping.
u4,v4: The texture coordinate corresponding to the fourth (perspective) coordinate of a 4-point
mapping.
horizRepetitions: The number of horizontal repetitions for a cylindrical or non-palette spherical
mapping (addToPalette = false).
vertRepetitions: The number of vertical repetitions for a non-palette spherical mapping
(addToPalette = false).
repetitions: The number of horizontal and vertical repetitions for a palette spherical mapping
(addToPalette = true).
returns: true if any texture was mapped.
remo.moveTexmap(x, y, z, layer, freezeX, freezeY, freezeZ)
Moves the texture coordinates of the currently selected geometry.
x, y, z: The coordinates for the movement.
layer (optional, default 0): The texture layer to be moved.
freezeX, freezeY, freezeZ (optional, default false): Set to true to freeze movement along certain
axes.
remo.rotateTexmap(angle, axisX, axisY, axisZ, layer)
Rotates the texture coordinates of the currently selected geometry.
angle: The angle to rotate in degrees.
axisX, axisY, axisZ: The axis to rotate around.
layer (optional, default 0): The texture layer to be rotated.
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remo.scaleTexmap(scaleX, scaleY, scaleZ, layer)
Scales the texture coordinates of the currently selected geometry.
scaleX: The scale along the x-axis.
scaleY: The scale along the y-axis.
scaleZ: The scale along the z-axis.
layer (optional, default 0): The texture layer to be moved.
remo.modifyUV(layer, vertexName1, u1, v1, vertexName2, u2, v2, ...)
Modifies the texture coordinate of one or more given vertices.
layer: The texture layer (0 - 7).
vertexNameX: The name of a vertex, e.g. p19/V2.
uX, vX: The new texture coordinate for the given vertex.
NOTE: Since the modifyUV function doesn't use the current selection, this is not the most efficient
way of modifying a texture mapping from script, merely a necessary equivalent to be able to
record actions in the Modify UV tool. Consider using the texture mapping transformation functions
described above or the applyAttributes function instead.

Modification Script Functions
This section describes script functions for modification tools.

remo.mirror()
Mirrors the selected nodes with respect to the grid plane.
returns: true if any geometry was mirrored.
remo.reverse()
Reverses the polygons in the current selection.
returns: true if any polygons were reversed.
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remo.slice(sliceAlongGridPlane)
Slices the currently selected geometry either along the grid plane or along the grid lines.
sliceAlongGridPlane: Set to true to slice along the grid plane. Set to false to slice along the grid
lines, like a cookie-cutter.
returns: true if any geometry was sliced.
remo.split()
Splits selected edges in halves, triangulates selected polygons and splits polygons between
selected vertices.
returns: true if any geometry was split.
remo.extrude(keepFloor, ...
(rest of parameters depending on if user wants a point or a height:)
POINT:
..., x, y, z, sharedAxis)
HEIGHT:
..., height)
Extrudes (elevates and builds walls) the currently selected polygons to a POINT or a along the
polygon normals to a specific HEIGHT.
keepFloor: true if the floor should be kept.
x, y, z: The point to which the extrusion is to be performed.
sharedAxis: Use the extrusion axis from the pivot point of the selected polygons to the indicated
point.
height: The height with which the extrusion will be performed.
returns: true if any geometry was extruded.
remo.revolve(x, y, z, angle, numSteps, revolveNormals)
Revolves the currently selected polygons around a specific axis. Note that the revolve origin is the
current pivot point.
x, y, z: The axis to revolve around.
angle: The angle to revolve.
numSteps: The number of steps to divide the revolve into.
revolveNormals: true if the normals should be revolved.
returns: true if any geometry was revolved.

133

Remo 3D™ v2.10 User’s Guide

remo.subdivide(iterations, subdivideBorders)
Increases the complexity of the selected geometry by subdividing the current polygons.
iterations: The number of subdividing iterations.
subdivideBorders (optional, default false): true if borders should be subdivided.
returns: true if any geometry was subdivided.
remo.simplify(level, weightRatio, boundaryLevel, boundaryWeightRatio,
vertexWeightEqual)
Reduces the complexity of the selected geometry.
level: The simplify level (0.0 - 1.0), where 1.0 means maximum reduction and 0.0 means no
reduction.
weightRatio: The ratio (0.0 - 1.0) with which to blend between the edge length and the normal
deviation. 0.0 means using only edge length and 1.0 means using only normal deviation.
boundaryLevel: The simplify level for the boundary edges (0.0 - 1.0), where 1.0 means maximum
reduction and 0.0 means no reduction.
boundaryWeightRatio: The ratio (0.0 - 1.0) with which to blend between the edge length and the
edge angles. 0.0 means using only edge length and 1.0 means using only edge angles.
vertexWeightEqual: true if the vertex weight is to be equal, otherwise the weight will be based on
the normal deviation.
returns: true if any geometry was simplified.
remo.merge(loose)
Merges co-planar polygons with matching attributes in the selected sub-tree. Selected vertices are
merged to a triangulated mesh beneath a new object node and selected edges are merged to
convex or concave polygons. The merged polygons are automatically selected.
loose (optional, default false): true to not consider same plane when merging polygons.
returns: true if any polygons were merged.
remo.quantify(quantification)
Quantifies all selected vertices to a specific value.
quantification: The value to quantify all values with.
returns: true if any vertices were quantified.
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remo.shade(flat, updateLightMode, vertexColorLit, creaseAngle)
Smooth or flat shades polygons in the selected geometry.
flat: true if the polygons should be flat shaded.
updateLightMode: true if the polygon light mode should be updated..
vertexColorLit (optional, default false): true if the polygon light mode should be set to 'vertex color
lit', false if 'polygon color lit'. Both require updateLightMode to be true.
creaseAngle (optional, default 180): The crease angle to use when smooth shading.
returns: true if any polygons were shaded.

Attribute Script Functions
This section describes script functions for attribute tools.

remo.applyAttributes(name1, attribute1, name2, attribute2, ...)
(remo.setAttributes is an alias that works exactly in the same way)
Applies a number of attributes to the selected geometry.
nameX: The name of the attribute number X as a string, as it appears in the corresponding label in
the attribute tool (case-insensitive). See below for more information. (*)
attributeX: The value of the attribute number X that is to be applied, can be of different types
(string, boolean or number) depending on the attribute.
returns: true if any attribute was applied.
remo.getAttributes(name1, name2, ...)
Reports the values for a number of given attributes of the selected geometry.
nameX: The name of the attribute number X as a string, as it appears in the corresponding label in
the attribute tool (case-insensitive). See below for more information. (*)
returns: A number of values corresponding to the given attribute names, in the same order. The
values can be of different types (string, boolean or number) depending on the attribute. If a value
is undefined or different among the selected primitives, it’s set to nil.
remo.addSwitchMask(maskString, maskIndex)
Adds a switch mask to the selected switch node.
maskString: A string containing 1 for an enabled child and 0 for a disabled child, e.g. "1101".
maskIndex (optional): If given, specifies the index of the new mask - otherwise added last.
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remo.deleteSwitchMask(maskIndex)
Deletes a given switch mask from the selected switch node.
maskIndex: The zero-based mask index.
remo.setSwitchMask(maskIndex, maskString)
Modifies an existing switch mask on the selected switch node.
maskIndex The zero-based index for the existing switch mask.
maskString: A string containing 1 for an enabled child and 0 for a disabled child, e.g. "1101".
remo.setActiveSwitchMaskIndex(maskIndex)
Sets the currently active switch mask on the selected switch node.
maskIndex: The zero-based index for the new currently active mask.
remo.getNumSwitchMasks()
Reports the number of switch masks for the selected switch node.
returns: The number of switch masks.
remo.getSwitchMask(maskIndex)
Reports a given switch mask for the selected switch node.
maskIndex: The zero-based mask index.
returns: The requested switch mask as a string containing 1 for an enabled child and 0 for a
disabled child, e.g. "1101".
remo.getSwitchState(maskIndex, childNumber)
Reports the switch state for a given child in a given switch mask on the selected switch node.
maskIndex: The zero-based mask index.
childNumber: The zero-based child number.
returns: The switch state (true or false) for the given child in the given mask.
remo.getCurrentSwitchMaskIndex()
Reports the index for the currently active switch mask for the selected switch node.
returns: The zero-based index for the currently active mask.

136

Remo 3D™ v2.10 User’s Guide

remo.applyComment(comment)
(remo.setComment is an alias that works exactly in the same way)
Applies a comment to the currently selected nodes.
comment: The comment string to set on the selected nodes.
returns: true if a comment was applied.
remo.getComment()
Reports the comment of the currently selected node(s).
returns: The comment string of the currently selected node(s). Empty if not equal among the
selected nodes.

(*) The labels given to apply/setAttributes and getAttributes should, as described above,
be given as they appear in the corresponding label in the attribute tool. However, there
are some special cases:
Attributes placed in groups in the attribute tool will normally get the group name as
prefix, e.g. "Primary Color Index". The exceptions from this rule are multi-texture
attributes, LOD switch range attributes and the Freeze LOD center attribute.
Attributes representing the check box in the top right corner of a group, used for
enabling or disabling the complete group (e.g. Normal and Texture Coordinate for
vertex attributes, Back Color for light point attributes) will get an "Enabled" suffix, e.g.
"Normal Enabled".
Additional information within parentheses or brackets at the end of a label will be
excluded.
To specify the multi-texture layer index of a multi-texture-specific attribute, a caseinsensitive "(layer X)" suffix has to be added to the attribute label name, where X is
the zero-based multi-texture layer index. An example is "Texture Index (layer 1)".
Special labels are used for the switch attributes:
"Mask Count" - replaces all masks with the new number of fully enabled masks.
"Active Mask" - the currently active zero-based mask index.
"Child Enabled (mask M, child C)" - the state (true/false) for the given child C in
the given mask M.
It's recommended to use the special switch functions described above for more
control of the switch attributes.
The same rules apply to the attribute list labels in the Select By Attributes window in
Remo 3D, which makes that list a good reference when writing your scripts.
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Reporting Script Functions
This section describes script functions for producing reports about the geometry.

remo.reportStatistics(name1, name2, ...)
Reports a number of statistic values.
nameX: The name of the statistic number X as a string, as it appears in the corresponding label in
the statistics tool (case-insensitive).
returns: A number of values corresponding to the given statistic names, in the same order. The
values are of number type. If no result is applicable, e.g. because of an empty selection, zeroes
are returned.
remo.reportDifferences(source, ignoreRevisionDate, ignoreDatabaseVersion, filename)
Reports the differences between the currently selected sub-tree and either the sub-tree contained
in the current clipboard (put there by a Copy or Cut operation) or with another OpenFlight file.
source: The type of source, one of the following:
"CLIPBOARD"
"FILE"
ignoreRevisionDate (optional, default true): true if the revision date of the file to compare with
should be ignored.
ignoreDatabaseVersion (optional, default true): true if the database version (not the OpenFlight
version) of the file to compare with should be ignored.
filename: The name of the file to compare with (if source is "FILE", otherwise ignored)
returns: The first difference encountered, as a descriptive string. The difference can be e.g.
different node types, node names, attributes or different numbers of children.

Grid Script Functions
This section describes script functions handling the current grid.

remo.setXYGrid()
Sets the grid to be aligned to the XY plane with the origin at (0,0,0).
remo.setXZGrid()
Sets the grid to be aligned to the XZ plane with the origin at (0,0,0).
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remo.setYZGrid()
Sets the grid to be aligned to the YZ plane with the origin at (0,0,0).
remo.setGridSpacing(spacing)
Changes the spacing between the grid lines.
spacing: The spacing between the grid lines.
remo.addGridOffset(offset)
Offsets the grid in the direction of the grid normal.
offset: The offset distance.
remo.setGridOrigin(originX, originY, originZ)
Changes the grid origin, the grid will still be aligned as before but translated so that the grid origin
is at the new origin position.
originX, originY, originZ: The new origin position.
remo.setGridPointOnAxis(pointOnAxisX, pointOnAxisY, pointOnAxisZ)
Changes the grid point on axis, the grid will be rotated around the axis from the origin to the third
point so that the point on axis lies on one of the grid axes.
pointOnAxisX, pointOnAxisY, pointOnAxisZ: The new point on axis position.
remo.setGridThirdPoint(thirdPointX, thirdPointY, thirdPointZ)
Changes the grid third point, the grid will be rotated around the axis from the origin to the point on
axis so that the third point lies on the grid plane.
thirdPointX, thirdPointY, thirdPointZ: The new third point position.
remo.getGridOrigin()
Reports the grid origin.
returns: The grid origin as three values (x,y,z).
remo.getGridPointOnAxis()
Reports the grid point on axis.
returns: The grid point on axis as three values (x,y,z).
remo.getGridThirdPoint()
Reports the grid third point.
returns: The grid third point as three values (x,y,z).
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remo.alignGridToPolygon()
Aligns the grid to the currently selected polygon, if any.
returns: true if alignment was successful.

Color Palette Script Functions
This section describes script functions related to the color palette.

remo.setCurrentColorIndex(index)
Sets the current color index (excluding the intensity) for the current model.
(if indexed colors aren't used for this model, this will do nothing)
index: The new zero-based index (0 - 1023 or -1 if none).
remo.setCurrentColorIntensity(intensity)
Sets the current color intensity for the current model.
(if indexed colors aren't used for this model, this will do nothing)
intensity: The new intensity (0 - 127).
remo.getCurrentColorIndex()
Reports the current color index (excluding the intensity) for the current model.
returns: The current zero-based color index (0 – 1023 or -1 if none).
remo.getCurrentColorIntensity()
Reports the current color intensity for the current model.
returns: The current color intensity (0 - 127).
remo.setCurrentColorRGB(red, green, blue)
Sets the current RGB color (if RGB colors are used for this model) for the current model.
(if RGB colors aren't used for this model, this will do nothing)
red: The red value (0-255) for the new current RGB color.
green: The red value (0-255) for the new current RGB color.
blue: The red value (0-255) for the new current RGB color.
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remo.getCurrentColorRGB()
Reports the current RGB color (if RGB colors are used for this model) for the current model.
If RGB colors aren't used for this model, this will report a completely white (255,255,255) color.
returns: Three integers (0-255) corresponding to the red, green and blue values of the current
RGB color.
remo.openColorPalette(filename)
Opens a palette of colors from disk.
filename: The filename of the color palette on disk.
returns: true if the palette was opened correctly.
remo.saveColorPalette(filename)
Saves the current color palette to a file on disk.
filename: The filename of the saved palette.
returns: true if the palette was saved correctly.
remo.setPaletteColor(index, red, green, blue)
Sets the RGB values of a color in the color palette.
index: The zero-based index of the color to be modified (0 - 1023).
red: The red value (0 - 255) for the new palette RGB color.
green: The green value (0 - 255) for the new palette RGB color.
blue: The blue value (0 - 255) for the new palette RGB color.
returns: true if a color was changed.
remo.getPaletteColor(index)
Reports the RGB values of a color in the color palette.
index: The zero-based index of the color to be reported (0 - 1023).
returns: Three integers (0-255) corresponding to the red, green and blue values of the palette
color.
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Texture Palette Script Functions
This section describes script functions related to the texture palette.

remo.loadTexture(filename)
Loads a texture into the texture palette.
filename: The texture filename.
returns: The index of the new texture, -1 if loading failed.
remo.loadTextures(filename1, filename2, ...)
Loads a number of textures into the texture palette.
filenameX: The texture filename number X.
remo.replaceTexture(index, filename)
Replaces the texture at a specified index with a new texture with a given filename.
index: The zero-based palette index of the texture to be replaced.
filename: The filename of the new texture.
returns: true if replacing was successful, i.e. if the index was valid and a new texture was loaded.
remo.getMaxTextureIndex()
Reports the maximum texture index, useful e.g. when looping through the texture palette.
returns: The maximum texture index.
remo.getTextureIndex(filename)
Reports the palette index of a texture with a specified filename.
filename: The texture filename (exactly as it appears in the OpenFlight file).
returns: The index of the texture, -1 if not found.
remo.getTextureFilename(index)
Reports the filename of a texture with a specified palette index.
index: The zero-based palette index of the texture.
returns: The filename of the texture, empty string if not found.
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remo.getTextureSize(index)
Reports the width and height in pixels of a texture with a specified palette index.
index: The zero-based palette index of the texture.
returns: Two integers corresponding to the width and height of the texture; (-1, -1) if not found.
remo.setCurrentTextureIndex(index)
Sets the current texture index for the current model.
index: The new zero-based palette index (-1 if none).
remo.getCurrentTextureIndex()
Reports the current texture index for the current model.
returns: The current texture index (-1 if none).
remo.changeTextureIndex(oldIndex, newIndex)
Changes the palette index of a given texture.
oldIndex: The old zero-based palette index of the texture.
newIndex: The new zero-based palette index of the texture.
returns: true if the index change was successful.
remo.openTexturePalette(filename)
Opens a palette of textures from disk.
filename: The filename of the texture palette on disk.
returns: true if the palette was opened correctly.
remo.saveTexturePalette(filename)
Saves the current texture palette to a file on disk.
filename: The filename of the saved palette.
returns: true if the palette was saved correctly.
remo.removeTextureFromPalette(index)
Removes the texture at the specified index from the palette.
index: The zero-based palette index of the texture that is to be removed.
returns: true if a texture was removed.
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remo.removeUnusedTexturesFromPalette()
Removes all unused textures from the palette.
returns: true if any texture was removed.
remo.removeTexturePath(index)
Removes the path for the texture with a specified index.
index: The zero-based palette index of the texture.
returns: true if the path removal was successful.
remo.removeAllTexturePaths()
Removes the paths for all textures in the palette.
remo.changeAllTexturePaths(path)
Changes the path for all textures in the palette.
path: The new path (except the filename).
remo.makeTexturePathsRelative()
Update all texture paths in the texture palette to be relative to the current model file path.
remo.makeTexturePathsAbsolute()
Update all texture paths in the texture palette to be absolute, by appending the model file path to
the relative paths.
remo.applyTextureAttributes(index, name1, attribute1, name2, attribute2, ...)
(remo.setTextureAttributes is an alias that works exactly in the same way)
Applies a number of texture attributes to the texture with the selected index and saves the
corresponding attribute file.
index: The zero-based palette index of the texture for which attributes are to be applied.
nameX: The name of the texture attribute number X as a string, as it appears in the corresponding
label in the texture attribute dialog (case-insensitive). More information about the rules of attribute
label names can be found at the asterisk (*) in the Attribute Script Functions section.
attributeX: The value of the texture attribute number X that is to be applied, can be of different
types (string, boolean or number) depending on the texture attribute.
returns: true if any texture attribute was applied.
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remo.getTextureAttributes(index, name1, name2, ...)
Reports the values of a number of given texture attributes for the texture with a specified index.
index: The zero-based palette index of the texture from which attributes are to be retrieved.
nameX: The name of the texture attribute number X as a string, as it appears in the corresponding
label in the texture attribute dialog (case-insensitive). More information about the rules of attribute
label names can be found at the asterisk (*) in the Attribute Script Functions section.
returns: A number of values corresponding to the given texture attribute names, in the same
order. The values can be of different types (string, boolean or number) depending on the texture
attribute. If a value is undefined, it’s set to nil.

Material Palette Script Functions
This section describes script functions related to the material palette.

remo.newMaterial()
Creates a new material in the palette.
returns: The palette index of the new material.
remo.getMaxMaterialIndex()
Reports the maximum material index, useful e.g. when looping through the material palette.
returns: The maximum material index.
remo.setCurrentMaterialIndex(index)
Sets the current material index for the current model.
index: The new zero-based index (-1 if none).
remo.getCurrentMaterialIndex()
Reports the current material index for the current model.
returns: The current material index (-1 if none).
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remo.changeMaterialIndex(oldIndex, newIndex)
Changes the palette index of a given material.
oldIndex: The old zero-based index of the material.
newIndex: The new zero-based index of the material.
returns: true if the index change was successful.
remo.openMaterialPalette(filename)
Opens a palette of materials from disk.
filename: The filename of the material palette on disk.
returns: true if the palette was opened correctly.
remo.saveMaterialPalette(filename)
Saves the current material palette to a file on disk.
filename: The filename of the saved palette.
returns: true if the palette was saved correctly.
remo.removeMaterialFromPalette(index)
Removes the material at the specified index from the palette.
index: The zero-based index of the material that is to be removed.
returns: true if a material was removed.
remo.removeUnusedMaterialsFromPalette()
Removes all unused materials from the palette.
returns: true if any material was removed.
remo.setMaterialAmbient(index, red, green, blue)
Sets the ambient color of the material with the given index.
index: The zero-based index of the material.
red: The red component (0 - 255).
green: The green component (0 - 255).
blue: The blue component (0 - 255).
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remo.getMaterialAmbient(index)
Reports the ambient color of the material with the given index.
index: The zero-based index of the material.
returns: Three integers (0 - 255) corresponding to the red, green and blue values of the requested
color.
remo.setMaterialDiffuse(index, red, green, blue)
Sets the diffuse color of the material with the given index.
index: The zero-based index of the material.
red: The red component (0 - 255).
green: The green component (0 - 255).
blue: The blue component (0 - 255).
remo.getMaterialDiffuse(index)
Reports the diffuse color of the material with the given index.
index: The zero-based index of the material.
returns: Three integers (0 - 255) corresponding to the red, green and blue values of the requested
color.
remo.setMaterialSpecular(index, red, green, blue)
Sets the specular color of the material with the given index.
index: The zero-based index of the material.
red: The red component (0 - 255).
green: The green component (0 - 255).
blue: The blue component (0 - 255).
remo.getMaterialDiffuse(index)
Reports the specular color of the material with the given index.
index: The zero-based index of the material.
returns: Three integers (0 - 255) corresponding to the red, green and blue values of the requested
color.
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remo.setMaterialEmissive(index, red, green, blue)
Sets the emissive color of the material with the given index.
index: The zero-based index of the material.
red: The red component (0 - 255).
green: The green component (0 - 255).
blue: The blue component (0 - 255).
remo.getMaterialEmissive(index)
Reports the emissive color of the material with the given index.
index: The zero-based index of the material.
returns: Three integers (0 - 255) corresponding to the red, green and blue values of the requested
color.
remo.setMaterialShininess(index, shininess)
Sets the shininess of the material with the given index.
index: The zero-based index of the material.
shininess: The shininess as a number (0.0 - 128.0).
remo.getMaterialShininess(index)
Reports the shininess of the material with the given index.
index: The zero-based index of the material.
returns: The shininess as a number (0.0 - 128.0).
remo.setMaterialAlpha(index, alpha)
Sets the alpha of the material with the given index.
index: The zero-based index of the material.
alpha: The alpha as a number (0.0 - 1.0).
remo.getMaterialAlpha(index)
Reports the alpha of the material with the given index.
index: The zero-based index of the material.
returns: The alpha as a number (0.0 – 1.0).
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Texture Mapping Palette Script Functions
This section describes script functions related to the texture mapping palette.

remo.getMaxTextureMappingIndex()
Reports the maximum texture mapping index, useful e.g. when looping through the texture
mapping palette.
returns: The maximum texture mapping index.
remo.setCurrentTextureMappingIndex(index)
Sets the current texture mapping index for the current model.
index: The new zero-based index (-1 if none).
remo.getCurrentTextureMappingIndex()
Reports the current texture mapping index for the current model.
returns: The current texture mapping index (-1 if none).
remo.changeTextureMappingIndex(oldIndex, newIndex)
Changes the palette index of a given texture mapping.
oldIndex: The old zero-based index of the texture mapping.
newIndex: The new zero-based index of the texture mapping.
returns: true if the index change was successful.
remo.openTextureMappingPalette(filename)
Opens a palette of texture mappings from disk.
filename: The filename of the texture mapping palette on disk.
returns: true if the palette was opened correctly.
remo.saveTextureMappingPalette(filename)
Saves the current texture mapping palette to a file on disk.
filename: The filename of the saved palette.
returns: true if the palette was saved correctly.
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remo.removeTextureMappingFromPalette(index)
Removes the texture mapping at the specified index from the palette.
index: The zero-based index of the texture mapping that is to be removed.
returns: true if a texture mapping was removed.
remo.removeUnusedTextureMappingsFromPalette()
Removes all unused texture mappings from the palette.
returns: true if any texture mapping was removed.
remo.setTextureMappingName(index, name)
Sets the name of the texture mapping at the specified index.
index: The zero-based palette index of the texture mapping to be renamed.
name: The new name of the texture mapping.
remo.getTextureMappingName(index)
Reports the name of the texture mapping with the specified index.
index: The zero-based palette index of the texture mapping.
returns: The texture mapping name as a string.
remo.setTextureMappingUV(index, number, u,v)
Sets the texture coordinate of a given point in the texture mapping at the specified index.
index: The zero-based palette index of the texture mapping.
number: The point number (1-4).
u,v: The texture coordinate corresponding to the numbered point.
remo.getTextureMappingUV(index, number)
Reports the texture coordinate corresponding to a given point in the texture mapping with the
given index.
index: The zero-based palette index of the texture mapping.
number: The point number (1-4).
returns: The requested texture coordinate as two numbers (u, v).
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remo.setTextureMappingRepetitions(index, repetitions)
Sets the number of repetitions of the texture mapping at the specified index; only valid for
cylindrical and spherical mappings.
index: The zero-based palette index of the texture mapping for which the number of repetitions is
to be set.
repetitions: The new number of repetitions.
remo.getTextureMappingRepetitions(index)
Reports the number of repetitions for the texture mapping with the specified index.
returns: The number of repetitions as a number (0.0 if inapplicable).
remo.getTextureMappingType(index)
Reports the type of the texture mapping at the specified index.
index: The zero-based palette index of the texture mapping.
returns: The texture mapping type as a string (empty if invalid), one of the following:
"THREEPOINT"
"FOURPOINT"
"CYLINDRICAL"
"SPHERICAL"

Light Point Palette Script Functions
This section describes script functions related to the light point palette.

remo.setCurrentLightPointAppearanceIndex(index)
Sets the current light point appearance index for the current model.
index: The new zero-based index (-1 if none).
remo.setCurrentLightPointAnimationIndex(index)
Sets the current light point animation index for the current model.
index: The new zero-based index (-1 if none).
remo.getCurrentLightPointAppearanceIndex()
Reports the current light point appearance index for the current model.
returns: The current light point appearance index (zero-based, -1 if none).
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remo.getCurrentLightPointAnimationIndex()
Reports the current light point animation index for the current model.
returns: The current light point animation index (zero-based, -1 if none).
remo.changeLightPointAppearanceIndex(oldIndex, newIndex)
Changes the palette index of a given light point appearance.
oldIndex: The old zero-based index of the light point appearance.
newIndex: The new zero-based index of the light point appearance.
returns: true if the index change was successful.
remo.changeLightPointAnimationIndex(oldIndex, newIndex)
Changes the palette index of a given light point animation.
oldIndex: The old zero-based index of the light point animation.
newIndex: The new zero-based index of the light point animation.
returns: true if the index change was successful.
remo.openLightPointPalette(filename)
Opens a palette of light points from disk.
filename: The filename of the light point palette on disk.
returns: true if the palette was opened correctly.
remo.saveLightPointPalette(filename)
Saves the current light point palette to a file on disk.
filename: The filename of the saved palette.
returns: true if the palette was saved correctly.
remo.newLightPointAppearance()
Creates a new light point appearance in the palette.
returns: The palette index of the new light point appearance.
remo.newLightPointAnimation()
Creates a new light point animation in the palette.
returns: The palette index of the new light point animation.
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remo.getMaxLightPointAppearanceIndex()
Reports the maximum light point appearance index, useful e.g. when looping through the light
point palette.
returns: The maximum light point appearance index.
remo.getMaxLightPointAnimationIndex()
Reports the maximum light point animation index, useful e.g. when looping through the light point
palette.
returns: The maximum light point animation index.
remo.removeLightPointAppearanceFromPalette(index)
Removes the light point appearance at the specified index from the palette.
index: The zero-based index of the light point appearance that is to be removed.
returns: true if a light point appearance was removed.
remo.removeLightPointAnimationFromPalette(index)
Removes the light point animation at the specified index from the palette.
index: The zero-based index of the light point animation that is to be removed.
returns: true if a light point animation was removed.
remo.removeUnusedLightPointAppearancesFromPalette()
Removes all unused light point appearances from the palette.
returns: true if any light point appearance was removed.
remo.removeUnusedLightPointAnimationFromPalette()
Removes all unused light point animations from the palette.
returns: true if any light point animation was removed.
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remo.applyLightPointAppearanceAttributes(index, name1, attribute1, name2,
attribute2, ...)
(remo.setLightPointAppearanceAttributes is an alias that works exactly in the same
way)
Applies a number of attributes to the light point appearance with the selected index.
index: The zero-based palette index of the light point appearance for which attributes are to be
applied.
nameX: The name of the attribute number X as a string, as it appears in the corresponding label in
the light point palette dialog (case-insensitive). See below for more information. (*)
attributeX: The value of the attribute number X that is to be applied, can be of different types
(string, boolean or number) depending on the attribute.
returns: true if any attribute was applied.
remo.applyLightPointAnimationAttributes(index, name1, attribute1, name2,
attribute2, ...)
(remo.setLightPointAnimationAttributes is an alias that works exactly in the same
way)
Applies a number of attributes to the light point animation with the selected index.
index: The zero-based palette index of the light point animation for which attributes are to be
applied.
nameX: The name of the attribute number X as a string, as it appears in the corresponding label in
the light point palette dialog (case-insensitive). See below for more information. (*)
attributeX: The value of the attribute number X that is to be applied, can be of different types
(string, boolean or number) depending on the attribute.
returns: true if any attribute was applied.
remo.getLightPointAppearanceAttributes(index, name1, name2, ...)
Reports the values of a number of given attributes for the light point appearance with a specified
index.
index: The zero-based palette index of the light point appearance from which attributes are to be
retrieved.
nameX: The name of the attribute number X as a string, as it appears in the corresponding label in
the light point palette attribute dialog (case-insensitive). See below for more information. (*)
returns: A number of values corresponding to the given attribute names, in the same order. The
values can be of different types (string, boolean or number) depending on the attribute. If a value
is undefined, it’s set to nil.
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remo.getLightPointAnimationAttributes(index, name1, name2, ...)
Reports the values of a number of given attributes for the light point animation with a specified
index.
index: The zero-based palette index of the light point animation from which attributes are to be
retrieved.
nameX: The name of the attribute number X as a string, as it appears in the corresponding label in
the light point palette attribute dialog (case-insensitive). See below for more information. (*)
returns: A number of values corresponding to the given attribute names, in the same order. The
values can be of different types (string, boolean or number) depending on the attribute. If a value
is undefined, it’s set to nil.
remo.addLightPointSequenceState(index)
Adds a new sequence state to the end of the sequence states list in the light point animation with
the given index.
index: The zero-based index of the light point animation.
returns: The zero-based sequence index of the added sequence state, -1 if nothing was added.
remo.removeLightPointSequenceState(index, sequenceIndex)
Removes a sequence state with a given index from the light point animation with the given index.
sequenceIndex: The zero-based sequence index of the light point animation.
index: The zero-based index of the light point animation.
returns: true if a sequence state was removed.
remo.getNumLightPointSequenceStates(index)
Reports the number of sequence states in the light point animation with the given index.
index: The zero-based index of the light point animation.
returns: The number of sequence states, 0 if none or inapplicable.

(*)The labels given to apply/setLightPointAppearance/AnimationAttributes and
getLightPointAppearance/AnimationAttributes should, as described above, be given as
they appear in the corresponding label in the light point palette dialog. However, there
are some special cases:
Attributes placed in groups in the light point palette dialog will get the group name as
prefix, e.g. "Back Color Index".
Attributes representing the check box in the top right corner of a group, used for
enabling or disabling the complete group (e.g. Back Color) will get an "Enabled" suffix,
e.g. "Back Color Enabled".
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Additional information within parentheses or brackets at the end of a label will be
excluded.
To specify the sequence state index of a sequence-specific attribute for a light point
animation (i.e. State, Duration, Color Change Index or Color Change Intensity), a
case-insensitive "(sequence X)" suffix has to be added to the attribute label name,
where X is the zero-based sequence index. An example is "State (sequence 2)".

Shader Palette Script Functions
This section describes script functions related to the shader palette.

remo.setCurrentShaderIndex(index)
Sets the current shader index for the current model.
index: The new zero-based index (-1 if none).
remo.getCurrentShaderIndex()
Reports the current shader index for the current model.
returns: The current shader index (-1 if none).
remo.changeShaderIndex(oldIndex, newIndex)
Changes the palette index of a given shader.
oldIndex: The old zero-based index of the shader.
newIndex: The new zero-based index of the shader.
returns: true if the index change was successful.
remo.setShaderName(index, name)
Sets the name of a given shader.
index: The zero-based index of the shader.
name: The new name of the shader as a string.
returns: true if the name change was successful.
remo.getShaderName(index)
Reports the name of a given shader.
index: The zero-based index of the shader.
returns: The name of the shader as a string.
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remo.openShaderPalette(filename)
Opens a palette of shaders from disk.
filename: The filename of the shader palette on disk.
returns: true if the palette was opened correctly.
remo.saveShaderPalette(filename)
Saves the current shader palette to a file on disk.
filename: The filename of the saved palette.
returns: true if the palette was saved correctly.
remo.newShader(name)
Creates a new shader in the palette.
name: The name of the new shader.
returns: The palette index of the new shader.
remo.getMaxShaderIndex()
Reports the maximum shader index, useful e.g. when looping through the shader palette.
returns: The maximum shader index.
remo.removeShaderFromPalette(index)
Removes the shader at the specified index from the palette.
index: The zero-based palette index of the shader that is to be removed.
returns: true if a shader was removed.
remo.removeUnusedShadersFromPalette()
Removes all unused shaders from the palette.
returns: true if any shader was removed.
remo.setShaderType(index, type)
Sets the type of a given shader.
index: The zero-based palette index of the shader to set the shader type for.
type: A case-insensitive string with the type of the shader, can be either "GLSL" or "Cg".
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remo.getShaderType(index)
Reports the type of a given shader.
index: The zero-based palette index of the shader to get the shader type for.
returns: The shader type as a string, either "GLSL" or "Cg".
remo.addOpenGLShaderVertexProgram(index, filename)
Adds an OpenGL shader vertex program to a shader with a specified index.
index: The zero-based palette index of the shader to add the vertex program to.
filename: The filename of the vertex program.
remo.getOpenGLShaderVertexPrograms(index)
Reports the OpenGL shader vertex programs of a shader with a specified index.
index: The zero-based palette index of the shader to get the vertex programs from.
returns: A table containing filenames of the vertex programs.
remo.removeOpenGLShaderVertexProgram(index, vertexProgramIndex)
Removes an OpenGL shader vertex program from a shader with a specified index.
index: The zero-based palette index of the shader to remove the vertex program from.
vertexProgramIndex: The zero-based index of the vertex program to remove.
remo.addOpenGLShaderFragmentProgram(index, filename)
Adds an OpenGL shader fragment program to a shader with a specified index.
index: The zero-based palette index of the shader to add the fragment program to.
filename: The filename of the fragment program.
remo.getOpenGLShaderFragmentPrograms(index)
Reports the OpenGL shader fragment programs of a shader with a specified index.
index: The zero-based palette index of the shader to get the fragment programs from.
returns: A table containing filenames of the fragment programs.
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remo.removeOpenGLShaderFragmentProgram(index, fragmentProgramIndex)
Removes an OpenGL shader fragment program from the shader with index.
index: The zero-based palette index of the shader to remove the fragment program from.
fragmentProgramIndex: The zero-based index of the fragment program to remove.
remo.setCgShaderVertexProgram(index, filename)
Sets the Cg shader vertex program for a shader with a specified index.
index: The zero-based palette index of the shader to set the vertex program for.
filename: The filename of the vertex program.
remo.getCgShaderVertexProgram(index)
Reports the Cg shader vertex program for a shader with a specified index.
index: The zero-based palette index of the shader to get the vertex program from.
returns: The filename of the vertex program.
remo.setCgShaderFragmentProgram(index, filename)
Sets the Cg shader fragment program for a shader with a specified index.
index: The zero-based palette index of the shader to set the fragment program for.
filename: The filename of the fragment program.
remo.getCgShaderFragmentProgram(index)
Reports the Cg shader fragment program for a shader with a specified index.
index: The zero-based palette index of the shader to get the fragment program from.
returns: The filename of the fragment program.
remo.setCgShaderVertexProgramProfile(index, profile)
Sets the Cg shader vertex program profile for a shader with a specified index.
index: The zero-based palette index of the shader to set the vertex program profile for.
profile: The profile of the vertex program as an integer.
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remo.getCgShaderVertexProgramProfile(index)
Reports the Cg shader vertex program profile for a shader with a specified index.
index: The zero-based palette index of the shader to get the vertex program profile from.
returns: The profile of the vertex program as an integer.
remo.setCgShaderFragmentProgramProfile(index, profile)
Sets the Cg shader fragment program profile for a shader with a specified index.
index: The zero-based palette index of the shader to set the fragment program profile for.
profile: The profile of the fragment program as an integer.
remo.getCgShaderFragmentProgramProfile(index)
Reports the Cg shader fragment program profile for a shader with a specified index.
index: The zero-based palette index of the shader to get the fragment program profile from.
returns: The profile of the fragment program as an integer.
remo.setCgShaderVertexProgramEntryPoint(index, entryPoint)
Sets the Cg shader vertex program entry point for a shader with a specified index.
index: The zero-based palette index of the shader to set the vertex program entry point for.
entryPoint: The entry point of the vertex program as a string.
remo.getCgShaderVertexProgramEntryPoint(index, entryPoint)
Reports the Cg shader vertex program entry point for a shader with a specified index.
index: The zero-based palette index of the shader to get the vertex program entry point from.
returns: The entry point of the vertex program as a string.
remo.setCgShaderFragmentProgramEntryPoint(index, entryPoint)
Sets the Cg shader fragment program entry point for a shader with a specified index.
index: The zero-based palette index of the shader to set the fragment program entry point for.
entryPoint: The entry point of the fragment program as a string.
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remo.getCgShaderFragmentProgramEntryPoint(index, entryPoint)
Reports the Cg shader fragment program entry point for a shader with a specified index.
index: The zero-based palette index of the shader to get the fragment program entry point from.
returns: The entry point of the fragment program as a string.
remo.removeShaderPaths(index)
Removes the paths for a given shader, leaving only the shader source file names.
index: The zero-based index of the shader.
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Macros
In order to make a script more user-friendly and appear more or less as a regular Remo
3D tool, it can be wrapped in a macro. A macro will appear in the Macros sub-menu
under the Script menu.

If a macro takes parameters, they will appear in the tool area to the right together with
an Execute button, like a regular tool. If no parameters are defined, the tool will be
executed immediately.

Macro Editor
A macro is defined as a name, a script (described in the Scripts chapter) and a number of
parameters of different types. Macros are handled in the Macro Editor available from the
Script menu. From here you can add a new macro, remove an existing macro, import or
export macros and edit the name, script file name and parameters of an existing macro.
Macros can be moved up and down and also be sorted alphabetically.

Macro parameters are completely optional; a macro doesn’t have to take any
parameters. A parameter is defined by a name and a type (String, Boolean, Number, File
or Folder) and is essentially just a variable definition into the script that will be executed.
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So if you define a number parameter named x in your macro and set it to 19 when
executing the macro, it’s the same writing x = 19 in your script.
A file or folder parameter can be specified manually in the parameter text box before
activating the macro, or with a browse (...) button next to it.
Note that parameters are preferably named as variable names, for a natural integration
with the script using them. They will be modified when presented in the user interface,
with capital initial letter and space before any following capital letters. So a parameter
named leftImage will e.g. be presented as "Left Image".

Macro Samples
Remo 3D is delivered with a number of macro samples. Try to import them from the
Macro Editor and you will discover that they are not only useful as samples, they also
really extend the functionality of Remo 3D in a simple but efficient way. Each macro has
its own configuration file that you can import, or you can choose to import all at once
with the all.cfg file. It's however recommended to import only the macros you need for
the moment, to avoid filling up the Macros menu in Remo 3D. The samples/macros
folder contains the following sample macros:

box.lua
Remo 3D script for creating a box, exposed in Remo 3D as a macro with the box.cfg file.
Parameters:
Size: Side length
Shaded: True if shaded
cone.lua
Remo 3D script for creating a cone, exposed in Remo 3D as a macro with the cone.cfg file.
Parameters:
Radius: Radius of base disk
Height: Height of the cone
Segments: Number of segments of base disk
Shaded: True if shaded
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createBlueprintBox.lua
Remo 3D script for creating temporary geometry with given blueprints as base for modeling,
exposed Remo 3D as a macro with the createBlueprintBox.cfg file.
Parameters:
Cross: True if cross-type, false if box-type
Length: Model length (Y direction)
Width: Model width (X direction)
Height: Model height (Z direction)
FrontImage: File name of front blueprint image
RearImage: File name of rear blueprint image
LeftImage: File name of left blueprint image
RightImage: File name of right blueprint image
TopImage: File name of top blueprint image
BottomImage: File name of bottom blueprint image
NOTE: If rear image is not given, the front image will be used for the front. The same applies to
the left and right images, as well as the top and bottom images.
cylinder.lua
Remo 3D script for creating a cylinder, exposed in Remo 3D as a macro with the cylinder.cfg file.
Parameters:
Radius: Radius of base disk
Height: Height of the cylinder
Segments: Number of segments of base disk
Shaded: True if shaded
eliminateDoubleVertices.lua
Remo 3D script for removing all consecutive vertices with identical coordinates in all polygons in
the selected geometry (or if none selected, in the complete model), exposed in Remo 3D as a
macro with the eliminateDoubleVertices.cfg file.
pyramid.lua
Remo 3D script for creating a pyramid, exposed in Remo 3D as a macro with the pyramid.cfg file.
Parameters:
Base: Side Length of base square
Height: Height of the pyramid
Shaded: True if shaded
selectConcavePolygons.lua
Remo 3D script for selecting all concave polygons beneath the currently selected node (or if none
selected, in the complete model), exposed in Remo 3D as a macro with the
selectConcavePolygons.cfg file.
selectEmptyPolygons.lua
Remo 3D script for selecting all polygons without vertices beneath the currently selected node (or
if none selected, in the complete model), exposed in Remo 3D as a macro with the
selectEmptyPolygons.cfg file.

164

Remo 3D™ v2.10 User’s Guide

selectNonPlanarPolygons.lua
Remo 3D script for selecting all non-planar polygons beneath the currently selected node (or if
none selected, in the complete model), exposed in Remo 3D as a macro with the
selectNonPlanarPolygons.cfg file.
Parameters:
Tolerance: Tolerance used when measuring distance from plane to vertex.

Sharing Macros
Since macros can be imported and exported in the Macro Editor, they are easy to share
between users.
The Export button in the Macro Editor will export all macros currently in the dialog, no
matter if they have been saved or not (they are not saved until the OK button has been
clicked). A new macro configuration file is specified and the corresponding Lua script files
will also be copied to the same destination folder.
The Import button in the Macro Editor will import the macros in the specified macro
configuration file, so that they are added to the existing macros currently in the dialog.
Nothing is saved until you click the OK button.
Macros are saved in your personal macro configuration file, macro.cfg.
In Microsoft® Windows® 10/8/7, the macro configuration file is found here:
<WINDRIVE>\Users\<USER>\AppData\Roaming\Remo3D\macro.cfg
where <WINDRIVE> is the Microsoft® Windows® installation drive, e.g. C: and <USER> is
your user name.
In Linux, the macro configuration file is found here:
<HOME>/.remo3d/macro.cfg
where <HOME> is your home directory.
However, since import and export of macros are trivial as described above, it’s normally
not necessary to handle the macro configuration file itself.

165

Remo 3D™ v2.10 User’s Guide

Troubleshooting
This section lists a number of troubles and their solutions.
Remo 3D crashes without explanation, e.g. when loading a texture into the
texture palette.
Check that the PATH environment variable is not set to a path where OpenSceneGraph
DLLs with a version other than the OpenSceneGraph DLLs installed with Remo 3D are
located.
Remo 3D crashes at start-up or at tool execution, or doesn’t show the model
view of a loaded file.
Try removing the Remo 3D configuration file.
In Microsoft® Windows® 10/8/7, the configuration file is found here:
<WINDRIVE>\Users\<USER>\AppData\Roaming\Remo3D\remo3d.cfg
where <WINDRIVE> is the Microsoft® Windows® installation drive, e.g. C: and <USER> is your
user name.
In Linux, the configuration file is found here:
<HOME>/.remo3d/remo3d.cfg
where <HOME> is your home directory.
A tool introduces inaccuracy in vertex positions.
This problem will be addressed in future versions of Remo 3D, but until then the Quantify
tool can be used to fix these inaccuracies.
A shortcut doesn’t work.
A text box in e.g. an active tool can be focused and stops the shortcut from working. Try
changing the focus by closing the tool or pressing TAB until no text box is focused.
Remo 3D crashes at loading of a model with materials.
Try installing the latest version of your graphics driver.
Remo 3D hangs under Linux, possibly with X warning messages.
Try setting the environment variable REMO3D_ENABLE_X_THREADING to 1.
Remo 3D hangs for about 5 seconds directly after it has been started.
An old 3Dconnexion Space Navigator™ driver may be installed, without any 3Dconnexion
device connected. Try connecting the device or install the newest 3Dconnexion driver.
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Cached search results and bookmarks in the Remo 3D help system don’t work.
You have probably installed a new version of Remo 3D and the cache needs to be
removed. Remove the config.ini, org.* and .metadata files in the Remo 3D user folder.
In Microsoft® Windows® 10/8/7, the Remo 3D user folder is found here:
<WINDRIVE>\Users\<USER>\AppData\Roaming\Remo3D\
where <WINDRIVE> is the Microsoft® Windows® installation drive, e.g. C: and <USER> is your
user name.
In Linux, the Remo 3D user folder is found here:
<HOME>/.remo3d/
where <HOME> is your home directory.
The Remo 3D built-in help system won't start when choosing Help... from the
Help menu.
The installed Java Runtime Environment is probably 32-bit only, even if you're on a 64-bit
operating system. Try installing the 64-bit version from
http://www.java.com/en/download/manual.jsp.
Remo 3D for Linux won't load images with a certain file format, or the program
terminates with a warning about missing dependencies for a certain image
format, e.g. GIF, JPG, PNG or TIF.
Install the proper libraries, e.g. by doing the following in Ubuntu for the JPG image format
(refer to other Linux documentation for other distributions and image formats):
sudo apt-get install libjpeg62
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Technical Specifications
In this section you will find various technical specifications for Remo 3D™ v2.10.

OpenFlight® File Format
The OpenFlight® versions supported by Remo 3D v2.10 are 15.7, 15.8, 16.0, 16.1 and
16.2. There are however some exceptions from this support; these are listed below:
Note: This means that the user doesn’t have full control of these features in Remo 3D.
However, when loading or saving an existing OpenFlight® file containing these features,
they will not be removed or modified. Many of these features may be implemented in
future versions of Remo 3D. Some of non-supported node types can still be cut, copied,
pasted, deleted, dragged and dropped, but their attributes can’t be modified.
15.7:
Mesh Nodes
Morph Vertex Lists
BSP Planes
Sound
Roads
Clip Regions
Text
CAT
Extension Nodes
Curves
Vectors
Bounding Volumes
Name Tables
Eyepoint/Trackplane
Linkage Palette
Light Source Palette
Line Style Palette
Continuation Records
Relative priority
Geo-specific control points (in texture attributes)
Sub-textures (in texture attributes)
15.8:
Indexed String
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Texture File Formats
The following texture file formats are supported by Remo 3D™ v2.10:
SGI® image file format (.rgb, .rgba, .int, .inta)
Microsoft® Windows® bitmap (.bmp)
Direct Draw Surface (.dds)
Graphics Interchange Format (.gif)
Joint Photographic Experts Group (.jpg)
Portable Network Graphics (.png)
Portable any map (.pnm, .ppm, .pgm, .pbm)
Targa (.tga)
Tagged Image File Format (.tif)

Import File Formats
The following import file formats are supported by Remo 3D™ v2.10:
3DC Point Cloud (.3dc)
3D Studio MAX® (.3ds)
AC3D™ (.ac)
COLLADA™ 1.4.1 (.dae)
Autodesk® FBX® (.fbx)
Autodesk® DXF (.dxf)
Note: After importing a DXF file, some of the polygons may have to be reversed by
using the Reverse Polygon tool, since the direction (clockwise or counter-clockwise) of
polygons is not uniquely defined in the DXF file format.
LightWave® (.lwo / .lws)
Quake Character Models (.md2)
Alias® Wavefront OBJ (.obj)
OpenSceneGraph 3.6.4 Deprecated ASCII (.osg)
OpenSceneGraph 3.6.4 Deprecated Binary (.ive)
OpenSceneGraph 3.6.4 Archive (.osga)
OpenSceneGraph 3.6.4 Binary (.osgb)
OpenSceneGraph 3.6.4 Text (.osgt)
OpenSceneGraph 3.6.4 XML (.osgx)
VBS2 P3D (.p3d)
Note: Textures are generally referenced with absolute paths to where a P3D model
was located in the VBS2 system. This may require the use of “Change All Paths” in
the texture palette after importing a P3D file.
Stanford Triangle Format (.ply)
StereoLithography Binary (.stl)
StereoLithography ASCII (.sta)
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ESRI Shape (.shp)
Note: Attributes will be imported as polygon comments, one line of text per attribute,
according to the format <Name>=<Value>, e.g. Perimeter=65.
Direct X (.x)
When importing files into Remo 3D, embedded textures and shaders, as well as
externally referenced files, can be converted and written to disk.
Remo 3D uses OpenSceneGraph plugins for importing different file formats. These
plugins can be controlled with a number of settings specified as an option string. This
string can be set using the REMO3D_IMPORT_EXPORT_OPTIONS environment variable.

Export File Formats
The following export file formats are supported by Remo 3D™ v2.10:
3D Studio MAX® (.3ds)
AC3D™ (.ac)
COLLADA™ 1.4.1 (.dae)
DOT (.dot)
Autodesk® FBX® (.fbx)
Alias® Wavefront OBJ (.obj)
OpenSceneGraph 3.6.4 Deprecated ASCII (.osg)
OpenSceneGraph 3.6.4 Deprecated Binary (.ive)
OpenSceneGraph 3.6.4 Binary (.osgb)
OpenSceneGraph 3.6.4 Text (.osgt)
OpenSceneGraph 3.6.4 XML (.osgx)
StereoLithography Binary (.stl)
VBS2 P3D (.p3d)
Note: When exporting a P3D file, textures are automatically converted to the TGA file
format and put in a data sub-folder which is created in the same location as the
exported file. Material RVMAT files are also written to the same data sub-folder. In
the P3D file, the textures and materials are referenced locally to the data sub-folder,
e.g. “data\texture.tga”. Generally, it will be necessary to change the texture and
material paths to absolute paths according to the folder where the model is located in
the target VBS2 system. The paths can be changed in the Oxygen 2 tool available in
the VBS2 Development Suite.
Remo 3D uses OpenSceneGraph plugins for exporting different file formats. These
plugins can be controlled with a number of settings specified as an option string. This
string can be set using the REMO3D_IMPORT_EXPORT_OPTIONS environment variable.

Environment Variables
Remo 3D supports a number of environment variables that allows the user to control
certain parts of the tool.

Setting an Environment Variable
An environment variable <name> can be set to a <value> by doing the following:
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Linux, tcsh:
setenv <name> <value>
Linux, bash:
export <name>=<value>
Microsoft® Windows®:
Start -> Settings -> Control Panel -> System -> Advanced ->
Environment Variables -> New
Enter <name> as variable name and <value> as the variable value.

Environment Variable Names
The environment variables used by Remo 3D™ v2.10 are:
REMO3D_FILE_PATH
File path used for loading textures, external references and shaders, multiple paths can
be specified separated with semi-colons (;).
REMO3D_IMPORT_EXPORT_OPTIONS
Options string to the OpenSceneGraph plugins used for import and export.
REMO3D_LICENSE_FILE
Path to the license file.
REMO3D_LICENSE_SERVER
The license server address to connect to.
REMO3D_LICENSE_SERVER_PORT
The license server port to connect to.
REMO3D_LICENSE_SERVER_FILE
Path to the license server file.
REMO3D_ENABLE_X_THREADING
Can be set to avoid threading issues in Linux.
REMO3D_SCRIPT_CONFIRMATION
Can be set to OFF to avoid having to press a key for the script to terminate in Microsoft®
Windows®.
REMO3D_NO_LINE_FEED
Can be set to ON to avoid automatic line feed after each print call in a script.
REMO3D_LOG
Path to a log file where all output can be directed form a script. When REMO3D_LOG is
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defined, no console window will open while running a command-line script in Microsoft®
Windows®.
REMO3D_SPACENAV_DEVICE
Path to the Space Navigator™ device in Linux.

System Configuration
Minimal system configuration for Remo 3D™ v2.10:
Microsoft® Windows® 10/8/7 64-bit or Linux 64-bit operating system
Hardware accelerated 3D graphics card
Minimum 1366x768 screen resolution
Mouse with three buttons or wheel button
Java™ Runtime Environment 64-bit (at least Java 6 / JRE 1.6 recommended for help
system)
Recommended system configuration for Remo 3D™ v2.10:
Microsoft® Windows® 10 64-bit or Linux 64-bit operating system
Intel® i5 or i7 processor
16 GB RAM
NVIDIA® hardware accelerated 3D graphics card
Minimum 1920x1080 screen resolution
Mouse with three buttons or wheel button
Java™ Runtime Environment 64-bit (at least Java 6 / JRE 1.6 recommended for help
system)
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Development Tools
Remo 3D™ was developed using the following excellent tools and libraries:

OpenSceneGraph

www.openscenegraph.org

OpenGL

www.opengl.org

FLTK

www.fltk.org

Lua

www.lua.org

173

Remo 3D™ v2.10 User’s Guide

Index
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—B—

3D Studio MAX ....................... 169, 170
3DC Point Cloud .............................169
3Dconnexion ....................................22

Back (Along Y) .................................97
Back Color ................................. 60, 85
Back Intensity ............................ 60, 85
Background .....................................99
base layer .......................................27
Below Grid.......................................97
BICUBIC ..........................................78
BILINEAR ........................................78
Billboard/Alpha.................................58
BLEND ............................................78
BMP ................................................76
Bottom (Along Z) .............................96
Built-in Help System .......................104

—A—
Abbreviations ...................................11
About Remo 3D ................................30
Above Grid ......................................97
AC3D .................................... 169, 170
Actual Size ................................ 62, 86
administrative privileges....................14
Alias ..................................... 169, 170
Align To Polygon (Face) .....................98
Align To Vertices ..............................98
Align To XY ......................................97
Align To XZ ......................................97
Align To YZ ......................................98
alpha ..............................................83
Always On Top .................................98
Always Save To Latest Version ...........96
ambient .................................. 83, 100
Ambient Intensity ....................... 61, 85
Animation Index ...............................62
animation preview ............................93
Animation State ...............................63
Animation Type ................................87
Appearance .....................................97
Appearance Index.............................62
Apply Attributes ...............................54
Apply Color ......................................41
Apply Comment................................69
Apply Material ..................................42
Apply Matrix .........................36, 37, 38
Apply Shader ...................................43
Apply Texture ..................................42
Apply Texture Mapping......................42
Apply Transformation Matrix ..............39
arguments .....................................107
ATTR (Attribute tools) .......................54
Attribute Script Functions ................135
attributes .................................. 54, 76
Autodesk ............................... 169, 170
Automatic External Reference Reload ..96
Automatic Shader Reload ..................96
Automatic Texture Reload..................96

—C—
Calligraphic Draw Order.....................62
Capture Screen ................................98
Catmull-Clark...................................51
Cg ..................................................89
Change All Paths ..............................76
Change Index ........... 76, 82, 83, 88, 90
Change Parent .................................27
Character Rate .................................87
Clamp ....................................... 79, 80
clipboard ................................... 16, 17
Clipboard/Edit Script Functions.........114
Close ..............................................26
Close All Models ...............................26
COLLADA............................... 169, 170
color .............................. 41, 42, 64, 74
Color Change Index ..........................87
Color Change Intensity......................88
Color Palette .........................19, 29, 74
Color Palette Script Functions...........140
command .................................. 17, 91
Command List ............................ 27, 91
command-line .......................... 16, 106
comment .........................................69
condition .........................................31
Conform To Terrain...........................85
console .........................................106
Contents .........................................30
contracting ......................................72
Control Point....................................80
convolution kernel ............................79
Coordinate.......................................63
Coordinate Units...............................55
coordinates......................................20
Coordinates and Selections Field ........20
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DXF ..............................................169

Copy ......................................... 16, 27
corner points ...................................70
Counter Clockwise ...................... 61, 87
CREATE (Creation tools) ....................40
Create Disk......................................40
Create External Reference .................41
Create Light Point .............................41
Create Node.....................................40
Create Polygon.................................40
Create Sphere ..................................40
Creation Script Functions.................126
Current Color (COL) ..........................19
Current Light Point (LPT) ...................19
Current Material (MAT)......................19
current parent..................................20
Current Shader (SHD) .......................19
Current Texture (TEX).......................19
Current Texture Mapping (TXM) .........19
Cut ........................................... 16, 26

—E—
Earth Ellipsoid Model .........................56
Earth Model .....................................77
Edge ...............................................70
Edge Mode.......................................28
Edit Color ........................................74
Edit Icons ........................................16
Edit Menu ........................................26
Eliminate Transformation Matrices ......39
Embedded textures...........................25
emissive..........................................83
Enabled ...........................................63
Enabled Period ........................... 61, 87
Environment ....................................78
Environment Variable Names ...........171
Environment Variables ....................170
ESRI .............................................170
evaluation .....................................103
Exit.................................................26
expanding .......................................72
Export As ........................................26
Export File Formats.........................170
expression .......................................31
External Format (read-only)...............77
External Reference ...........................71
External Reference Attributes.............68
External Reference Mode ...................29
external references ...........................41
External References…........................25
Extrude ...........................................50

—D—
Database Offset X.............................56
Database Offset Y .............................56
Database Version .............................55
DDS................................................76
DECAL.............................................78
Decrease Grid Size ...........................98
Defaults .................................. 96, 100
degree-of-freedom ...........................70
Delete .............................................27
Detail Texture ............................ 59, 79
Development Tools .........................173
diffuse..................................... 83, 100
Direct Draw Surface........................169
Direct X.........................................170
Directional Type ......................... 60, 85
disk ................................................40
Display At Dusk.....................57, 60, 85
Display At Night ....................57, 60, 85
Display In Daylight ................57, 60, 85
Display Mode ............................. 60, 85
distance ..........................................20
DOF ................................................70
DOF Attributes .................................65
DOF Mode........................................29
DOF preview ....................................92
DOT (.dot) .....................................170
Double Grid Size...............................98
double-clicking ........................... 55, 73
drag and drop ............................ 16, 72
Draw Mode ......................................58
Draw Wireframe Backface..................97
Drawing Order .................................61
Duration ..........................................87

—F—
Fade In Duration ..............................86
Fade Out Duration ............................86
Fade Range Ratio .............................86
Fading....................................... 62, 86
Falloff Exponent ......................... 61, 85
far clip ............................................99
far range .........................................64
FBX ...................................... 169, 170
Feature ID ............................57, 60, 85
field-of-view ....................................99
File Dialogs ......................................23
File Icons.........................................16
File Menu.........................................25
File Script Functions........................112
Fit In View .......................................97
Fit To Selection ................................97
Flashing .................................... 61, 87
Flat Shaded .....................................57
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Flip DDS/PNM Images .......................76
floating .........................................101
Floating licenses .............................102
FLTK .............................................173
Fog Intensity ............................. 62, 86
Fog Punch ................................. 62, 86
Fog Scale .................................. 62, 86
Footprint .........................................58
Format Version.................................55
fragment program ............................89
freeze ....................................... 35, 46
Freeze LOD Center............................64
Front (Along -Y) ...............................97
Front Intensity ........................... 60, 85
Frozen Normal .................................64
Frustum ..........................................99
Full Size ..........................................75

Image Origin....................................77
Import ............................................25
Import File Formats ........................169
inaccuracies ............................. 53, 166
increase complexity ..........................51
Increase Grid Size ............................98
Increment .......................................66
Indexed Light Point Attributes ............62
Installation ......................................14
Installed Content ............................104
INT .................................................76
INTA ...............................................76
Intel .............................................172
Intensity .........................................63
Internal Format ................................77
Invert Selection................................28
IR Color Code...................................57
IR Material Code...............................57
Isolate Selected ...............................98

—G—
General Script Functions..................110
GIF .................................................76
gizmo............................. 35, 37, 46, 47
Gizmos............................................95
graphics card .................................172
graphics driver ...............................166
Graphics Interchange Format ...........169
Grid ................................................97
Grid Offset.......................................98
Grid Script Functions.......................138
Grid Spacing ....................................98
Group .............................................70
Group Attributes...............................56
Group Mode .....................................29

—J—
Java...................................... 105, 172
Joint Photographic Experts Group .....169
JPEG ...............................................76
—L—
large vertices .................................100
Last Frame Duration .........................57
Least Detail .....................................27
Left (Along X) ..................................97
Less Detail.......................................27
level-of-detail...................................70
License............................................30
License dialog ................................101
License Handling ............................101
license key ....................................101
licenseserver.dat ............................102
Light Mode.......................................58
Light Point ................................. 71, 84
Light Point Animation Attributes .........87
Light Point Appearance Attributes .......85
Light Point Attributes ........................60
Light Point Mode...............................29
Light Point Palette .................19, 29, 84
Light Point Palette Script Functions ...151
Light Point System............................71
Light Point System Attributes .............63
Light Point System Mode ...................29
light points ......................................41
lighting ................................... 97, 100
LightWave .....................................169

—H—
Half Grid Size...................................98
Hard Edge .......................................63
hardware fingerprint .......................101
Head Light .......................................97
Header Attributes .............................55
Help..............................................105
Help Menu .......................................30
hidden ...................................... 58, 73
Hide Selected ...................................98
Hiding .............................................98
hierarchy .........................................72
Horizontal Lobe Angle ................. 61, 85
HSV .......................................... 74, 83
—I—
Illuminated ......................................57
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Limit ...............................................66
Line Style ........................................58
Linux ...................................... 14, 172
Linux File Dialogs .............................24
Load Texture....................................76
Lobe Roll Angle .......................... 61, 85
LOD ................................................70
LOD Attributes .................................64
LOD Center......................................64
LOD Mode........................................29
LOD Range Ratio ..............................86
LOD Scale........................................86
Loop Count ......................................56
Loop Duration ..................................56
Lua ....................................... 106, 173

MODIFY (Modification tools) ...............49
Modify UV ........................................48
MODULATE ......................................78
More Detail ......................................27
Morse Code......................................87
Morse Code Timing ...........................87
Most Detail ......................................27
Mouse Coordinate Indication ..............22
Mouse Handling................................21
Mouse Movement .............................21
Mouse Selection ...............................21
Move...............................................35
Move Texture Map ............................45
Multi-texture ....................................27
Multi-texture Data ............................59
Multi-texture Effect ...........................59
multi-texturing .................................44

—M—
macro ...........................................162
macro configuration file...................165
Macro Editor ..................................162
Macro Samples...............................163
Macros .................................. 104, 162
Magnification Filter ...........................78
Map Texture ....................................44
Mapping texture and adding to palette 45
Mapping texture without adding to
palette .........................................45
mask ..............................................68
matching .........................................31
material ......................... 42, 43, 59, 83
Material Palette .....................19, 29, 83
Material Palette Script Functions.......145
Max Commands................................95
Maximum Defocus ...................... 61, 85
Maximum Pixel Size .................... 62, 86
Menu ..............................................25
Menu Bar.........................................15
Merge .............................................53
mesh ..............................................53
Microsoft ............................... 171, 172
Microsoft® Windows® ......................14
Minification Filter ..............................78
Minimum Defocus ....................... 61, 85
Minimum Pixel Size ..................... 62, 86
MIP Kernel.......................................79
mipmap...........................................78
Mirror........................................ 49, 79
Misc Menu .......................................30
Miscellaneous Icons ..........................17
Miscellaneous Mouse Functions...........22
Mode Menu ......................................28
Model View ......................................20
Modes .............................................70
Modification Script Functions............132

—N—
N/A (not available) ...........................95
naked .............................................28
NE Corner Latitude ...........................56
NE Corner Longitude .........................56
near clip ..........................................99
near range.......................................64
Network Adapter ............................101
Never On Top...................................98
New .......................................... 16, 25
New Textured Polygon White..............55
Next IDs..........................................55
Next Model ......................................27
Node Colors .....................................73
node-locked ...................................101
Node-locked and USB dongle licenses101
Normal............................................63
normals.........................................100
numbers..........................................19
NVIDIA .........................................172
—O—
OBJ ...................................... 169, 170
Object .............................................70
Object Attributes ..............................57
Object Mode ....................................29
Open......................................... 16, 25
Open Recent ....................................25
OpenFlight ............................... 16, 168
OpenFlight® File Format .................168
OpenGL .........................................173
OpenGL Shading Language ................89
OpenSceneGraph...... 166, 169, 170, 173
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Quantify ..........................................53

orientation axes .............................100
Origin .............................................65
Origin Latitude .................................56
Origin Longitude...............................56
Orthographic....................................96
Other Icons .....................................15
Overview .........................................13

—R—
radius .............................................38
Randomize Intensity ................... 62, 86
Range Mode............................... 61, 86
RCP (Remo 3D Color Palette) .............75
Read Color From Node ......................42
Read Material From Node ..................43
Read Shader From Node....................43
Read Texture From Node ...................42
Read Texture Mapping From Node ......42
Real World Size ................................77
Recall View ......................................97
Redo ......................................... 17, 26
reduce complexity ............................52
Reflective Only ........................... 62, 86
REMO3D_ENABLE_X_THREADING.....171
REMO3D_FILE_PATH..............41, 76, 90
REMO3D_FILE_PATH File path ..........171
REMO3D_IMPORT_EXPORT_OPTIONS171
REMO3D_LICENSE_FILE ..................171
REMO3D_LICENSE_SERVER .............103
REMO3D_LICENSE_SERVER .............171
REMO3D_LICENSE_SERVER_FILE .....171
REMO3D_LICENSE_SERVER_PORT....103
REMO3D_LICENSE_SERVER_PORT....171
REMO3D_LOG ................................171
REMO3D_NO_LINE_FEED ................171
REMO3D_SCRIPT_CONFIRMATION....107
REMO3D_SCRIPT_CONFIRMATION....171
REMO3D_SPACENAV_DEVICE ..........172
remoLicenseServer .........................102
Remove All Paths..............................76
Remove Material ..............................43
Remove Path ...................................76
Remove Shader................................43
Remove Texture ...............................43
Remove Texture Mapping ..................43
Remove Unused .............. 76, 83, 88, 90
Repeat ............................................79
Replace Texture ...............................76
Replications .................... 56, 57, 60, 62
Report Differences ............................18
Report Statistics ...............................18
Reporting Script Functions ...............138
Reverse Polygon ...............................49
Revert.............................................25
Revert Externals...............................25
Revert Textures................................25
Revision Date...................................55
Revolve ...........................................51
RGB .....................................74, 76, 83
RGB Mode .......................................55

—P—
P3D ...................................... 169, 170
Palette Icons....................................19
Palettes ...........................................74
Palettes Menu ..................................29
panning..................................... 21, 94
Parameter Precision ..........................95
Paste ........................................ 17, 27
PATH ............................................166
PBM ................................................76
Period ....................................... 61, 87
Perspective ......................................96
Perspective Mode........................ 62, 86
PGM................................................76
Phase Delay ............................... 61, 87
pivot ......................................... 17, 77
pivot point ...................... 17, 22, 35, 45
pixel size threshold ...........................99
Plant ...............................................36
PNG ................................................76
PNM................................................76
POINT .............................................78
Point In XY Plane ..............................65
Point On X Axis ................................65
Polygon ..................................... 40, 70
Polygon Attributes ............................57
Polygon Mode...................................29
Portable any map ...........................169
Portable Network Graphics...............169
PPM ................................................76
Preferences................................ 27, 94
Preview Animation ............................93
Preview Animation... .........................27
Preview DOF .............................. 27, 92
Previous Model .................................27
Primary Color ...................................58
primitive..........................................70
Projection ........................................77
Projection Type ................................56
Proximity Occulting..................... 61, 86
—Q—
Quake Character Models..................169
Quality ...................................... 61, 86
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RGBA ..............................................76
Right (Along -X) ...............................97
RLP (Remo 3D Light point Palette) ......88
RMP (Remo 3D Material Palette) .........83
Rotate.............................................36
Rotate Texture Map ..........................46
rotating ................................21, 61, 87
rotation ...........................................94
Rotation Axis ............................. 61, 87
RSP (Remo 3D Shader Palette)...........89
RTP (Remo 3D Texture Palette) ..........76
RVMAT ..........................................170
RXP (Remo 3D teXture mapping Palette)
...................................................82

Setting an Environment Variable ......170
Settings ..........................................94
SGI.................................................76
Shade .............................................54
shader .................................43, 59, 89
Shader On .......................................97
Shader Palette ......................19, 30, 89
Shader Palette Script Functions ........156
Shadow ...........................................57
Shape ...........................................170
Sharing Macros ..............................165
Shift Far Left....................................27
Shift Far Right..................................27
Shift Left .........................................27
Shift Right .......................................27
shifting............................................73
shininess .........................................83
shortcut ........................................166
Shortcuts ........................................32
Show All LODs..................................27
Show Coordinate System...................65
Show Gizmos ...................................27
Show Grid .......................................97
Show Normals..................................18
Show Vertex Numbers.......................19
Show Vertices Large .........................18
Shrink Polygons ...............................17
Significance ............................... 61, 85
Simplify...........................................52
Size Difference Threshold ............ 62, 86
Sky.................................................99
Sky Light .........................................97
Slice ...............................................50
Small Feature Culling ........................99
Snap To Grid....................................18
Soft Selection ..................................38
Solid ...............................................97
Space Navigator™ Support ................22
specular .................................. 83, 100
sphere ............................................40
split ................................................50
Split/Triangulate...............................50
Stanford Triangle Format (.ply) ........169
State ..............................................87
statistics..........................................18
Status Area......................................20
StereoLithography .................. 169, 170
Store View.......................................97
Subdivide ........................................51
sub-section ......................................80
SURFACE (Surface appearance tools) ..41
Surface Material Code ............57, 60, 85
Surface Script Functions ..................128
SW Corner Latitude...........................56

—S—
sample ..........................................104
Sample Models ...............................104
Samples ........................................104
Save ......................................... 16, 25
Save As...........................................25
Save Vertex Normals ........................55
Scale ..............................................37
Scale Texture Map ............................47
Scramble .........................................79
Screen Capture Size .........................95
screen resolution ............................172
Scribed ...........................................97
script .................................... 106, 162
Script Editor...................................106
Script Environment .........................106
Script Menu .....................................30
Script Reference .............................109
Script Samples ...............................107
Scripts .................................. 104, 106
Secondary Color ...............................58
Select By Attributes .................... 28, 31
Select By Name................................28
Select Children .................................28
Select Naked Edges ..........................28
Select Parents ..................................28
Select Polygons By Number Of Vertices...
...................................................28
Select Previous.................................28
Select Sliver Polygons .......................28
Selection Menu.................................28
Selection Mode Icons ........................17
Selection Script Functions................115
sensitivity........................................94
Sensitivity... ....................................27
Sequence ........................................56
Sequence Number ............................87
service ..........................................102
Set Parent .......................................27
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SW Corner Longitude ........................56
SW Database Coordinate X ................56
SW Database Coordinate Y ................56
Swing .............................................57
Switch.............................................71
Switch Attributes ..............................67
Switch In.........................................64
switch masks ...................................68
Switch Mode ....................................29
Switch Out.......................................64
Switch Range ...................................64
System Configuration......................172

Tree View .................................. 20, 72
trees ...............................................36
triangulate.......................................50
triangulated .....................................53
Troubleshooting .............................166
Tutorial .........................................104
—U—
Undo......................................... 17, 26
Unhide All........................................98
Unhide Selected ...............................98
Up Vector ........................................77
USB dongle....................................101
Use Current Rotation.........................65
Use Current Translation.....................65
Use External Color Palette .................68
Use External Light Point Palette ..........69
Use External Light Source Palette .......69
Use External Line Style Palette ...........69
Use External Material Palette..............68
Use External Sound Palette ................69
Use External Texture Palette ..............68
Use Relative Paths ............................76

—T—
Tagged Image File Format ...............169
Targa ............................................169
Technical Specifications...................168
Terrain ............................................58
TEXMAP (Texture mapping tools)........44
texture..................... 42, 43, 59, 75, 87
Texture Attributes ...................... 76, 77
Texture Coordinate ...........................63
Texture File Formats .......................169
Texture List .....................................75
texture mapping.............. 42, 43, 44, 81
Texture Mapping Index......................59
Texture Mapping Palette .........19, 29, 81
Texture Mapping Palette Script Functions
.................................................149
Texture Mapping Script Functions .....130
Texture On ......................................97
Texture Palette......................19, 29, 75
Texture Palette Script Functions .......142
Texture Size ....................................77
Textured Polygon White.....................58
TGA ................................................76
TIFF ................................................76
Tile .................................................80
Time limited license ........................103
tolerance .........................................95
Tool Area.........................................20
Tool Icons........................................15
Tools......................................... 29, 35
Tools Menu ......................................29
Top (Along -Z) .................................96
transformation matrix .......................39
Transformation Script Functions .......120
Transition ........................................64
Translate Origin................................98
Transparency ............................. 57, 58
Transparent Clamp ..................... 62, 86
Transparent Falloff Exponent........ 62, 86
Transparent Pixel Size................. 62, 86
Transparent Scale....................... 62, 86

—V—
VBS2 .................................... 169, 170
Vertex.............................................70
Vertex Attributes ..............................63
Vertex Mode ....................................28
vertex program ................................89
Vertical Lobe Angle ..................... 61, 85
vertices ...........................................18
View Menu .......................................27
Viewpoint ........................................96
Viewport..........................................28
Viewport Menu ........................... 28, 96
Viewport Preferences .................. 98, 99
Visibility Range.................................86
Visual Cues....................................100
—W—
Window Areas ..................................15
Windows ............................... 171, 172
Windows File Dialogs.........................23
Wireframe .......................................97
Word Rate .......................................87
Wrap...............................................79
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—X—

—Z—

XFORM (Transformation tools) ...........35

Z-buffer ..........................................98
zoom ..............................................73
zooming .................................... 21, 94

181

